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1. ABOUT FILEHOLD

FileHold is a document management software system that is easy to use, easy to install, and is
affordable for small to large organizations. It integrates with existing applications and enriches
Microsoft SharePoint deployments. Features include web access, search, version control,
tagging, workflow, secure user rights, mark up and annotations, redaction, scanning, and OCR
and indexing.

Records Management features allow records to be converted to archives, put into legal hold, or
be scheduled for final disposition.

2. ACCESSING FILEHOLD

You are able to access FileHold many ways:
e Web Client via a web browser.

e FileHold Desktop Application (FDA)

e Microsoft Office applications including Word, Excel, Outlook, and PowerPoint

e Mobile FileHold through your mobile device such as an iPhone or Android

Access to files can be gained through any of the methods by users with a valid FileHold
account.

Access via the web client can occur using LAN, WAN, an Intranet or over the Internet. Working
with files via the web client does not require installation of our document management
software. However, to access the system via the FileHold Desktop Application (FDA) or
Microsoft Office applications, users are required to install FDA on their computer.

The web client and the FDA interface are very similar. You can use either to access the
document Library but it is recommended that you generally use FDA as it is faster than going
over the web and has more advanced functions than the web client. See a list of differences
between the Web Client and FDA.

2.1. WARNING BANNER

Regardless of what standard client you use to log in to FileHold, you may have to respond to a
warning banner message to access the software. The contents of the banner and the actions
available are configured by your administrator. Contact your local FileHold administrator if you
have any questions.

2.2. FILEHOLD DESKTOP APPLICATION (FDA)

The FileHold Desktop Application (FDA) has a very simple, intuitive and familiar Library
structure similar to your traditional filing cabinets (cabinets > drawers > folders > documents)
and Microsoft Windows Explorer folder hierarchy.
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You may have your connection settings set to automatically log into FileHold when you start
the FDA. If you have not selected that option, you need to login manually.

2.21. FDA Connection Options

In order to connect to the FileHold server via the web client, FDA, or Microsoft Office
applications, you must ensure that you have entered the correct connections settings. The
connection settings are set in the FDA. You must have your username, password, know
whether it is a locally managed account, Windows domain (Active Directory) account, or
managed using an external authentication provider and the URL path to the FileHold server.

To SeT THE FDA CONNECTION SETTINGS

1. Open the FileHold Desktop Application (FDA) and select File > FileHold Connection

Options.

2. Select the following options that you want to enable:

e Automatically run FileHold application when | logon to Windows — This option
automatically starts up FileHold after you log into your computer.

e Automatically logon to FileHold Library when Desktop Application starts — This option
automatically logs you in after you launch the FDA. You do not need to enter your

username and

password.

e Remain logged in even if no activity is performed — This option keeps your account logged
into the system even if you are not using it. This is dependent upon the settings made by
the system administrator. This option can only be set when logged into the FDA and may
be locked down by a system administrator.

3. Select one the following options:

o External identity provider — You will log in using your corporate authentication provider.

e Always prompt for credentials — You always need to log in with a username and

password.
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e Use my windows account username and password to logon — This uses your Microsoft
Windows account username and password to login. You need to ask your system
administrator which type of account you are using.

e Use the following username and password to logon — Your system administrator provide
you with a username and password. Enter the username and the password twice.

4. Select the default domain:

e Local FileHold Account — Select this option if a username and password was provided by
your system administrator.

e “Domain Name” — Select this option if you are using your Microsoft Windows user account
to login to FileHold.

5. Enter the FileHold Server URL. The URL should be given to you by your system
administrator and should be in the format

http://yourcompanyservername/FH/FileHold
or
https://yourcompanyservername/FH/FileHold

6. Select the Share my Inbox with others check box if you want to share your Inbox with other
users of the same local computer. See Sharing Inboxes for more information.

7. Click Test URL. If the server URL is correct, you receive a “Connection Successful’
message.

8. Click Test Logon. If the username and password are correct, you receive a “Logon
Successful message.”

9. Click OK.
2.2.2. Logging into the FDA
Ensure that the connection options have been configured prior to logging in. You may have

your connection settings set to automatically log into FileHold when you start the FDA. If you
have not selected that option, you need to login manually.

Two-factor authentication may have been configured for your system. See Multi-Factor
Authentication for more information on how to log in if this has been enabled for your system.

To LoG INTO FDA

1. Open the FDA. If there is not a shortcut to FDA on your desktop, go to Start > Programs
> FileHold > FileHold Desktop Application.

2. Select one of the following options:

e Go to File > Logon to FileHold Server as username — This uses your stored Microsoft
Windows or locally managed username and password.

e Goto File > Logon to FileHold Server as... — This allows you to login using an
alternative user name and password than the one that is stored in the connection options.
Enter a username, password, and select a domain. Click OK.

3. You are now logged into FileHold. Click OK to close the Welcome Screen.

€ FileHold ,
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e Select the check box on the Welcome Screen to not display this screen when FDA
starts. You can re-enable this screen in the User Preferences.

2.2.3. FDA Menus and Toolbars

The FDA has several methods in which functions can be performed.

e The document toolbar that can be used to perform operations on single or batch (many at
once) documents such as check out or get a local copy.

o Aright-click context sensitive menu where only those functions that can be performed are
available to use.

e The main menu bar where other functions of the FDA can be performed.
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The following table describes the functionality of the FDA FileHold Toolbar buttons.

Button Description Permissions Needed
Add document. Document publisher or
Add File higher.

Enabled when a user can add a document.

Disabled when a user cannot add a document.

Add an offline document to the library. Document publisher or
dd higher.

- Aadd Enabled when a user can add an offline
Offline document: there is at least one schema where
Document the user is a member, the user is an
administrator, or has permission to convert
documents to offline.

Not visible when offline documents are not
configured in the system for the user.

This button can be hidden if the key
“Display.EnableOfflineButton” in the Library
Manager web configuration file is set to “false”.
By default, it is set to “true”.
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Button

Description

Permissions Needed

local copy

B Make a

Makes a copy of the documents to the local
user computer.

Enabled when a user can download a copy of
a document.

Disabled when a user cannot download a copy
of a document.

All users with access to
the folder and permission
to download.

Check

o
c
—

Checks out a document for editing.

Enabled when a user can check out a copy of
a document.

Disabled when a user cannot check out a copy
of a document.

Document publisher or
higher.

..

documents

Creates a link between two or more
documents.

Enabled when a user selects more than one
document to link together.

Disabled if there are no documents to link
together.

Document publisher or
higher.

¢?

Assemble
documents

Publish documents to PDF, combine two or
more documents, add watermarks, and more.

Enabled if a user can assemble documents.

Disabled if the user does not have a FileHold
viewer level 2 or 3 license and the
“Display.LicenseWarning” key is false in the
web config file of C:\Program Files\FileHold
Systems\Application Server\LibraryManager. If
the key is true and the user does not have a
license, a warning message displays.

Document publisher or
higher and user has a
FileHold viewer license
level 2 or higher.

Emails the document as an attachment or as a
link in the body of an email.

Enabled if a user can email documents.

Disabled if a user cannot email documents.

All users and permission
to email documents.

— Send
Courier
Transmission

Transmits documents for viewing or approving
to people inside or outside the FileHold
system.

Enabled if Courier is enabled and there is a
template associated with the schema.

Disabled if Courier is disabled and if there is
no template associated with the schema.

See the Workflow and Courier Guide for more
information.

Document publisher or
higher and Courier is
enabled.
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Button

Description Permissions Needed

nDeIete

=ZEICle Enabled if a user has permission to delete the
document.

Deletes a document from the library.

Disabled if a user does not have permission to
delete the document.

Deleted documents can be recovered by a
library administrator before a set amount of
time. See the Library Administration Guide.

Document publisher +
delete and the user is the
owner of the document.

Publisher + delete and
the user is the owner of
the document.

Organizer and the user is
the owner of the
document.

Organizer + delete and
higher roles can delete
any documents.

FDA Shortcut keys

The following are a list of the hotkeys (shortcut keys) found in the FileHold Desktop

Application.

Shortcut Key Description

ALT +L Performs a database lookup. Can only be used when the
metadata panel is in edit mode and the Lookup button is
available.

Alt+ N Saves the metadata values and moves to the next document
in the list (Save and Next). Can only be used when the
metadata panel is in edit mode.

Alt + Shift + S Saves the metadata in the metadata pane.

Alt+T Invokes Click To Tag when in the metadata panel.

CTRL+C Copies information about selected documents from the

documents grid to Clipboard.

CTRL + Shift+ O

Adds an offline document

CTRL + Shift + R

Opens the report viewer.

CTRL + Shift + V

Opens the document viewer.

CTRL+V

Adds files from the Clipboard to the current folder or Inbox.
Files can be selected in Windows Explorer and copied using
CTRL + C (the source files are not deleted after uploading)
or CTRL + X (the source files are deleted).

CTRL+Double-click

Opens the document in its native application and checks out
the document from the library at the same time.

CTRL+F Cursor moves to simple “Google” like Search bar.
CTRL+Shift+A Adds a file to the library.

CTRL+Shift+F Adds a folder to the library.

CTRL+Shift+L Logoff from FileHold.

CTRL+Shift+P Show/hide metadata and properties pane.

< Hold
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2.2.5.

Shortcut Key Description
CTRL+Shift+T Show/hide the document tray.
Double-click Does one of the following, depending on how it has been

configured by an administrator:

e Opens a document in its native application but does not
check it out. This is the default action.

e Opens a document in an undocked FileHold viewer screer
if the file format is supported.

The behaviour for double-clicking can be set to either option
above. The key “FDA.DoubleClick” can be configured the
Library Manager web config file. The available values are
“OpenNative” and “OpenViewer”. The default is opening the
file in the native application.

F5 Refreshes the screen.

Sharing Inboxes

When importing documents into FileHold, you can now share the contents of your Inbox with
other users if you have sufficient rights.

Documents in the Inbox can be shared between users on the same computer. Sharing your
Inbox allows others to file the contents of your Inbox on your behalf. For example, if there is a
dedicated scanning station with several people scanning documents to be added into FileHold,
all users who can log into the Windows environment of that scanning station are able to file all
the scanned documents in the Inbox. This is because the Inbox is shared between all the users
who can log in with a Windows user account.

You can set whether you want to share your Inbox in the Connection Options window. Note
that if you change this setting, it won't take effect until you log off and then log back in.

NOTE: The Shared Inbox check box option is only available to users who have at least the
Write permission to the common application data folder (usually “C:\ProgramData”), which
normally defaults to members of the Administrators group only. See the Manage Imports Tool
in the Library Administrator Guide or the Knowledge Base for more information.

2.3. WEB CLIENT

To access the FileHold web client, you need to use a valid web browser. See the browsers that
FileHold supports.

Two-factor authentication may have been configured for your system. See Multi-Factor
Authentication for more information on how to log in if this has been enabled for your system.
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The interface of the web client is similar to that of the FDA. Most functions are identical but
there is more end-user functionality in the FDA.

Library Administration and System Administration functions are performed through the web
client as well using the Administration Panel.

TO LOG INTO THE FILEHOLD WEB CLIENT

1. Open a web browser and enter the URL for the FileHold login screen. This should be
provided by your system administrator. It is usually in the format:

http(s) ://yourcompanyservername/FH/FileHold/WebClient/LoginForm.aspx

TIP: It is recommended that you create a bookmark, favourite, or shortcut to the web client
URL for easy access.

2. Enter your username, password, and select the domain.
3. Click Log In.

NOTE: If you are using Active Directory in conjunction with FileHold, your administrator may
have configured the web browser for authentication. If this is the case, click the Logon with
Windows Authentication link on the login page.

Web Client Menus and Toolbars

The Web Client has two methods in which functions can be performed.

e The FileHold Toolbar that can be used to perform operations on single or batch (many
documents at once) documents such as check out or get a local copy. To select multiple
documents, select the check box next to the document name.

¢ A context-sensitive menu where only those functions that can be performed is available to
use. The context sensitive menu is accessed by right-clicking on a document name or a
level in the library tree.
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The following table describes the functionality of the Web Client FileHold toolbar buttons.

Button Description Permissions Needed
Get a copy Makes a copy of the documents to the All users with access to the
local user computer. folder.
Check out Checks out a document for editing. Users with Document
Publisher rights or higher.
Edit metadata | Opens the metadata pane for editing. Users with Document
Publisher rights or higher.
Link Creates a link between two or more Users with Document
documents. Publisher rights or higher.
Move/copy Moves or copies the document from one Users with Document
area in the Library to another. Publisher rights or higher and
have ownership of the
document.
Users with Organizer rights or
higher.
Delete Deletes a document from the Library. Users with Document
Publisher plus Delete rights,
D fenecuer®! ™ | Pubisher plu Delte it
amour:%/of time. See the Library and Organizers, who have
Administration Guide. ownership of the document.
Organizer plus Delete and
higher roles.
Convert to Converts the document to an offline Users with cabinet
offline document. Offline documents are those administrator rights or higher
documents that are stored outside the and are owners of the
FileHold repository, such as a library, file | cabinet.
room or filing cabinet.
Send to > Tray | Adds the document to your document All users with access to the
tray. folder.
Send to > Sends the document to a Virtual folder. A | All users with access to the
Virtual folder Virtual folder must be available or folder.
created.
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Library archive

Button Description Permissions Needed
Send to > Emails the document as an attachment or | All users with access to the
Email as a link in the body of an email. document and email settings
have been enabled by the
library administrator.

Send to > Checks the document out and sends itin | Users with Document

Email and an email attachment or as a link in the Publisher rights or higher and

check out body of an email. email settings have been
enabled by the library
administrator.

Send to > Sends the document to the Archive. Users must be a member of

the system administrators /
senior library administrator
group OR a member of the
library administrator group
which is the owner of the
cabinet where the document
belongs.

template name

Selecting more than one document starts
a multiple document workflow.

Send to > Adds main or supporting documents to an | Users with Document

Existing existing workflow. Publisher role or higher. User

Workflow must have access to all
added documents and be
owner of the document
version when adding main
documents.

Initiate Allows you to select the workflow Users with Document

Workflow > template name from the list and start a Publisher rights or higher and

workflow workflow. is owner of the document.*

*Unless the ‘Allow non
document version owner to
initialize workflow” permission
setting is enabled. See the
System Administration Guide
for more information.

2.4. MICROSOFT OFFICE APPLICATIONS

FileHold software has tight integration with Microsoft Word, Excel, Outlook, PowerPoint, Visio,
or OneNote applications to provide a comfortable work environment. The FileHold Office Client
(FOC) window is used when opening, browsing, getting a copy, checking in/out, adding
attachments, or approving or reviewing documents from within Microsoft Office applications.

The FileHold Desktop Application (FDA) must be installed, running and a user must be logged
in for the FileHold Office Toolbar icons to be active.

10

< Hold

September 2025




End User Guide

FileHold 17.1

File Home

Browse Add Check-

Insert Design

Q +v ¢

Layout References Mailings

Quick Review /

In Check-In Approve

Actions

Microsoft Word — FileHold Tab

Using the FileHold Toolbar and menu commands you can browse the Library, add a document,

Review View Help

check in a document, send for approval or review (workflow) and in Microsoft Outlook you can
add an attachment to an email from FileHold. See the table below for details.

Button/Menu item

Description

Permissions Needed

Q

Browse Browse

Browse opens the “Get From
FileHold” window where you can
select which document you want to
open in the library.

All users.

+

add Add

Add opens the “Add Document to
FileHold” window where you can
select the location in the library and
enter metadata for the document.

Document publisher or
higher.

v

Check-

Check-in opens the “Check
Document Back Into FileHold”

Document publisher or
higher.

Quick

chece-n Quick Check-in

document and bypasses the FOC
window.

i Check-in window where you can check your
document back into the library.
< Quick Check-in checks in the Document publisher or

higher.

Review [

Apperove. Review/Approve

Review/Approve opens the “Select
Task you are Reviewing or
Approving” window and allows you
to select the workflow task and
enter any comments and feedback.

See the Workflow and Courier
Guide for more information.

Document publisher or
higher.

0

Atach Attach

Attach opens the “Get From
FileHold” window where you can
select which document you want in
the Library to add as an attachment
to an email. For Microsoft Outlook
only.

All users.
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241. Working with Documents using Microsoft Office Applications

The FileHold Office Client (FOC) window allows users to browse the library, get a copy of
documents, check them out or into the library. Users can also add new files, add approvals or
reviews (workflow), or add attachments to emails.

In the FOC window, the Library tree looks and performs the same as it does in the web or
desktop applications. Users can also see the associated metadata. In the “Get From FileHold”
window, you can perform various functions such as get a copy of a document, check it out,
rename, delete, view version history, and open the file after it has been downloaded.

In the Add Document to FileHold window (shown below), you can select the location in the
library structure for the document, fill out the metadata, close the document before adding to
the repository, delete the local copy, and email folder members to notify them that a document
has been added to the folder.

To change the document name, click on the name of the document and type a new one.
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2.5. LOST OR FORGOTTON USERNAME AND/OR PASSWORD

In the event that a locally managed user has forgotten their user ID or password, the system
administrator can configure FileHold so that one or two links can be made available on the web
client login screen and FDA login screen.

If a user has forgotten their user ID, they are asked to enter their email address. An email
containing their user ID is emailed to them.

If a user has forgotten their password and wants to reset it, then the user is prompted to enter
their email address and is sent a time-sensitive link in which they need to use in order to reset
their password. Once the link is clicked, the user is prompted to reset their password in the
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web client. If the time limit on the email expires, then the user needs to resend the reset
password request from the login page.

An additional security measure may be put into place
Hold by your administrator using a two-step verification
process via a mobile phone. This sends a text
message to the user’'s mobile phone containing a
Azure PIN code. This code is needed to reset the
password. See your system administrator for details.

Log in to FileHold to continue.

OR

I e e If a mobile phone number is required to reset the
password for the user, it can be set by a user in the
User Preferences > Contact Information tab > Mobile
Login field.

: If your system administrator has not configured
Password E these “forgot” options, you need to contact them
directly.

Forgot your password?
Forgot user ID? TO REQUEST A FORGOTTEN USER ID

1. From the web client or FDA login screen, click
the Forgot user ID? link.
a. If yourlog in page has multiple log in options,

you may need to select the option for password entry
before you will see the links.

Web Client version FileHold17.0_20221006.2
‘ Teams Add-on 202305311

2. Enter your email address and click Recover.

3. The message “If the address matches a local account in the system you are sent an email
with your user id” displays. Click OK.

4. Youruser ID is sent to the email address provided.

TO RESET A FORGOTTEN PASSWORD
1. From the web client or FDA login screen, click the Forgot your password? link.
2. Enter your email address and click Recover.

3. The message “If the address matches a local account in the system you are sent a time
limited email with password reset instructions” displays. Click OK.

4. An email is sent to the address provided. The email contains a time sensitive link to reset
the password. If the link provided in the email is not used with a certain time period, the link
expires and you need to click Forgot user ID? link to be sent another password reset link
email. See your system administrator for time limit details.

In the email, click or copy and paste the link provided into a browser window.
If you are not using the two-step mobile phone verification process:
e Enter your User ID.

e Enter your Password twice and click Save. You are now logged into FileHold with your
new password.
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Select a new password in order to log in.

Userid ®

Pazsword *

Pa=zzword (confirm) *

| Save || Cancel |

7. If you are using the two-step mobile phone verification process:
e Enter your User ID.
e Enter your Password twice.

e Select the Phone Number to be sent the verification code and click Continue. Only a
partial phone number is shown in the list.

Log In

Select a new password in order 1o log in,

User ic | basie

Password *l sEEsEn

Password [cumrm;l'l wrnnes| -
Select a phone number for identity verfication. & PIN will be sent to your mabile phone
Prone fiumber *[ G011 Tl

o Enter the 4-digit PIN that was sent to your phone and click Save. You are now be logged
into FileHold with your new password.

Select a new password in order to log in.

Select @ phone number for dentity verificalion. & PIN will be sent to your mobile phore
Phone numbser | [ s 11 E
Please enter the venfication PIN that you received on your mobile phone

PiN *| 3432 |
[save || ance |

2.6. LOGGING IN WITH MULTI-FACTOR AUTHENTICATION

If you need additional security when accessing the FileHold application, the multi-factor
authentication feature strengthens access security by requiring two methods to verify a user’s
identity. FileHold supports multi-factor authentication (MFA) with the Duo (www.duo.com)
“Trusted Users” service. Each user of FileHold may be required to create a Duo account in
order to login to the system.

All FileHold clients supports MFA including: FileHold Desktop Application (FDA), web client,
mobile web client, and Courier client.

. ©FilcHold
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An administrator needs to set up the Duo account at www.duo.com prior to configuring MFA in
FileHold. This is the responsibility of the customer, not FileHold. See the System
Administration Guide for details on how to configure two-factor authentication.

TO LOGIN USING TWO-FACTOR AUTHENTICATION WITH DuO
1. Open a FileHold client and login using your FileHold credentials.

2. If a Duo account has not been set up for the user, you are prompted to start the account
setup process. Click Start Setup.

Follow the prompts to set up your selected device for authentication.
Click Continue to Login.
Select your method of authentication:

e Duo Push — Pushes a login request to your phone or tablet (if you have Duo Mobile
installed and activated on your iOS, Android, or Windows Phone device). Just review the
request and tap Approve to log in.

e Call Me — Authenticate via phone callback.

e Passcode — Log in using a passcode, either generated with Duo Mobile, sent via SMS,
generated by your hardware token, or provided by an administrator.

Authentication is required. Please confirm your identity.
‘ Choose an authentication method
Duo Push RecoMMENDED Send Me a Push

FileHold Q@ call Me Call Me

Documant Management Software

What is this? C7
el E Passcode Enter a Passcode

Powered by Duo Security

September 2025 ’ File Ho"d 15


http://www.duo.com/

FileHold 17.1

End User Guide

v

2:54 PM 9 3 68% .

Login Request
Protected by Duo Security

<

FileHold

Document Management Software

FileHold
FileHold

2

96.53.37.246
Vancouver, BC, CA
®
2:53:52 PM PST
January 30, 2018

X

Approve

Example of Duo Push authentication method — notification sent to iOS Duo app

6. You are automatically logged into FileHold once your Duo account has been
authenticated.

16
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3. UNDERSTANDING ROLES, PERMISSIONS, AND ACCESS TO THE LIBRARY

Only users with the correct role can use and manage certain parts of the Library structure.
Your system administrator assigns users to groups and a role to each group. Your library
administrator created the Library structure and assigned group membership to the cabinets,
folders, and document schemas. The role assigned to the group determines what permissions
you have in terms of functions in the system and accessing cabinets, folders, and documents.

All roles provide document emailing capability. Roles higher than Document Publisher have the
Courier functionality. These functions can be disabled on a role by role basis by a System
Administrator in the FileHold Groups area. See the System Administrator Guide for more
information.

NOTE: You can be logged into FDA and the Web Client at the same time but you cannot be
logged into two FDAs or web clients at a time. Only one user account can log into FileHold at a
time.

Role Name Description

Limited A user assigned to a group with a “limited” role has restricted access to the
system. Users can only get a copy or view documents in the library.

Groups assigned to a “limited” role are used for when multiple people can
share the same username and password to log into FileHold to see the
same documents in the library. For example, documents such as
newsletters, forms, or corporate policies may need to be accessible to all
company employees but they do not require a full registered user license
and full functionality.

There are two user account types that can be assigned to a limited role:

e Limited Registered user accounts can log into FileHold using a single
username and password.

e Portal Alias user account types are used in conjunction with the
Anonymous portal and require no login.

Using limited registered or anonymous portal user account types are a cost-
effective way for many people to view documents in the repository but with
very limited functionality.

User accounts assigned a role of “limited” consume “Limited concurrent
sessions”. Limited concurrent sessions are the number of users that can log
into FileHold at the same time using a limited registered or portal alias
account. For example, 30 people may have the same login credentials but
only 20 can use FileHold at the same time because there are only 20
limited concurrent sessions.

If multiple people log into FileHold with the same user name, the log files
record the same user name regardless of the actual person that logged into
the system.

Groups assigned the limited role restrict users from downloading, viewing,
emailing, or printing documents.
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Role Name

Description

Read Only

A Read-Only user role may only download or open and read documents
from FileHold. They cannot edit, delete, or create documents. They can
email documents if given this functionality by system administrators.

Read-only users may be restricted from downloading, viewing, emailing, or
printing documents.

Read-only users can participate in workflows but cannot initiate workflows.

Document
Publisher

Document Publisher user role can read, get a copy, add, check-in/check-
out, edit documents, and metadata. They can move documents that are
owned by them. They cannot delete any documents including those which
they have added to the system.

Document publishers can initiate workflows, participate in workflows, and
initiate Courier transmissions.

Document publishers can be restricted from downloading, viewing,
emailing, or printing documents.

Document
Publisher +
Delete

Document Publisher Plus Delete user role can do everything a Document
Publisher can do and delete their own documents. They must be the owner
of the document in order to delete it. To see the owner of a document, you
can look at the version properties in the metadata pane.

Document publishers can convert offline documents to electronic
documents using the check out and check in process (if the permission
setting is enabled).

Publisher

Publisher user role can do everything a Document Publisher can do plus:
e Create new folders and folder groups.
e Copy or move folders that they have already created.

e Clone folders and folder groups created by other users and become the
owners of the folders / folder groups.

e Publishers cannot delete existing documents, folders or folder groups
including those which they have added /created. All documents and
folders created by the Publisher are owned by them and they cannot
change the ownership.

Publisher
+ Delete

Publisher plus Delete user role can do everything that a Publisher can do
plus delete documents, folders and folders group owned (created) by them.

18
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Role Name

Description

Organizer

The Organizer role is for users who are responsible for organizing
documents that are scanned or imported into the system or who are
assigned to organize documents added by other users. For example,
organizers would move the documents generated by scanner operators to
their correct folder in the library. Only trusted personnel should be given this
role. Organizer role user can:

e Move all documents (which they have an access to) in other places in the
library including documents which they do not own. In other words, they
can move documents that are owned by other users.

e Move, copy or clone all folders and folder groups regardless of their
ownership. In case of cloning, they are the owners of folder / folder
groups. In case of copying and moving the original ownership of folders /
folder groups is preserved.

e Change folder properties regardless of ownership.

e Add folders / folder groups (in which case they are the owners) and
rename folders and folder groups.

e Delete documents that they own.
e Change document owner regardless of ownership

e Export documents

Organizer +
Delete

Organizer plus Delete role can do everything that Organizers can do plus
delete all documents, folders and folder groups regardless of their
ownership. This organizer and delete role can only do this within Cabinets,
Folders and Schemas that they are a member of.

This role should be used by trusted personnel only.
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Role Name

Description

Cabinet
Administration

Cabinet Administrators can only administer the cabinets that they own; they
cannot create cabinets for themselves. They can:

Create, edit, and delete drawers, folder groups and folders and manage
their properties (i.e., membership structure).

Access all documents (in Publisher and Delete capacity) from anywhere
in the library structure unless they are restricted from that area of the
library structure. If they do not have access to the Cabinet and Folder,
they are not able to access the documents.

Delete and move electronic records as long they are owners of the
cabinet. Electronic records can only be moved to another Cabinet in
which they own.

Move documents between cabinets as long as they are owners of the
Cabinet. If users need to move documents between Cabinets that they dg
not own, then use an organizer role instead.

Have access to all document schemas.
Change document owner for documents in the cabinets that they own.

Convert electronic documents to electronic records and vice versa for
cabinets that they own.

Convert electronic documents to offline documents for cabinets that they
own.

Manually move document to and from the library archive as long as they
are the Cabinet owner in the library archive.

Library
Administration

Library administrators can perform, within their cabinets, the same functions
as Cabinet Administrators plus:

Create cabinets for which they are the owner of and manage them in the
library.

Access to Library Administration functionality where they can manage
metadata fields, schemas, events, set up workflow templates, manage
numerous global settings (for example: viewer permissions, search
engine settings, reporting services permissions and more), perform
various managerial functions such (as check-in for user, change
document owner, recover deleted document etc.) and access many
useful reports and usage logs for the cabinets that they own.

Library administrators cannot create cabinets for Cabinet Administrators
to own. If a library administrator creates a cabinet, then they are the
owners.

Senior Library
Administration

Senior library administrators have full control of the FileHold library itself
and library administration area. Senior library administrators can create
cabinets to be managed by any Library Administrator or Cabinet
Administrator.
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Role Name

Description

System
Administration

System administrators have complete control of the system. They can
perform all of the functions of all other roles. However, the main tasks of the
system administrators are to add users to the system (including assigning
the initial password and setting requirements for all new passwords and
ability to self-register), assign users to their appropriate groups, enable
document control numbers and version control numbers, manage user
accounts, user groups and the system license pool. The system
administrator also has access to various global settings (outbound e-mail,
system wide configurations for managing the various documents format
conversion permissions etc.) and as well as user activity reports.

NOTE: All roles provide document emailing capability. This can be disabled on a role by role
basis by a system administrator in the FileHold Groups area. See the System Administration
Guide for more information.

3.1. DOCUMENT PERMISSION ICONS

The permission icon to the left of the document indicates the degree of access you have to a
file in the document management system. The permission that you have to the document is
dependent upon the role you were assigned.

Document

R b Lo
o oD

] 1310110950

Mame re

1] 131011095009
1] 131011095009

=)

Descriptions for permission icons are outlined below in order from most flexible to most

restrictive access to t

he document.

Permission Icon

Description

@

Red, Yellow and Green Dots indicates that the user has full access
to that file in the document management system and is able to
read, edit or delete the document. This document is being stored as
an electronic document type and not as an electronic record and
can therefore have multiple versions associated with it.

Red and Yellow Dots indicate that the user can only read or edit the
document.

Red Dot indicates that the user has Read-Only access to the
document. This could indicate that the user has read-only
permissions, the document is checked out by another user, or
under workflow.

Gray Dot indicates that the document is an electronic record and
not an electronic document type. This means that there is only one
version of this file and there are very strict restrictions for all users
for the deletion of this document.

September 2025

€ FileHold .




FileHold 17.1

End User Guide

Permission Icon

Description

Rectangle with Dot indicates an external/physical document (called
an "off-line document”) for which metadata is available but there is

no electronic file associated with it in the documents management

system

"H" indicates that the document version is hidden while it is
undergoing a workflow. The "H" is only seen by those that are
observers or participants of the workflow

indicates that the current document is under workflow. Only
previous versions are available at this time. The "!" is seen by those
who are not observers or participants of the workflow.

Purple dot indicates an electronic document is in the library archive.
Electronic records in the archive keep a grey dot.

22
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4. LIBRARY TREE OVERVIEW

The Library structure view of FileHold provides a familiar and intuitive means to view and
search for content held in the document management system. When users first log on to
FileHold the file structure appears on the left side. The upper folders, including the My FileHold
group, act as a personal space for users to organize and work with items retrieved from the
system. The rest of the tree represents the hierarchical arrangement of the entire document
management system. The library is at the top and is divided into cabinets, drawers, folder
groups and folders. The following is an overview of each major section of the Library file
structure.

22 Document oy

- |+ Inbox (Send to Library) ) Add Document

My FileHold
@ # &2 My FileHold

[_EJ, Reviews & Approvals
{7 Recent Folders # [, Reviews & Approvals

+ Q Search

# [ Virtual Folders

E Reports
+ EE Library

+ E Library Archive

+ n Teams

The FDA, on the left, and the web client, on the right, have slightly different options.

e Inbox (Send to Library) Folder - The Inbox folder contains a list of documents that are
locally queued for processing prior to being sent to FileHold. Note: The Inbox view is only
available to users accessing the document management system using the FileHold
Desktop Application software. The FileHold Desktop Application is designed to streamline
the importing of legacy files into the document management system by removing the
bottlenecks associated when adding and classifying files en masse.

e Document Tray — The web client only provides a button at the top of the library panel for
opening the document tray.

e Add Document — The web client only includes the Add document wizard to add one
document at a time without first locating a folder to store the document.

e My FileHold - The My FileHold section provides users with personalized views of files. The
files located in the My FileHold area is local to the user's machine and login credentials.

o Reviews & Approvals - See the review or approval tasks you have been assigned and the
workflow status report.

o Recent Folders — A list of the last 10 used folders is displayed in the tree in FDA, the Select
Destination windows, and FileHold Office Client window. The Recent Folders list is not
displayed in the Web Client. This is useful for viewing and keeping track of what areas of
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the document management system you are using and quick access to the documents in
those folders.

Search - Provides access to saved search results.

Virtual Folders - Virtual Folders are personalized custom folders that allow users to
reference to files located in different folders throughout FileHold without the need for
duplicating the files. This allows users to logically group and organize documents for
individual use without compromising security or clogging up the document management
system with personal folders full of nothing more than duplicates.

Reports (if configured) - Provides easy access to various custom reports developed by the
IT department using SQL Server Reporting Services or the simple report method.

Library — Where active documents are stored. FileHold provides a completely customizable
hierarchy to store and manage electronic documents and records using a cabinet / drawer /
folder group / folder metaphor. Research shows that filing documents 3 to 4 levels deep is
the most organized means to store files and provide for efficient retrieval. By expanding the
various levels of the library or library archives users are able to browse down to the various
folders in the system.

Library Archive — Located at the bottom of the file structure is usually a clone of the library
structure. It is meant to be the long-term storage space for records or other important
documents which are no longer active and were moved to the Library Archive manually or
by an automated process based on the document life cycle policies defined by library
administrator(s).

Teams (if configured) — The interface between FileHold and your Microsoft 365 Teams and
team folders.

24
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5. INBOX (SEND TO LIBRARY)

The FileHold Desktop Application’s (FDA) Inbox is designed to streamline the importing of
many documents into the library by removing the bottlenecks associated when adding and
classifying files en masse. The Inbox is a queue or list of files that have not yet been copied to
the FileHold Server.

The Inbox is specific to each user's FileHold Desktop Application (FDA) on their workstation
and user account profile unless you share your Inbox. Sharing your Inbox allows others to file
the contents of your Inbox on your behalf. For example, if there is a dedicated scanning station
with several people scanning documents to be added into FileHold, all users who can log into
the Windows environment of that scanning station are able to file all the scanned documents in
the Inbox. This is because the Inbox is shared between all the users who can log in with a
Windows user account.

The Inbox is the first category visible in the library structure. The Inbox acts as a staging area
for documents that are queued for processing on the client machine prior to be sent to the
Library. All documents in this list remain on the client machine until they are sent to the library.
Files located in the Inbox are ready to be sent to the Library once they have both required
metadata (tags) values entered and a destination folder associated with each file.

Library

-8 My FleHoid Select View: | Defauk View

£ Reviews & Approvals

S

9 Recent Foiders @ Remove From Inbox Edit Metadata Edt Destination Send Send Al Auto-Fie 0
i 42 Search Document Name Status Document Schema Coming From Going To Progress

+ £ Virtual Folders "% A_GdPicture fo Required F-18-Quotations and Tenders-Broch... C:\Use...\documents20200120104342 Set Destination

=83 Library
& Accdent and Heaith Insurance (A%
+- @ Accounting
+@ Corporate

% Bke_14_ID#_FR-M636-40 I

uired F-18-Quotations and Tenders-Broch...  C:\Use...\documents20200120104342 Set Destination

Click arrow in column header to sort
ascending/descending order

Users can quickly add all the files from a network folder to the Inbox to prepare for filing. Files
in the Inbox that still need to have their metadata or destinations set have a status of “Info
Required”. This information is necessary before they can be filed in the Library.

NOTE: The Inbox is not available in the Web Client interface.

The status column lets users know if more information is required before the file can be sent to
the document management system. A status of "Info Required" indicates that the required
metadata or a destination have not been set. Once all the required information is set, the status
changes to "Ready to Send" and file can then be uploaded by clicking the Send or Send All
(used when multiple files are ready to be sent to the Library). The documents are then sent to
their destination folders and are removed from the Inbox.

The Inbox can be sorted by document name, type, coming from, or going to by clicking on the
column header name. The columns can be sorted in ascending or descending order by clicking
on the arrow button next to the header name.

The following table describes the functions of the Inbox:

Function Description

@ Adds documents from outside the document management
Add file) system.

Remove from Inbox Removes the selected document(s) from the Inbox.
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Function Description
Edit Metadata Allows you to enter the metadata for the selected
documents.

Select multiple documents to be filed under the same
schema and click Edit Metadata. You can set all the
metadata fields to the same value.

Edit Destination Allows you to select the destination folder for documents.

Select multiple documents to be filed under the same folder
and click Edit Destination. You can set the destination to
the same folder.

Send Sends a single document to the Library. The metadata and
the destination must be set in order to send a document to
the repository.

Send All Sends all documents that have set metadata and
destination to the library.

Auto-File Automatically files documents in folders. This needs to be
configured. See the Library Administration Guide for
information on auto-filing.
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6. MY FILEHOLD

The My FileHold area of FileHold provides views of documents that are unique to each user. In
other words, it is a personal document workspace for you. This area allows you to access the
documents that you use most frequently, documents that you have checked out, and any alerts
or reminders that you have set on documents.

-4k My FileHald

----- "7 My Favorites

----- [ Checked Out Documents
----- [ Document Alerts

----- [ Document Reminders

----- [ Recently Accessed

----- [ Recently added

----- :ﬁ Calendar

6.1. MY FAVORITES

My Favorites is a list of files that the user has flagged as favorites. To make a document a
“favorite”, click the star next to the document name so it turns yellow. A yellow star indicates a
favorite document and display in the My Favorites list.

Document Name <+ Type Linked Ver Status Last Modified On
7 @ & nvoice-TPO300018852  Invoice 0

f?we-wumuzgun Tnvoice 0
Yellow star indicates a

"favourite" document

Checked In  04/03/2011 1:45 PM Edit

1
1 Checked In  04/03/2011 1:46 PM Edit

6.2. CHECKED OUT DOCUMENTS

Checked Out Documents are a listing of documents that the user has checked out of the

system. The red dot icon © signifies that the document is checked out and cannot be
modified by other users.

For more information on how to check a document in and out, see Checking In/Out.

i My Checked Out Documents Select View:  Default View
™
e R [0 L0 e (?)
Document Name Location Document Schema Linked Ver Checked Out Date Last Modified On
7 © " Creating FastFind Templates Training and Support / FleHold 15 / d... Work Order 0 2 6/1/2021 1:53 PM 5/28/2021 3:21 PM
10 ] 1

6.3. DOCUMENT ALERTS

Document Alerts is a list of notifications received about documents or folders users have
subscribed to. For more information on setting document alerts, see Setting Document Alerts
and Reminders.
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6.4. DOCUMENT REMINDERS

Document Reminders is a list of reminders to check on certain documents at a set time. For
more information on document reminders, see Setting Document Alerts and Reminders.

6.5. RECENTLY ADDED AND RECENTLY ACCESSED

Recently Added is a list of files that the user recently added to any location in the document
management system in the last 14 days.

Recently Accessed is a list of files recently accessed (opened, checked out/in, reviewed, etc.)
to any location in the document management system in the last 14 days.

- My Recently Accessed Documents Select View:  Default View
4 VIR x
Document Name Location Document Schema Linked ver Status Action Type Action Date -

* o 2 5 Edt

@ X JKL Co Contract.vi.v2 Training and Support / FieHold 15/ C... Contract 0 2  Checkedln  Downloaded 6/1/2021 1:57 PM Edit

© "E Creating FastFind Templates Training and Support / FieHold 15 / d... Work Order 0 2 Checked Out Downloaded 6/1/2021 1:53 PM

© ¥ DEF Co Contract Training and Support / FleHold 15 / d... Estimates 0 1 Checked Out Downloaded 6/1/2021 1:53 PM

@ ) DEF Co Contract.v1.vl Training and Support / FieHoid 16.0 /... Contract 0 1 Checked In Viewed 5/31/2021 2:10 PM Edit

6.6. CALENDAR

The Calendar helps keep you organized by showing all of your tasks, reminders, and event
schedules so you can become more proficient at accomplishing your document management
goals.

The Calendar is shown in the My FileHold area of the Library tree in the FileHold Desktop
Application (FDA). The Calendar is not available in the Web Client.

Library Set the view to the

. . == Events can be seen for System
é"g ;::Eﬁ;::";d to Library) Calendar Month, Week, or Day and Library Administrators
E !;a:i:;rgzi Dacuments Week Day  Today = ,E’ e, Xl L
-] Document Alerts Maonday Tuesday ‘Wednesday Thursday Friday Saturday Sunday
-] Document Reminders 30 31 1 F 3 4 5
= Recently Accessed ( T savents )
Scroll through the
- E R B Approvals months and years
({7 Recent Folders g 7 5 g 10 11 12
=42 Search
-2 My Saved Searches
42 Public Saved Searches Task is not
- Virtual Folders overdue
= Library 13 14 15 16 17 18 19
EB Rl \' 1 reminder . ( 1 event T 4 gvents ]
-5 Projects " -~ /s g
-] FileHald'ng
- Enginesring
[ {57 Projects 20 21 2z 23 24 25 26
B Ptk BERNTESN 0
[ FileHald't0 i "
2 Training and Support ( 1 reminder Task is overdue
£ {57 FileHold 12 /
[ Autko-initiate 27 28 20 30 1 2 3
[&] Auto-Tagging Folder ( W' _
[ Email %
[ Forms
1 New Features
P v

To AcCESS THE CALENDAR
1. In FDA, got to My FileHold > Calendar.

2. The Calendar can be viewed by the Month, Week, Day, or today (current date). You can also
scroll through the months, weeks, days, and years using the scroll arrows.

28 S Hold
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3. Click Today to bring you back to the current date (today’s date).
4. You can click on a day in the Month or Week view to see the details for the day.

5. Click on a task or a reminder in the Day view to open the document in the My Tasks view for
tasks or in the My Document Reminders View for reminders.

You can view the following items in the Calendar:
e Active, overdue, and completed workflow tasks:
e Completed tasks are in a light green background.

e Due tasks are in a green background with bold text and then number of tasks due in
brackets.

e Overdue tasks are shown in red with bold text and the number of overdue tasks in
brackets. A task is considered overdue the day after the task is due. Note that this
shows that there is only one task overdue but two tasks were due on that day. Only
one task was completed.

e Reminders are displayed in cyan background. Active reminders that have not been marked
as read are bolded with the number of active reminders listed in brackets (). Active
reminders that have been marked as read are un-bolded. Only the current days’ reminders
are considered active. Lapsed and future reminders are not active.

e Scheduled events when the Include Events button is selected. Only users with library
administrator roles and above can access this feature. Events are for when documents are
set to be archived, converted to a record, disposed, or a user defined event. Events are
displayed in yellow background.

6.7. RECENT FOLDERS

The Recent Folders area displays a list of the last 10 used folders is displayed in the tree in
FDA, the Select Destination windows, and FileHold Office Client window. The Recent Folders
list is not displayed in the Web Client. This is useful for viewing and keeping track of what
areas of the document management system you are using and quick access to the documents
in those folders.
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7. SEARCHING

You can find a document in FileHold using the powerful and robust search capabilities. There
are three methods of searching for documents in FileHold:

o FastFind — Use predefined hot keys to search within FileHold from third party applications.

o Full text Search —The full text search (also called simple search) is a “Google-like” toolbar
that uses a full-text search. FileHold has the ability to recognize, index text and allows
users to search content of all your favorite document types including PDF, Microsoft Office,
Zip and many more. When searching using the full text search, the system searches both
the metadata associated and the content of the document for matches. Full text search is
particularly useful for general searches of files stored in a records management system.
For example, searching the system for all files that make reference to Sarbanes Oxley.

e Advanced Search — The advanced search allows users to use the metadata associated
with a document to help locate the file. This is particularly useful when users have a
specific piece of information they would like to search for. Up to ten search parameters can
be used in an advanced search.

7.1. HOW TO ACCESS SEARCH

There are several methods in accessing the Search function.

e Click Search, My Saved Searches, or Public Saved Searches in the Library Tree.

EI ----- Search
@@ My Saved Searches
EJQ Public Saved Searches

]

o From the FDA, use the search bar in the top right of the screen.

Full text basic query JJ,Q @&

=
Full text search or Advanced search |

[Search name I quick search

~_ T~

| \|"Quick search - Case documents @:' @

e From in a folder in the Web Client, use the search bar in the top right of the screen.
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Right-click on any area of the library and select Search. This restricts the search to that
location in the library.

I N R

EE Library
EI ----- E Accounting

----- =1] [nvoices

| Search

o =

Open Drawer

e Click search from the library panel to display the simple search panel. Click Advanced to
access the Advanced Search screen.

Simple search - Full text basic query Show advanced

Search

Quick search - Case documents Show advanced
| ) [Seamen] &

e From the quick search panel. Click on any saved quick search.

I Quick search Value search
> name dialog
7
Quick search —klrlrﬂject number j
Projec:\# |3lease Select... “~_ w [ Search
< \R\
Custom search [ Search value I
prompt

7.2. USING THE SIMPLE SEARCH BAR

The search bars in the FDA and Web Client can be used to:

e Perform an ad-hoc search L . This type of search is the same as a “Contains in FTS”
search or simple search.

e Perform a quick search L .

e Start an advanced search L .
Depending on the search selected, the ad-hoc and quick search icons change. The search
menu is ordered by:

1. The last 5 recent quick searches. The default quick search is the most recently used
and is displayed at the top of the list.
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2. Ad hoc search.
3. Private quick searches.
4. Public quick searches.
Quick
search icon

Recent 5 quick searches. Most

recent and default at the top of
Ad hoc or the list.

bike search
quick db dd

Ad hoc

simple search

Private quick searches

bike search

Invoice # Search
quick db dd
URL quick

Public quick searches

For an ad-hoc search, the L icon is displayed. Simply enter the search term and hit Enter.
The full text search results are displayed below. To change to an ad-hoc search from a quick
search, click the icon select the Ad hoc option from the menu.

For a quick search, the Q icon is displayed. When this icon is displayed, enter a search
term and hit Enter. The search results are based on the default quick search (most recently
used). For the displayed quick searches, only “contains” type searches are displayed. There
are no options for dates, drill-down or drop-down menu type searches. These types of quick
searches are available from the list in library tree.

NOTE: The ad-hoc search option may be disabled by an administrator.

7.3. DISABLED AD-HOC SEARCHES

Ad-hoc searches are searches that a users can run on the fly. While ad-hoc searches are
powerful, they can also be performance hogs on the system if poorly designed. Some users
never have the training necessary to perform or plan well formed ad-hoc searches such a
guests or infrequent users. In order to prevent such users from negatively affecting system
performance, ad-hoc searches can be disabled.

In these cases, the only types of searches that a user can perform are public saved searches.
An administrator needs to configure these for groups that have ad-hoc searches disabled. The
ability to create, modify, or save a search is removed. All search bars are removed. Searching
from the library structure (right-click > Search) is removed. Clicking the Search node in the
library tree does not start a search.

If you have been restricted from performing ad-hoc searches, see your administrator.

7.4. HOW FILEHOLD SEARCHES FOR DOCUMENTS

Users can only retrieve documents to which they have access. Access is based on user rights
and permissions. Therefore, in order for a user to see a document in their search results they
would have to be a member of the cabinet, folder, and schema that the document belongs to.
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The following are how the document management system conducts searches for documents:

7.41.

1.

When using the operator “Contains in FTS” or “Does not contain in FTS”, it searches all
metadata, file properties, document name, and content (full text indexing) of the
documents.

When using the operator “Contains in DB” or “Does not contain in DB”, it searches the
metadata (databases) only. The content of the documents (full text indexing) is ignored.

FileHold searches for whole words only. Partial words need wildcards (*, ?,) (think of
“Google").

Metadata searches return the most relevant of results. Metadata searches also return
faster search results as it searches the Microsoft SQL database only.

When the user invokes search functionality on a cabinet, drawer, folder group, or folder,
the search is restricted to the portion of the file structure from which the search was
invoked.

The contents of the Library Archive are NOT included in the search. To expand the search
to include the Library Archive, select the Include in Archive check box in the Advanced
Search options.

If using a simple search or the Boolean search, the search engine ignores all document
fields such as those created by file properties.

Documents that have been deleted from the system are not included in the search.

Only the latest version of a document is searched. The document usage history and
document version history are not included in the search scope. To expand the search to
include all document versions, select the Include All Document Versions check box in the
Advanced Search options.

My FileHold, Search, Saved Searches and Virtual Folders contents are not searched
because these are links to documents and not where the documents reside.

Metadata field names that have been edited or deleted are not searched. To search using
old metadata field names, select the Search Using Historical Metadata Fields check box in
the Advanced Search options.

General Usage

Avoid searching for two letter words alone; instead use three letter words or simply use a
wild card (*) before or after the 2 letters. Two letter word searches are not searchable for
several technical reasons:

The two letters you are searching for can appear in a portion of a word, or very commonly
on their own, these if used in the search engine criteria, would greatly slow down and
impede the performance of the FileHold search system.

In addition, they can also affect the quality of search results because they can appear
inside a larger word or on their own with great frequency. This throws off search quality to
unacceptable levels. The document management system is designed to ignore common
words or characters as they tend to slow searches without improving the quality of the
results. See the table below on Noise Words.

Use whole words when searching for words inside of documents. Simple search acts like a
"Google" search and partial words may not return the results you are looking for or may not
return any results. If you need to use partial words, use a wildcard (*, ?,) with the search.
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3. If you use a very generic search term, then the search engine may time out. Try to look for
unique words or terms or limit the search to a specific area in the Library. See Full Text
Search — Wildcard Search Limitation Setting for more information.

7.4.2. Noise Words

A noise word is a word such as "the" or "if" that is so common that it is not useful in searches.
To save time, noise words are not indexed and are ignored in index searches. All single letters
are ignored and include the list of words in the table below.

Letter Noise Words

A a, about, after, all, also, an, and, another, any, are, as, at

B be, because, been. before, being, between, both, but, by

C came, can, come, could

D did, do

E each, even

F for, from, further, furthermore

G get, got

H had, has, have, he, her, here, hi, him, himself, how, however

I i, if, in, indeed, into, is, it, its

J just

L like

M made, many, me, might, more, moreover, most, much, must, my

N never, not, now

(0] of, on, only, or, other, our, out, over

S said, same, see, she, should, since, some, still, such

T take, than, that, the, their, them, then, there, therefore, these, they, this, those,
through, thus, to, too

U under, up

\% very

w was, way, we, well, were, what, when, where, which, while, who, will, with,
would

Y you, your

7.5. SEARCH REQUEST TYPES

FileHold supports different types of search requests:

e An "any words" search is any sequence of text, like a sentence or a question. In an "any
words" search, use quotation marks around phrases, put AND in front of any word or
phrase that is required, and NOT in front of a word or phrase to exclude it. Note that the
operators + and — are not supported. Examples include:
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e banana pear "apple pie"

e "apple pie" NOT salad AND "ice cream"

e An "all words" search request is like an "any words" search except that all of the words in
the search request must be present for a document to be retrieved. Example:

e FileHold Systems finds all documents with the words FileHold and systems

Noise words, such as “if”: and “the”, are ignored in searches.

Such operators and logics including: stemming, fuzzy, synonym and phonic can be used with
“contains” or ‘does not contain” type searches. Because the stemming, fuzzy, synonym and
phonic search methods can impact search performance the ability to search using Fuzzy,
Synonym and Phonic searching is a global setting configured by library administrators. See the
Library Administration Guide or the Knowledge Base for more information. Individuals can also
search using these logics for individual full text searches. Search terms may include the
following special characters:

Character Meaning Examples

? Matches any character. appl? would match apply and apple

but not apples

= Matches any single digit. N=== would match N123 but not

N1234 or Nabc

* Matches any number of characters. appl* would match apple, application,
Use to search for a term where the etc.
spelling is in question or there are P o
multiple possible spellings cipl” would match principle,

’ participle, etc.
Note: Use of the * wildcard character an*ed would match apolied
near the beginning of a word slows ap roved. etc pplied,
searches somewhat. pp U

% Fuzzy search. The number of % ba%nana:
characters you add determines the L
rumoer ofiferences e search | 104 TUSLbeat il b and e o
engine ignores when searching for a banana
word. The position of the % '
characters determines how many b%%anana:
letters at the start of the word have Word must begin with b and have at
to match exactly. i ;

most two differences between it and
banana.

# Phonic search. Phonic searching Put a # in front of the word in your
looks for a word that sounds like the | search request. Example: #smith also
word you are searching for and finds Smithe and Smythe.
begins with the same letter.

~ Stemming. Stemming extends a Add a ~ at the end of words that you
search to cover grammatical want stemmed in a search.
variations on a word. . ) .

Example: apply~ also finds applying,
applies, and applied.

A search for fish would also find
fishing.
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Character Meaning Examples

& Synonym search. Synonym Put a & at the end of the words you
searching finds synonyms of a word | want to use in your search request.

that you include in a search request. A search for fast& would also find

quickly.

7.5.1. Words and Phrases

To search for a phrase, use quotation marks around it, like this: "fruit salad"

If a phrase contains a noise word, the search engine skips over the noise word when searching
for it. For example, a search for statue of liberty would retrieve any document containing the
word statue, any intervening word, and the word liberty.

Punctuation inside of a search word is treated as a space. For example:
e can't would be treated as a phrase consisting of two words: can and t.
e 1843(c)(8)(ii) would become 1843 ¢ 8 ii (four words).

7.6. FULL TEXT SEARCHES (SIMPLE SEARCH)

Full text search (also called simple searches or ad-hoc searches) in FileHold uses a “Google-
like” toolbar to return full-text search results. FileHold has the ability to recognize, index text
and allows users to search content of all your favorite document types including PDF, Microsoft
Office, Zip and many more. When searching using the full text search, the system searches
both the metadata associated and the content of the document for matches. Full text search is
particularly useful for general searches of files stored in a records management system. For
example, searching the system for all files that make reference to Sarbanes Oxley.

Types of simple searches:

e All words — By default an ‘and’ is placed between any of the words typed in the search bar.
For example: banana pear apple pie returns any documents with the words banana,

pear, apple and pie.

e Exact phrases — Enter exact words in quotes. For example: banana pear “apple pie”
returns any documents with the words banana pear and the exact phrase “apple
pie”.

e Any words — Type OR between words. For example: banana or pear “apple pie”
returns any documents with the words banana or pear and the exact phrase “apple pie”.

e No words — Put a minus sign (-) before the words that you don’t want. For example:
banana -pear returns any documents with the word banana but not pear.

There are three locations where you can find the Simple Search screen:

e Click Search in the Library hierarchy. The simple search form that appears allows users to
search the contents of the entire documents management system using the full text search
engine.

e The Search field located in the top right-hand corner of the FileHold Desktop Application
user interface:

’ HOld September 2025
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7.6.1.

| Simple search panel i e | |Q @ 2

Simple search - Full text basic quéry ped Show advanced P

Search [ Simple search bar l

e In afolder view or Search in the library tree of the Web Client:

1Copy » CheckOut b EditMetadata Link Move/Copy Delete ConvertTo Offine SendTo... b Select View:[UgEEEIRIETEPE)] Rd| - | Fulltext basic query Q Q
a
Add File to Folder I

Product Development/General/Product Ideas 7  Results 130 of 414

Nacumeant —

a Document Tray Simple search - Full text basic query

3 Add Document - # | | Search | Q

@ £ My FileHold

=] E‘, Reviews & Approvals

=] Q Search

+ Q My Saved Searches

| Simple search panel l

The search results returned have a relevance ranking. The relevance value (expressed as a
percentage) is an approximation of how close the document is to the search criteria.

TO DO A FULL TEXT SEARCH

1. In the simple search bar, enter the search term and click Search. The search results are
displayed.

Full Text Search - Wildcard Search Limitation Setting

When a wildcard search (*) is performed or is used in conjunction with the “contains” or ‘does
not contain” operators in an Advanced search, using a common term in the repository may
return a very large number of intermediate search results that must be processed. A parameter
limitation can be set on the number of results returned when a search like this has been
performed. Care should be taken not to set a value that makes any typical searches
impractical. For most users this value does not need to be changed from the default which
returns all specified results that can be found before the full text search timeout expires.

Managed options is used to set the key Fts.LimitNumberOfEntriesToReturn. If the value is
set to 0, then the limitation is disabled. It is disabled by default.

If a wildcard full text search exceeds the limit set in the web config file then a message is
displayed:

“Your search with the CONTAINS in FTS operator would consume more server resources than
allowed by your system administrator. Consider narrowing your search conditions to reduce the
possible results. Your search would have returned {x} documents and your system
administrator has set a limit of {x} documents.”

7.7. ADVANCED SEARCHES

Advanced Search allows you to search by specific metadata fields and other system-recorded
information about the document.
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Users can combine searches in order to filter results. Users can also choose to search by
metadata only, search the archive, include all versions and search using historical metadata
fields by checking the boxes at the bottom of the advanced search form.

Advanced Search i Hide Advanced

Contract [ Contract manager w | In the List w |R0n Swanson j =
Contract / Effective date - | August 01,2017 kg | =
Contract / Al signed off? v [ Equals  [SRIOE =] Search

[] Boolean search [ ] Include archive in search [ ] Include all document versions [ | Search using historical metadata values

The parts of an advanced search include:

o Metadata Field Selector — Allows users to select the metadata field they want to search the
document management system with.

e Search Operator Selector — Allows users to select an operator to accompany a selected
metadata field. The list of operators are: Equal to, Between, Greater than >, Less than <,
Greater than or equal to >/=, Less than or equal to </=, In the list, or Is Blank. The list of
available operators is dependent on the type of Metadata field selected. See Search
Operator Selectors for more information.

e Search Criteria Value Select — Allows users to enter a specific search criterion based on
the metadata field and operator selected. The value field is based on the type of metadata
field selected. By default, there is only one value field for each operator. The only exception
is the “between” operator that allows users to search between two values such as dates or
numbers.

e Add or Remove Search Rows — The [ -] and [ + ] buttons to the right of each row allow
users to remove or add (respectively) rows from the search criteria. Multiple search rows
are joined automatically joined using the AND operator. Up to 10 rows can be used.

e Advanced search options — Options that can be used in an advanced search and saved for
future advanced searches by clicking the Save icon. Some, none, or all may be enabled or
disabled by default. See your administrator for details.

Metadata field selector Search criteria value
Add or remove
search
Search operator criterion
selector

Advanced search
options

Advanced Search ‘ ‘ Hide Advanced '@"
File or Metadata Contains in FTS | | seagcf Save advanced
& ’ search options

Boolean search |/ Include Archive in Search | Include All Document Versions | Search Using Historical Metadata Fields &

TO ACCESS THE ADVANCED SEARCH FORM

e From the 'Search and Saved searches' simple search, click the Advanced link to the right
of the search button.

e In the FDA or Web Client, click the Advanced search icon L .

e Clicking on a Saved Search in the library tree.
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¢ Right-clicking on the file structure and selecting Search. The search is automatically set to

start at the library, cabinet, drawer, folder group of folder level depending on where the
user right clicks.

TO DO AN ADVANCED SEARCH

1. Inthe Advanced Search screen, use the following table to build search queries. You can
use up to 10 search filters to build the search query.

Search Description Available search

option operator selectors

File or Allows users to add a full text search value to Contains in FTS

Metadata their metadata search criteria. This hybrid Does not contain in FTS

approach can be used to combine the best
aspects of full text and metadata only
searching. The same full text search operators
apply to this field as in Full Text Searching.

Full text o File or metadata — Searches both file Contains in FTS
unchanged from previous versions and is the (except for Raw query)
default.

e File only — Searches file contents only for
matching search terms.
* Metadata only — Searches metadata only for
matching search terms. The contents of the
file are ignored.
e Raw query — A direct search in the dtSearch
engine with no adjustments made by
FileHold. Raw dtSearch search terms are
required for this option. This option is
available only to system administrators by
default.
By default, a natural language query or
“Google-like” search is used with the full text
search options above.
Document Searches the system for a file by the name in Contains in FTS
Name the search criteria. Does not contain in FTS
Contains in DB
Does not contain in DB
Equals
Does not equal
Checked Out Search by the checked-out status of: Equals
Status e Checked In
e Checked Out
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Search Description Available search
option operator selectors
Person Allows users to search by: Equals
e Owned By Me Does not equal
« Owned By Someone Else In the list
e Checked Out By Me Not in the list
e Checked Out Be Someone Else
File Date File Data menu allows users to search by: Equals
e Date Last Modified Not Equals
e Creation Date In the List
o Approval Date (for workflow) Not In the List
Between
> (greater than)
< (less than)
>= (greater than or equal
to)
<= (less than or equal to)
At least
No older than
Workflow Search by the workflow status of: Equals
Status >
Approval e Approved Does not equal
Status e Pending Approval In the list
o Not Approved Not in the list
Workflow ¢ Not Submitted for Approval
Status >
Review Status | * Approval Postponed
Search by the workflow review status of:
¢ Reviewed
e Pending review
¢ Not submitted for review
Library Allows users to restrict searching to a specific Equals
Location cabinet, drawer, folder group or folder.

Searching using the library location applies a
“pre-filter” for the search engine to narrow
possible full text search results. This reduces
the time for searches with a very high
occurrence of hits in the full text index. This
also improves relevance values as fewer
search results are excluded after the database
portion of the search.

Does not equal
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Search
option

Description

Available search
operator selectors

Document Log
Action

Search for documents that have been checked
out, downloaded, checked in, copied, moved,
archived, viewed, printed, published, added,
linked, emailed, etc.

Equals

Does not equal
In the list

Not in the list

Document Log
Date

Search for documents that have had actions

performed on them within a date or date range.

Equals

Does not Equal
In the List

Not In the List
Between

> (greater than)
< (less than)

>= (greater than or equal
to)

<= (less than or equal to)
At least

No older than

Special Fields

Folder name — Search using part of a folder
name when the “Contains” operator is
selected. Note that no wildcards or dtSearch
keywords can be used for this option.

Contains in DB
Does not contain in DB
Equals

Does not Equal

File Type — The File Type extension list is

dynamically updated and sorted alphabetically.

A new file extension entry is dynamically
added to the initial standard list upon adding a
document with a new file extension for the first
time. The list is not updated in FDA until the
user logs in and out. Multiple file extensions
can be selected when the qualifier is set to “In
the list”.

Equals

Does not equal
In the list

Not in the list
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Search
option

Description

Available search
operator selectors

FileHold ID — The unique ID number given to
every version of a document. See Entering
Metadata.

Equals

Does not Equal
In the List

Not In the List
Between

> (greater than)
< (less than)

>= (greater than or equal
to)

<= (less than or equal to)

Document Control No. — Specialized metadata
field used to track specific document
numbering requirements.

Contains in FTS

Does not contain in FTS
Contains in DB

Does not contain in DB
Equals

Does not equal

Version Control No. — Like document control
numbers, used to track specific document
numbering requirements.

Contains in FTS
Does not contain in FTS
Contains in DB

Does not contain in DB

Equals
Does not equal
Has Markup — User can find documents that Equals
have been "Marked Up" using the Brava
Viewer Markup Tool.
Has Link — Users can find all documents that Equals
have been linked with other documents.
Is Favorite — Provides a list of documents that | Equals
are marked as favourites.
Document Format — Select Electronic Equals

Document, Electronic Record, or Offline
Document type.

Does not equal

Common MD
(metadata)
Fields

Allows users to search by common metadata
fields. For example, the metadata field
“Customer name” may be used in five different
schemas. The list of possible metadata field
options is customized based on how the library
administrator has defined the document
classification standards for the FileHold server.

Depends on metadata
field type. See Search
Operator Selectors for
more information.
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Search Description Available search
option operator selectors
Search by Allows users to restrict their search by Equals
Document document schemas and the associated Does not equal
Schema metadata. The list of possible document q

schemas and associated metadata fields is In the list

customized based on how the library . .

administrator. Not in the list

Searching using schemas applies a “pre-filter”

for the search engine to narrow possible full

text search results. This reduces the time for

searches with a very high occurrence of hits in

the full text index. This also improves

relevance values as fewer search results are

excluded after the database portion of the

search.
Search by Depending on the document schemas Depends on metadata
Metadata Field | selected, the associated metadata fields are field type. See Search
Name available to search by. Operator Selectors for

more information.

2. Select any of the following advanced search options:

e Boolean search — Allows a user to employ the Boolean search options.

e Include Archive in Search- Searches the documents in the library archive and includes any
matches in the results. FileHold searches only the library (current documents) if this option
is not selected.

e Include All Document Versions - Searches all versions of the document. FileHold only
searches the latest version if this option is not selected.

e Search Using Historical Metadata Fields - If metadata field names and values have been
changed over time, you can still search these "historical" items as FileHold keeps track of
any changes that have been made.

3. The above options can be saved by clicking the Save = icon so they are kept for every
advanced search performed.

4. Click Search. The search results are returned. You can continue to add or modify the
advanced search criteria, save the search, or export the results to a CSV file.

7.71. Search operator selectors

The available search operator selectors are described in the following table:

Search operator selector Description

Contains in FTS

Searches the full text search index which includes the
metadata, document name, file properties, and contents of
the document and contains an exact match of the value.

Does not contain in FTS

Searches the full text search index which includes the
metadata, document name, file properties, and contents of
the document and the value is not present.
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Search operator selector

Description

Contains in DB

Searches only the metadata and contains an exact match
of the value. The contents of a document are ignored (full
text search index).

Does not contain in DB

Searches only the metadata and the value is not present.
The contents of a document are ignored (full text search
index).

Equals Matches the specified value.
The “Search by” p option can be used with this search
operator selector if configured for database drop-down
fields. See your administrator for details.

Not equal Does not equal the value specified.
The “Search by” p option can be used with this search
operator selector if configured for database drop-down
fields. See your administrator for details.

Is Blank The value has been left empty (blank).

Below Matches anything below a certain level in a drill down

menu type field

> (greater than)

Is larger than the specified value.

< (less than)

Is less than the specified value.

>= (greater than or equal to)

Is larger than or equal to the specified value.

<= (less than or equal to)

Is less than or equal to the specified value.

In the list

Matches all values entered in the list. Multiple values are
shown in individual pills.

The “Search by” p option can be used with this search
operator selector if configured for database drop-down
fields. See your administrator for details.

Not in list

Show all documents that do not match the values entered
in the list. Multiple values are shown in individual pills.

The “Search by” p option can be used with this search
operator selector if configured for database drop-down
fields. See your administrator for details.

No older than x number of
days before now

The document is not older than x days before today. In
other words, 5 days old or less.
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Search operator selector

Description

At least x number of days
older than now
days.

The document is x many days older than the specified
date. In other words, show everything prior to the last 5

Between

Search for values that are within a set of values, given the
minimum and maximum values.

The following table describes the type of search operator selectors that are available for each

metadata field type:

Metadata Field Type

Available search operator selectors

Text

Contains in FTS, Does Not Contain in FTS,
Contains in DB, Does not Contain in DB,
Equals, Not Equals, Is Blank

Drill down menu

Contains in FTS, Does Not Contain in FTS,
Contains in DB, Does not Contain in DB,
Equals, Not Equals, Below, Is Blank

Drop down menu (FileHold managed and
database lookup)

Contains in FTS, Does Not Contain in FTS,
Contains in DB, Does not Contain in DB,
Equals, Not Equals, In the List, Not in the
List, Is Blank

Date

Equals, Not Equals, In the List, Not In the
List, Between, > (greater than), < (less than),
>= (greater than or equal to), <= (less than
or equal to), At least, No older than

Number / Currency

Equals, Not Equals, In the List, Not In the
List, Between, > (greater than), < (less than),
>= (greater than or equal t0), <= (less than
or equal to), Is Blank

Checkbox

Equals, Is Blank

“Is Blank” can be used in the event that a
check box type metadata field is added to a
schema but documents belonging to that
schema already exist in the system.

URL

Contains in FTS, Does Not Contain in FTS,
Contains in DB, Does not Contain in DB,
Equals, Not Equals, Is Blank

Boolean searches

A "Boolean" search request consists of a group of words, phrases, or macros linked by
connectors such as AND and OR that indicate the relationship between them. Examples

include:

Select the Boolean search check box in the Advance Search screen to use this functionality.

<
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Search Request Meaning
apple AND pear Both words must be present.
apple OR pear Either word can be present
apple w/5 pear Apple must occur within 5 words of pear
apple NOT w/12 pear Apple must occur, but not within 12 words of
pear
apple AND NOT pear Only apple must be present
apple w/5 xfirstword Apple must occur in the first five words

AND CONNECTOR

Use the AND connector in a search request to connect two expressions, both of which must be
found in any document retrieved. For example, apple pie and poached pear would retrieve any

document that contains both phrases.

A search for banana and pear w/5 grape would retrieve any document that (1) contains
banana, AND (2) contains pear within 5 words of grape.

OR CONNECTOR

Use the OR connector in a search request to connect two expressions, at least one of which
must be found in any document retrieved. For example, apple pie or poached pear would
retrieve any document that contained apple pie, poached pear, or both.

W/N CONNECTOR (PROXIMITY SEARCH)

Use the W/N connector in a search request to specify that one word or phrase must occur
within N words of the other. For example, apple w/5 pear would retrieve any document that
contained apple within 5 words of pear.

The following are examples of search requests using W/N:
e apple or pear w/5 banana
e apple w/5 banana w/10 pear
e apple and banana w/10 pear

The xfirstword term is useful if you want to limit a search to the beginning of a file. For
example, apple w/10 xfirstword would search for apple within 10 words of the beginning of a
document.

NOT AND NOT W/NUMBER (PROXIMITY SEARCH)

NOT allows you to exclude documents from a search. For example: apple sauce AND NOT
pear would return all documents with term apple sauce but exclude any that had pear.

NOT standing alone can be the start of a search request. For example, NOT pear would
retrieve all documents that did not contain pear.

If NOT is not the first connector in a request, you need to use either AND or OR with NOT such

as apple OR NOT pear or NOT apple w/5 pear.

The NOT W/ ("not within") operator allows you to search for a word or phrase not in association

with another word or phrase. For example: apple NOT w/20 pear.
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Unlike the W/ operator, NOT W/ is not symmetrical. That is, apple NOT w/20 pear is not the
same as pear NOT w/20 apple. In the apple NOT w/20 pear request, it searches for apple and
excludes cases where apple is too close to pear. In the pear NOT w/20 apple request, it
searches for pear and excludes cases where pear is too close to apple.

CAUTION: “NOT” cannot be used in conjunction with the search parameter “Folder name”. For
example, Folder name contains “not procedures” is not a valid search string.

Using the Raw Query field selector

A raw query is direct search in the dtSearch engine with no adjustments made by FileHold.
Raw dtSearch search terms are required for this option. Knowledge of the dtSearch engine is
required to use this type of search.

This option is available only to system administrators by default. See the System
Administration Guide to enable the feature for other roles.

Some examples of raw mode searches are:

e m_fn-— Searches on a specific metadata field ID where n is the internal ID number of the
metadata field. For example: m_£249 returns documents with a value in metadata field ID
249.

e contains — “contains” operator. For example:m f5 contains apple searches on the
term “apple” only in metadata field ID 5.

e ~ —The weight char is used for preferring text or metadata in search results ordered by
relevance. For example: ( ( DocumentMetadata”l contains ( (apple) ) )
OR ( //text™4 contains ( (pear) ) ) ) returns search results weights the
relevance more heavily on the contents of the document (pear) than the metadata (apple).
For more information on relevance, see the dtSearch documentation.

e DocumentMetadata — Searches all metadata. For example: DocumentMetadata
contains apple searches for the term “apple” in all metadata fields.

e LMID — Searches on document ID. For example: LMID 2 0 1 retrieves the document
with the FileHold ID of 201.

7.8. SAVED SEARCHES

You can save your advanced search templates as a Saved Search. Every time the search is
invoked any new documents that meet the query are brought into the results view.

Saved searches can be made personal or public. An Administrator can create "Public Saved
Searches". Public saved searches can be made available to all users or can be assigned
security rights so that only certain groups and users can use the public saved search.

Personal searches saved by the user are called My Saved Searches. These personal saved
searches can only be used by the user that created them.

There are three types of saved searches:

e Regqular saved search — The search template is saved with all of the search criteria
including operators and values for the selected criteria.

e Quick search — The search template is saved with only one empty variable in the template.
When a user runs a quick search, they are required to enter the search term for the empty
variable while all other search criteria remain fixed.

e Empty search — The search template is saved with empty values for all the search criteria.
The user is forced to enter the values prior to running the search.
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A default view can be set for each type of saved search so that the search results appear with
the correct columns and metadata information.

Regular Saved Searches

A regular saved search repeats a pre-defined search when invoked. All of the set values and
operators in the template are used in the search.

TO SAVE A REGULAR SAVED SEARCH
1. After performing an advanced search, click Save as Saved Search.
2. Inthe My Saved Searches window, enter a Name for the search.

3. If you want to make the search accessible to other users, select the Make this saved
search public check box (available to administrators only).

4. If this is a public saved search, click Next. Select the groups and/or users that can use this
public Saved Search and click Add. Public saved searches can only be created by library
administrators or higher roles.

5. Click OK. The Saved Search name is now in the Library hierarchy under Search > My
Saved Searches or My Public Saved Searches with an icon 18l

TO USE A REGULAR SAVED SEARCH

1. Click on the named of the saved search in the My Saved Search or My Public Saved
Searches area.

2. The results of the search are displayed. You can modify the search query by adding,
changing, or removing any of the filters.

Quick Searches

Quick searches are a type of saved search that allows you to leave a single variable in the
advanced search template empty while all other variables remain fixed. When a user runs a
quick search, they are required to enter the search term for the empty variable that was set up
in the template. The search results that are returned meet all advanced search criteria plus the
quick search term the user entered.

Quick searches can be made private or public by administrators just like regular saved
searches. Public saved searches can be made available to other users while personal saved
searches are only available to the individual that created them. Quick searches are useful for
conducting searches in Mobile FileHold since search terms cannot be entered for regular
saved searches (non-quick type saved searches).

Quick searches can be accessed from:

e My Saved or Public Saved searches list.

e The quick search icon L from the FDA or Web Client. The search results are based on
the default quick search (most recently used). Depending on the search selected, the ad-
hoc and quick search icons change. The search menu is ordered by:

1. The last 5 recent quick searches. The default quick search is the most recently
used and is displayed at the top of the list.

2. Ad hoc search or simple search.

3. Private quick searches.
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4. Public quick searches.

Quick
search icon

Recent 5 quick searches. Most
recent and default at the top of
the list.

Ad hoc or

bike search
quick db dd

Ad hoc

simple search

Private quick searches

bike search

Invoice # Search
quick db dd
URL quick

Public quick searches

Both saved quick searches and using the quick search icon searches work the same — enter a
search term and hit Enter.

If a quick search has been set up and configured to be used in conjunction with a FastFind
search, then this search cannot be deleted. See FastFind for more information.

A quick search can be integrated for use with external applications. See Integrating FileHold
Search with External Applications for more information.

CAUTION: Search variables with an operand of Owned by Me, Checked out by Me, and the
operator “Is Blank” cannot be used in quick searches.

TO CREATE A QUICK SEARCH
1. After performing an advanced search, click Save as Saved Search.

2. In the Save this Search window, enter a Name for the quick search or overwrite an existing
search.

3. If you want to make the search accessible to other users, select the Make this saved
search public check box (available to administrators only).

4. Select the Quick Search Condition check box and select the search variable that you
want a user to be able to enter a search term for.

5. When you check the quick search condition, a new prompt Custom search prompt will
appear. This is for optional text that will be displayed to the left of the value prompt.

6. If this is a public saved search, click Next. Select the groups and/or users that can use this
public Saved Search and click Add. Public saved searches can only be created by library
administrators or higher roles.

7. Click OK. The Quick Search name is now in the Library hierarchy under Search > My

Saved Searches or My Public Saved Searches with an icon E]

TO USE A QUICK SEARCH
1. Do one of the following:

e Click on the name of the quick search in the My Saved Search or My Public Saved
Searches area.
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e Use quick search icon Q from the FDA or Web Client. To change the quick search, click
on the quick search icon. For the displayed quick searches, only “contains” type searches
are displayed. There are no options for dates, drill-down or drop-down menu type
searches. These types of quick searches are available from the list in library tree.

2. Enter a value for the single search term and click Search or hit Enter.

3. The results of the search are displayed. You can view or modify the advanced search
query by clicking on the Advanced link in the header.
Empty Search Templates

When an advanced search is saved, all of the search criteria values can be left empty. This
forces the user to enter the search values and click Search once the saved search is selected.
This differs from regular saved searches which stores the search values in the template and
runs the query automatically.

TO CREATE AN EMPTY SAVED SEARCH
1.  After performing an advanced search, click Save as Saved Search.

2. In the Save this Search window, enter a Name for the quick search or overwrite an
existing search.

Select the Make this saved search empty check box.

If you want to make the search accessible to other users, select the Make this saved
search public check box.

5. If this is a public saved search, click Next. Select the groups and/or users that can use
this public Saved Search and click Add. Public saved searches can only be created by
library administrators or higher roles.

6. Click OK. The Empty Saved Search name is now in the Library hierarchy under Search >
My Saved Searches or My Public Saved Searches with an icon 8l

TO USE AN EMPTY SEARCH

1. Click on the name of the empty saved search in the My Saved Search or My Public Saved
Searches area.

2. Enter the values for the search terms and click Search. The results of the search are
displayed.

7.9. USING FASTFIND

FastFind is an optional feature that can search third party applications using hotkeys and return
the search results in FileHold. Users can use keyboard shortcut shortcuts that perform
searches directly from the chosen application in the document management system to find
relevant data instantly.

Once FastFind is enabled you can use the hotkeys in any third-party application. The pre-
defined hotkeys are:

e Mouse search (Alt+S) — Activates an on-the-fly screen scraper. When this is done a green
bar appears in the bottom-left corner of the user’s desktop screen. Users can now start
moving their mouse over screen form objects such as data fields or field labels. The text
under the current mouse position is captured and displayed in the green bar. If a user

50

< Hold

September 2025



End User Guide FileHold 17.1

7.10.

wishes to search with the captured text, they may left click to invoke the FileHold search.
This initiates the Full Text Search and Metadata search in FileHold and the search results
are displayed within the standard search results screen. Pressing the ESC button at any
time stops the mouse search mode.

e Selection search (Ctrl+D) - Selection Search is similar to the Clipboard Search (and in fact
is using Clipboard Search as its internal mechanism), however, it uses a one step process
to initiate the search after a user highlights their selection on a business application form or
as a part of the content of a document opened in a 3rd part application. Invoking Ctrl+D is
all that is needed to initiate search and display results within FileHold application.

e Clipboard search (Alt+C) — Users can copy any text from the screen to the Windows
clipboard using traditional “Copy” menu option or the Alt+C shortcut available in most
Windows applications and then by pressing the Alt+C combination they can activate the
Full Text Search and Metadata search in FileHold and the search results are displayed
within FileHold on the standard search results screen.

e Enable screen OCR search (Alt + F) — Allows you to do a search based on the Click to Tag
functionality. Once the shortcut key is invoked, you can click on the text on the screen or
draw a bounding box around the text. Then a search is performed in FileHold to meet the
selected criteria from the screen.

Since FastFind uses the contents of the clipboard any string displayed on the screen which can
be copied to the clipboard (similarly to when using the well-known Cut/Paste sequence in
Windows), it can be used as the search criteria including partial highlights of the text strings.

FastFind searches can be based on a full text search (file and metadata search) or a quick
search. If based on a quick search, it only searches on that specific search parameter and
nothing else in the system (unlike a full text search which searches through everything).
Advantages of using up a quick search with FastFind would be to be able to limit the search
results. For example, if FastFind was only used to locate an invoice in FileHold from your
accounting software, the search results would be limited to what documents would be found
using “Invoice Number” quick search. See Quick Searches for more information on configuring
quick searches.

FastFind must be a purchased option and enabled before the feature works. You can also
create your own FastFind templates that work with the system. See the Knowledge Base for
more information.

To ENABLE FASTFIND

1. Go to File > Preferences and Settings > FastFind Preferences and select the Enable
FastFind check box. See more information about FastFind preferences.

2. Click Apply and then OK.

SEARCHING FOR PREVIOUS VERSIONS OF A DOCUMENT

For system performance reasons, only the most recent version of the document is included in
the search scope. However, users can use the advanced search setting to include all versions
of documents (most recent and all previous) stored in the document management.

TO SEARCH FOR A PREVIOUS VERSION OF A DOCUMENT

1. In the Advanced Search, select the Include all document versions check box.
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7.11. SEARCHING FOR DOCUMENTS IN A WORKFLOW
You can refine your search criteria to search for documents based on their approval status.
Using Advanced Search, the user can select the Approval Status metadata field for any
document schemas as long as that schema has at least one workflow template associated with
it that contains at least one approval activity. Use the Approval Status select box to choose
whether or not the file being searched for is approved or rejected. The Approval Status field
can be used in combination with any other metadata field criteria for searching.
NOTE: If the workflow has NOT been set to hide the file until approval is complete, the file is
able to be seen by all users with access to the document. If the workflow is set to hide the
document until approval then it is not able to be seen by users who are not participants in the
workflow instance. All users are able to see the file once it is approved and the workflow
completed.
TO SEARCH FOR A DOCUMENT BASED ON APPROVAL OR REVIEW STATUS
1. Go to Advanced Search.
2. Click File or Metadata and select Workflow Status and select either Approval Status or
Review Status.
3. In the search operator selector, select one of the following: Equals, Does not equal, In the
List, Not in the list
4. In the search criteria value field, select an option from the drop-down list. For "in the list" or
"not in the list" search operator selectors multiple values are show as pills. For approval
status searches, the following options are available: Approved, Pending Approval, Not
Approved, Not Submitted for Approval, or Approval Postponed. For review status
searches, the following options are available: Reviewed, Pending Review, or Not
Submitted for Review.
5. Add any other search criteria to the advanced search and click Search.
7.12. HIGHLIGHTING DOCUMENT SEARCH RESULTS
In the FileHold Desktop Application (FDA), you are able to see the search results highlighted in
yellow in a simple HTML viewer which appears at the bottom of the window.
TIP: Search terms can also be highlighted in the FileHold viewer.
TO HIGHLIGHT SEARCH RESULTS
1. In the Search Results window of the FDA, right-click on a document and select Highlight
Results or click Highlight Results.
2. Any terms that match the search criteria is highlighted in yellow in the HTML viewer that
appears in a separate window below.
3. Press the navigation buttons to go to the first or last matched word or the next or previous
word. The word status displays the current word number and the total number of words.
All matched words in the view are highlighted in yellow, but the current word also has a
blue border.
4. Press Undock Snippets to show the highlighed results in their own window.
<L
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INTEGRATE FILEHOLD SEARCH WITH AN EXTERNAL APPLICATION

A saved quick search can be invoked through an URL address from an external application.
Once the URL is clicked, the search results are displayed in the Web Client. A quick search is
a type of saved search where the search template is saved with only one empty variable in the
template. When a user runs a quick search, they are required to enter the search term for the
empty variable while all other search criteria remain fixed.

A simple tool has been provided for users that do not want to build the URL manually. When a
quick search has been created and saved, the URL for the quick search can be created with
the URL Builder in the Web Client. In the URL Builder, the server address, the client type (Web
Client or Portal Web Client), log in type (local or Active Directory user), Ul type (normal, locked
or XML), and the quick search value are specified and a URL is generated.

The Ul type options determine how the search results are displayed:
e Normal means that the results are displayed in the normal Web Client Ul.

e Locked means that the search results are displayed in an embeddable locked view of the
web client where only the heading and the document list is found. There would be no
processing options, though one of the columns in the search results could be a link to the
document for web viewing or downloading. Additional settings are available for modifying
the title bar and page numbering in the search results screen when using this option.

e XML means that the search results are returned as an XML document. This can be
combined with an XSL style sheet or some other XML processing method to render the
precise output the caller desires. The column heading names and column values would be
included in the XML as defined in the search view. The XML output include the document
ID which can be used to build links for viewing or downloading the documents.

Once the settings for the URL are defined, the URL can be generated. The URL defines the
quick saved search name and value(s) for the quick search. For example:

http://<servername>/fh/filehold/webclient/gsearch.aspx?name=<quick sea
rch name>&value=<search value>

Where:
e <servername> is the name of the server where FileHold is installed
e <quick_search _name> is the name of the quick saved search

e <search_value> is the operand value that is used for the search. If more than one value is
needed, values can be delimited with a ; (semicolon).

Once the URL for the quick search is clicked from an external application, the saved quick
search runs and displays the search results in the selected Ul type option. If the user is not
logged in, the login screen appears first or the user is logged in using Windows Authentication
(single sign on).

The quick saved search can have the default view defined so that the desired information is
displayed in the search results every time the URL is clicked.

Here is a basic example of how it might look on company’s web site. For this example, the URL
is specified in an iframe with the Ul type in locked mode.

<iframe
src="http://yourservername/FH/FileHold/WebClient/gSearch.aspx?name=Doc
+Name&value=fh*gui=lock" width=600 height=400>
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#/C:/Projects/testSearchUrl.html

This example uses an iframe to msert the search results mto another web page.
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This 15 my web page!

Using the Ul Type option that returns XML, the page can be formatted how you want if XML
can be interpreted on your website.

The return page for the Web Client can be manually entered to include a returnPath parameter.
For example, the user can be returned to the Add Document Wizard:

http://yourservername/FH/FileHold/WebClient/gSearch.aspx?name=d dlm eqg
t&value=2014-09-05&ui=lock&returnPath=AddDocumentWizardForm.aspx

If you are using the Ul in Lock mode, the returnpath can also be entered in the web.config file
in C:\Program Files\FileHold Systems\Application Server\WebClient under the <appSettings>
area:

<add key="gSearch ReturnPage" value="Search ReturnPage PLACEHOLDER" />

If a value is entered, it is the default place the return button takes the user. If the path is not
fully qualified, it is relative to the FileHold server.

Deataimed Ao, [ ] Dotianom ahoima Linked et Ratus Lant Modified On
L+ ﬂ 1F 00 TSI Board Mretes-201 4 § October § Dary-18 Board Mrwfes o i Crecksdn 10HED & 1; 3100 Pm
L5 'Zlcm_pﬂ_bﬂ Bioard Mirubes-200 4 § October [ Day-18 Bioard Minubss (1] 1 Creciosdin 108208 T4535 PM
€ T macgement mesteg Wi, 2014 § Hcrmmbe | a3 Appication 1 1 Chechedin 41 E 113508 M
Le) zm Wounr-2074 § bowamber § Dary-3 Apphoation i i Creciedin 1182014 11:37:54 AM

To make the Return button invisible, set the value for gSearch_ReturnPage key in web.config
to empty. For example:

<add key="gSearch ReturnPage" value="" />

To CREATE AN URL TO RUN A SEARCH FROM AN EXTERNAL APPLICATION

1. Create a quick search and save it as public saved search. Ensure you assign the correct
permissions to the saved quick search.
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2. In the Web Client > Public Saved Searches area, right-click on the quick search name and
select URL Builder.

In the URL Server Part field, enter the path to the FileHold server.

In the Client Type area, select if the link is accessed through the Web Client or the Portal
Web Client (anonymous portal).

5. Inthe Login Type area, select if the user is logging in using a username and password, or
using single sign on (Active Directory integration). Note that if you are not using Active
Directory integration, the single sign on option is not available.

6. Inthe Ul Type area, select if the results are displayed in normal (Web Client), locked
(embedded locked mode) or XML (highly customizable mode).

7. If Locked Ul mode was selected, fill out the following information:

e Select the Disable title bar check box if you do not want the Search by URL title bar
displayed in the search results.

e Enter a Custom Title bar if needed such as "Documents to be approved". The default title
is "Search by URL".

e Select the Disable summary bar if you don’t not want the number of search results
displayed. For example, "Search Results 1-10 of 52".

e Select the vertical position of the page numbers in the Page Bars Vertical Position drop
down: Top, Bottom, or Top and Bottom.

e Select the horizontal alignment of the page numbers in the Page Bars Horizontal Alignment
drop down: Right, Left or Center.

<« c qa-sbd 200854 7077 FHF: tiaSearche—"" ~—qyal+stat.ndva B

" oy 3
Lol ' Page numbers ) TE5R
Search Resslls 110 of 52 € { vertical position:
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T 1 12388 100
o ] 1ZMEBC rydee 18002014
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i
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i‘q;'-i:lr.-unsnderm.m.:old
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T [5) BV 45595 Stapies 08.10-2014 alignment: rlght —

G m s, et

" — B lqzagsﬁ[

8. In the quick search parameter area, enter the value to be searched on Click Generate
URL.

9. Inthe URL Builder Result area, the URL address is displayed. Click Go To Link to test the
link.

10. Once the link is verified and working, copy and paste the link into the external application.
Note that there is no way to save this link so you need to copy and paste it into a Notepad
file or similar to retain the link address.

In the example below, a quick search on Approval Status was created with the search value
set to Approved. The resulting URL is:

http://QA-
STD2008X64:7077/FH/FileHold/WebClient/gSearch.aspx?name=quick+approval
+status&value=Approved
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URL Builder Properties "@'
URL Zerver Part

hittp: MGA-STD2005X64: 707 F/FHIFileHald!

Cliertt Type ® e Cliert ) Portal Wb Client
Login Type * pMormal Single Sign on
Ul Type

® jormal O Locked ) ML

Quick Search - quick approval status

Approval Status Enjuals Approved | Generate LIRL
URL Builder Result
URL Address [ http: 4124 -STD2008XE4: 707 7/F HFileHoldAebClient/gSearch aspx 7name=guick+apr] | Gato Link |

Note: The number of search results displayed on a page is set in the View Preferences for the
Search Results view.

56

€ FileHold

September 2025


http://www.filehold.com/help/user/view-preferences

End User Guide FileHold 17.1

8. VIRTUAL FOLDERS

Virtual folders are a good way for documents located throughout the FileHold library to be
displayed in one place. A virtual folder does not contain the actual document; it only holds a
pointer to the document. All virtual folders are private (unique to the user) unless they are
made public.

Document publishers and higher roles can create virtual folders for their own use.

Library administrators or higher roles can create virtual folders and make them pubilic.
Public virtual folders are seen by all users or groups that are given access. Users with
access to a virtual folder still need the proper permissions to access any documents that
are listed. Users with a document publisher role or higher may be given permissions to add
or remove documents from a public virtual folder.

If enabled in the public virtual folder settings, users and groups with a role of document
publisher or higher can add or remove documents from the public virtual folder. Removing
documents removes them only from the virtual folder; it does not delete the documents.

Documents that have been added or removed from a virtual folder are tracked in the document
usage log.

Virtual folders can be deleted at any time. The documents contained in a virtual folder are not
deleted from the system; they are located in their folder location in the library.

TO CREATE A VIRTUAL FOLDER

1.
2.
3.

Right-click on the Virtual folder section and select Add Virtual Folder.
Enter the name for the Virtual Folder.

If you are a library administrator, you can set the folder as public or private. Do one of the
following:

Click OK or Save if a private folder.
Click Next if a public folder.
If public, select the following options if required:
Allow document publisher and higher roles to add documents.
Allow document publisher and higher roles to remove documents.

If the Virtual Folder is a public folder, set the security to allow user access in the Security
tab.

Click OK or Save.

TO DELETE A VIRTUAL FOLDER

1.
2.

Right-click the Virtual Folder name from the list and select Delete.

Click OK on the warning message to proceed with the deletion process.

TO ADD A DOCUMENT TO A VIRTUAL FOLDER

1.

Select one or more documents that you want to add to a virtual folder.
Use the SHIFT or CTRL keys to select multiple documents in the FDA.

Check the box next to the document name to select documents in the Web Client.
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2. Right and select Send To > Virtual Folder.

e Alternatively, in the FDA, you can drag and drop one or more documents into the virtual
folder.

3. Select the virtual folder to which you want to add the documents or create a new virtual
folder.

4. Click OK. The shortcuts to the documents are now in the virtual folder.

TO REMOVE A DOCUMENT FROM A VIRTUAL FOLDER
1. Select one or more documents in the virtual folder that you would like to remove.
o Use the SHIFT or CTRL keys to select multiple documents in the FDA.
o Check the box next to the document name to select documents in the Web Client.

2. Click CLEAR remove the documents from the virtual folder. This does not delete the
documents from the document library.
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9. THE LIBRARY STRUCTURE

All files in FileHold software are stored under the library icon (root folder) shown in the file
structure located on the left-hand side of interface.

Taking a closer look at the file structure you can see that the document management software
uses a real-world metaphor for filing. The Library is filled with cabinets that contain drawers
that contain folder groups (optional) that contain folders. Only folders can contain documents.

EE Library

_I:l Cabinet

d Drawer 1

: {—111 Folder group
~ ~[IFolder 1

| [ Folder 2

d Drawer 2

1 Folder

/

NOTE: Documents are displayed as a list in the display pane to the right of the file structure.
Documents can be displayed by selecting the folder they reside in or by searching to gather
files from multiple folder locations.

Documents can only be stored in folders in the document management system. Folders can be
located directly within drawers or within folder groups.

Access to specific areas of the document management software is controlled by group and
user memberships at the cabinet and folder levels. Only users that are members of a cabinet
can see the cabinet to access its contents. Once inside the cabinet a user must also be a
member of the folders it contains in order to access files contained within the folder. If the user
is not a folder member, they do not see the folder. Users can see the membership associated
with a particular cabinet or folder by right clicking on the cabinet or folder and selecting
Properties. Once authenticated to access files inside a folder access to individual document
schemas is by schema membership. Users must be a member of schema in order to view files
associated with this document schema in the document management system.

NOTE: Users who are not members of a folder do not see the folder. To get access a user has
to be added by the owner of the folder or a library or systems administrator.

Along with memberships at the cabinet and folder level, the document management software
system, maintains membership permissions by document schema. For example, users in the
sales department can be restricted to only add, search for and access sales document
schemas (invoices, purchase orders and contracts) while users in the HR department can be
restricted to only add, search for and access only HR document schemas (expense reports,
vacation requests and performance reviews) even if they are located in the same folder. Only a
designated library administrator can change the membership associated with a document
schema. See setting up and managing document schemas for more information.

In addition to the membership in cabinets, drawers, folders and document schemas, access to
documents is controlled by roles that individual users are assigned to. All roles and their
related permissions are described on the user role page.

The document level permission icons indicate operations allowed for a given role or provide
some additional information regarding the statuses of the documents visible in the folder view.
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9.1. CABINETS

Only library administrators, senior library administrators, and system administrators can create
cabinets.

In order for a user to see a cabinet they must be a member of the cabinet. Only members of
cabinets can see and access its content. In order to manage the access to a particular cabinet,
the owner of the cabinet can add and remove member access and permissions. For more
information on cabinets, see the Library Administration Guide.

9.2. DRAWERS

Only cabinet administrators, library administrators, senior library administrators, and system
administrators can create drawers.

In order for a user to see a drawer they must be a member of the cabinet in which the drawer
resides. The availability of actions is dependent on the rights that users have to the cabinet that
the drawer resides unless further restrictions have been placed on the drawer by its owner, the
library administrator or the Systems Administrator. For more information on drawers, see the
Library Administration Guide.

The ability to browse the contents of specific drawers can be prevented. This can be done via
an API call or modifying a setting in the database. Contact support@filehold.com for more
information.

If browsing a drawer is blocked and a non-administrator clicks on a folder, the message, “The
administrator has disabled browsing in the <name> drawer” displays with an option to search
the folder. If the Search the folder button is clicked, the advanced search screen displays and
executes a search as though it is a saved search on a folder location. If the Cancel button is
clicked, the user is shown an empty folder.

If an administrator attempts to browse a drawer that is restricted, the message, "Browsing has
been disabled in the <name> drawer. Administrators can override this restriction and browse
the <number of> documents in the <name> folder. There could be performance issues
associated with the browsing folders with large numbers of documents” displays. The
administrator has the option of clicking Search the folder or Override browse restriction.
Overriding the restriction displays the documents in the folder.

9.3. FOLDER GROUPS

Folder groups are intended to be used as an extra layer of division in the Library structure but
their use is optional. Like drawers that divide cabinets into more manageable size; folder
groups divide drawers into more suitably sized portions. Folder groups contain only folders.

In order for a user to see a folder group they must be a member of the cabinet in which the
folder group resides. The availability of actions is dependent on the rights that users have to
the cabinet that the folder group resides unless further restrictions have been placed on the
folder group by its owner, the library administrator or the Systems Administrator.

The following actions can be performed on folder groups:

Action / Function What the Function Does Who Can Access the
Function
Open Folder Group Expands the folder group All users with access to the
revealing its contents. cabinet that the folder group
belongs to.
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Action / Function

What the Function Does

Who Can Access the
Function

Search Allows users to restrict their All users with access to the
search to files located in the folder group.
selected folder group.

Properties Displays the folder group All users with access to the
Properties. folder group.

Set Default View

Allows user to select a default
view that has been created in
the View Preferences.

All users with access to the
folder group.

Add Folder

Allows user to add a folder to
the folder group.

Users with Publisher or
higher access.

Move Folder Group

Moves the folder group to a
different drawer.

Users with Organizer or
higher access.

Copy Folder Group

Makes a copy of the folder
group including all folders and
files it contains.

Users with Organizer or
higher access.

Clone Folder Group
Structure

Makes a copy of the folder
group and the folders it
contains. Does not copy
documents in folders.

Users with Publisher or
higher access.

Delete Folder Group

Deletes the folder group and
all items it contains.

Users with Organizer +
Delete or higher access.

Archive Folder Group

Manually sends the contents
of the folder group to the

Library Archive.

Library administrator or
system administrators only.

Export

Exports all documents in the
folders contained in the folder

group.

Users with Organizer or
higher access.

TO MANAGE FOLDER GROUPS

1. Right-click on a cabinet and select Manage Folder Groups. The folder group list window
opens with a list of existing folder groups.

2. To add a folder group, click Add Folder Group.

3. Enter a folder group Name.

4. Select a weight for this folder group from -10 to 10. The lower the weight (such as -10), the
higher the folder group name appears in the Library. The higher the weight (such as 10), the
lower the folder group name appears in the list. Leave the weight at 0 if you want the folder
groups sorted alphabetically.
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Folder Group List 3

Add Folder Group

Folder Group Name Weight

Marketing 1]
Support - Materials 1]
Support - Screenshots [v]
Support - Training 1}

5
Add Folder Group @

Folder Group Name Support - Guides|

5. Click Save. The folder group name is added to the list.

TO ASSIGN A FOLDER GROUP TO A DOCUMENT FOLDER
1. Right-click on a folder in the Library and select Properties.
2. In the Folder Group field, do one of the following:

e Select the folder group to which you want this folder to belong from the list.

e To create a new folder group, select Add a New Folder Group and enter the name in the

New Folder Group Name field.

3. Click OK. The folder is moved into the selected folder group.

TO EDIT OR DELETE A FOLDER GROUP NAME

1. Right-click on a folder group in the Library and select Properties.
2. Click Edit Folder Groups.

3. To edit a folder group name, double-click on a folder group.

4

. In the Edit Folder Group window, enter a new name for the folder group and a weight
(optional). The lower the weight (such as -10), the higher the folder group name appears in
the Library. The higher the weight (such as 10), the lower the folder group name appears in
the list. Leave the weight at 0 if you want the folder groups sorted alphabetically.

5. Click Save.

6. To delete the folder group, click Delete.
Calculating the Folder Group Statistics

You are able to see how many folders, documents, number of files and size of the repository
that are contained within a folder group by looking at the statistics.

TO CALCULATE THE FOLDER GROUP LEVEL STATISTICS
1. Right-click on a folder group in the tree structure and select Properties.

2. In the folder group properties window, click Calculate. The number of folders, files (latest
version), size (in MB), files (all versions) and size of all versions (in MB) is shown. Click
Cancel to close the properties.
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9.4. FOLDERS

Folders are the level in the library structure where documents reside. Documents can only
reside at the folder level. The results for the total number of documents in a folder can be
viewed in the header bar. Only users that are members of a particular folder can access the
files that reside in that folder.

When a user with a role of Publisher or higher creates a new folder, they must associate
groups (or users) with the folder in order to protect the contents of the folder from unauthorized
users. ONLY groups (or users) associated with a folder see and have access to the folder.
Permissions can be further restricted once the groups or users are assigned as members.

The groups that are available to be members of the folder are inherited from the cabinet in
which the folder resides. If you wish to add groups other than the ones that appear in the folder
properties, the group must first be added at the cabinet level of the document management
system. After the group is added at the cabinet level, the new group appears in the Available
FileHold Group listing in the folder properties security section.

Security on the folder can be modified using the advanced security option. You are able to give
a user or group a role that is less than what is already designated to them. For example, you
can modify a cabinet administrator’s role to reduce it to document publisher. If a group or
user’s permissions are modified using the advanced security option, a red dot appears on the
folder that has been modified when the user logs in.

File  View  Tools  Help

Library

[ ] piglalers (Send to Library)
[+ My FileHold

o Reviews & Approvals
----- %7 Recent Folders

-4 Search

-5 Wirtual Folders

|:—:|-- Library
EB Training and Support
=57 FilsHold 13

Modified permissions at
the folder level. Cabinet
administrator role
lowered to document
publisher. Red dot
appears on folder

-FF Library &rchive

The availability of actions is dependent on the rights that users have to the cabinet that the
folder resides unless further restrictions have been placed on the folder by its owner, the library
administrator or the Systems Administrator. The following actions can be performed on folders:

Action / Function What the Function Does Who can Access the
Function
Open Folder Opens the folders and shows | All users with access to the
the files it contains. folder based on the folder
membership.
Search Allows users to restrict their All users with access to the
search to files located in the | folder.
selected folder.
Properties Displays the folder All users with access to the
properties. folder.
< Hold
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Action / Function

What the Function Does

Who can Access the
Function

Set Default View

Allows user to select a
default view that has been
created in the View
Preferences.

All users with access to the
folder.

Alert Me of Changes

Subscribes the user to be
alerted when certain actions
are performed on the folder
by other users. The types of
actions that trigger alerts are
managed by the users Alert
Preferences. Users can
remove folder alerts from the
My FileHold; Document
alerts page OR select the
'Disable This Alert' option
from the folder menu.

All users with access to the
folder.

Disable This Alert Disable the alert for the All users with access to the
folder. The user can no folder.
longer be alerted when
certain actions are
performed on this folder. Re-
activate the alert by clicking
on the 'Alert Me of Changes'
option in the folder menu.

Move Folder Moves the folder to a Users with Publisher or
different drawer or folder higher access that are the
group. folder owner.

Copy Folder Makes a copy of the folder. Users with Publisher or

higher access that that are
the folder owner.

Delete Folder

Deletes the folder and all
documents it contains.

Users with Publisher and
Delete or higher access that
are the folder owner. If the
user is Publisher and Delete
role, they must be also be
the owners of all document
versions in the folder before
they can delete a document.

Clone Folder

Makes a copy of the folder
group and the folders it
contains. Does not copy
documents in folders.

Users with Publisher or
higher access.

Archive Folder

Manually sends the contents
of the folder group to the

Library Archive.

Library administrator or
system administrators only.

Export

Exports all documents in the
folders contained in the
folder group.

Users with Publisher or
higher access and that are
the folder owner.
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TO CREATE A FOLDER

1.
2.
3.

In the Library, right-click a drawer or folder group and select Add Folder.
Enter a Name for the folder.

Select a folder owner for the list. Your permissions may be restricted to only allowing
yourself to be the owner of the folder.

Select a Default Schema from the list. The list of schemas are only those that you have
access to.

Select a Folder Group from the list (if applicable).

Select a Weight for the folder. The lower the weight (such as -10), the higher the folder
name appears in the Library. The higher the weight (such as 10), the lower the folder name
appears in the list. Leave the weight at 0 if you want the folder groups sorted
alphabetically.

Select a Color from the list. Options include: yellow (default), green, red, and blue. The
folder is displayed in the library tree in the selected colour.

Click Next.
In the Security tab, do the following:
In the Group By field, select how you want the available FileHold Groups displayed.

In the Available FileHold Groups area, select the groups you want to be able to access the
cabinet and click Add Groups. The group is added to the Current Members of Cabinet list.

In the Eligible Users in the FileHold Group, select the user you want to be able to access
the cabinet and click Add User. The user is added to the Current Members of Cabinet list.

To remove a user or group from the cabinet, select the name from the Current Members of
Cabinet list and click Remove Members.

To view all Groups and Users, click Group Members. A new All Groups/Users panel
opens on the right side of the window.

To see which user roles the user or group belongs to, select the user or group name in the
Current Members list and click Effective Permissions. The user role for that cabinet
member appears in the Effective Permissions list.

To set advanced security options on a user or group, select the user or group name in the
Current Members list and click Advanced Security Options. To modify the rights, select a
user role from the list and click Apply. To revert to the default user role, click Restore.
Note that if a group or user’s permissions are modified, a red dot appears on the folder that
has been modified when the user logs in.

Select the Inherit Security Permissions from Cabinet check box if you want to inherit the
security settings from the cabinet that the folder resides. If you select this check box, you
cannot modify the members of the folder.

10. Click Next.

11. In the Auto-tagging tab, you can set the documents that are added to the folder to be

automatically tagged (metadata automatically added). See the section Creating Auto-
Tagged Folders for more information.
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12. Click Save. The folder is added to the Library structure.
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TO EDIT THE FOLDER PROPERTIES

1. Right-click on a folder in the Library and select Properties. The folder properties window
opens.

2. Make any changes to the folder properties and click Save.

TO DELETE A FOLDER
1. Right-click on a folder in the Library and select Delete Folder.

NOTE: You need to have delete permissions in order to delete a folder.

2. A warning message is displayed. Click OK to delete the folder. The folder is removed from
the Library.

( Warning [&1

You are about to delete a Folder, All items contained in this Folder shall
l . be deleted. This action cannot be un-done. Do you wish to proceed?

QK ] ’ Cancel

TO COPY A FOLDER

1. To copy a folder, its security, and all of its contents including documents, right-click on the
cabinet and select Copy Folder.

2. Enter a name for the copied folder and click OK. The copied folder appears in the Library
hierarchy.

WARNING: Copying large folders and its contents causes the FileHold server to consume
resources and may slow down the system. We recommend that you do this after business
hours if copying folders containing tens of thousands or many hundreds of thousands of
documents. The amount of time it takes to copy a folder and its contents is dependent on the
server hardware that powers the system; the faster the server hardware the better.
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9.4.1.

TO CLONE THE FOLDER STRUCTURE

1 To clone a folder, its security, and all of its contents including drawers, folders and folder
groups, right-click on the cabinet and select Clone Folder.

2 Select a destination in the Library for the cloned folder.

Enter a name for the cloned folder and click OK. The cloned folder appears in the Library
hierarchy.

NOTE: Cloning a folder does NOT copy the documents. Use Copy Folder to copy folders and
documents.

TO ARCHIVE A FOLDER

1. To send a folder and its contents to the Library Archive, right-click on the folder name and
select Archive Folder.

2. At the message prompt, click OK. The folder and its contents are moved to the archive.

( Warning @1

You are about to move the Folder to the Library Archive, This acticn
r l . cannot be un-done. Do you wish to proceed?

QK l [ Cancel

TO MOVE A FOLDER
1. Right-click on a folder and select Move Folder.

2. Select the destination location by navigating through the Library in the dialog box and click
OK. The folder is moved to the location.

TO SET THE DEFAULT VIEW FOR THE FOLDER

Administrators can create public views in the View preferences area and then assign the
default view to each folder. Users can create personal views and assign it to a folder.

1. Right-click on the folder and select Set Default View.

2. Clear the Inherit setting from parent container check box.
3. Select the view you want to use from the drop-down list.
4

Click OK to save your settings.
Viewing the Folder Statistics

You are able to see how many documents, number of files and size of the repository that are
contained within a folder by looking at the statistics.

TO VIEW THE FOLDER STATISTICS
1. Right-click on a folder in the tree structure and select Properties.

2. Inthe folder properties window, files (latest version), size (in MB), files (all versions) and
size of all versions (in MB) is shown. Click Cancel to close the folder properties.
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9.4.2.

Creating Auto-Tagged Folders

When documents are added to the system, you need to set the document with metadata in
order to store it in the Library. Auto-tagging removes the manual step of setting the metadata
step out of the process. The metadata values to be automatically applied to all files placed in
the folder with auto-tagging configured. Auto-tagging on a folder is set on a document schema;
therefore, all files using that schema uses the predefined auto-tags.

Auto-tagging can be set at the cabinet or folder level. If some of the documents in the cabinet
or folder belong to a different schema type than what has been defined in the auto-tagging tab,
then the metadata is not changed or overwritten.

When documents are added to a folder that is auto-tagged, they must follow the rule that is
defined and no changes can be made to that rule. For example, if the auto-tagging rule is set to
the Invoices schema, then no other document schema types can be added to that folder.

Auto-tagging rules are set up by the folder owner or higher roles.

TO SET AUTO-TAGGING ON FOLDERS (OR CABINETS)

1. When creating a new folder go to the Auto-Tagging tab or for an existing folder, go to
Folder Name > Properties > Auto-Tagging.

2. In the Auto-Tagging tab, select the Enable Auto-tagging check box to have all documents
in this folder automatically “tagged” with the same metadata based on the schema as they
are added to this cabinet. This assumes that all of the documents that are being added to
the cabinet have mostly the same metadata as all the other documents in the cabinet. This
ensures a highly compliant filing system and standardization across all documents within
the cabinet or folder. Users can select to have some standard repetitive metadata added
automatically, manually, or a combination of both.

3. Select the Make this the default auto-tagging settings for all folders in this cabinet if
desired if you are setting up auto-tagging at the cabinet level. This option is not available at
the folder level.

4. In the Auto-Tagging Metadata area, select the document schema and the metadata. You do
not have to set all the metadata fields; you can leave them blank for the user to enter them.

5. Click Save.

6. The folder with the auto-tagging rule has the letter “A” on the folder signifying that is being
automatically tagged.

IEN) Liser Documentation - PDF
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10.DOCUMENT ACTIONS AND FUNCTIONS

A variety of actions can be taken on individual document versions. Actions are accessible from
the contextual menu associated with a document by right-clicking on the document name.

The following actions can be performed on one or more documents at a time. The availability of
actions is dependent on the rights that the user has.

Action /Function

Description

Permissions needed

Open (FDA only)

Opens the selected
document in its native
application.

Users with access to the
document.

Open in PDF/Image viewer
(FDA only)

Opens the document in the
PDF/Image Viewer.

This option may be disabled.
See your administrator for
details.

Users who have been
assigned a FileHold viewer
license.

Open in FileHold viewer
(both FDA and Web Client)

Opens the document in the
FileHold Viewer.

Users who have been
assigned a FileHold viewer
license.

Make a Local Copy (FDA)
Get a Copy (Web Client)

Creates a copy of the
document to the user’s local
machine. If using the FDA,
the copy is automatically
sent to the My FileHold
Documents folder.

Users with access to a file.

Check Out This Document

Checks out the document
and downloads it to your
working directory which is
typically My FileHold
Documents folder.

Users with document
publisher rights or higher.

Check In This Document

Checks documents back in
the system and opens the
'lock" on the document.
Documents that are checked
in are given a new document
version number.

Users with document
publisher rights or higher.
However, only the user that
has checked the document
out of library OR the library
system administrator may
check it back in.

Workflow > Initiate workflow
template name (FDA)

Initiate Workflow > Workflow
template name (Web Client)

Allows you to select the
workflow template name
from the list and start a
workflow. Selecting more
than one document starts a
multiple document workflow.
See the Workflow and
Courier Guide for more
information.

Users with Document
Publisher rights or higher
and is owner of the
document.*

*Unless the ‘Allow non
document version owner to
initialize workflow”
permission setting is
enabled. See your system
administrator for information.
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Action /Function

Description

Permissions needed

Workflow > View Sign-Off
Sheet

Listing of all users that either
approved or rejected this
version of the document,
when they did it, and if they
signed-off on behalf of
someone else. See the
Workflow and Courier Guide
for more information.

Users that are participants or
observers in a workflow.

Workflow > View Review &
Approval History

View the history of
comments for a workflow.
See the Workflow and
Courier Guide for more
information.

Users that are participants or
observers in a workflow.

Workflow > Cancel Workflow

Cancels a workflow in
progress. See the Workflow
and Courier Guide for more
information.

Initiators of a workflow or
library administrators or
higher.

Workflow > Submit Approval

Allows you to approve a
document. See the Workflow
and Courier Guide for more
information.

Users assigned to perform
an approval task in a
workflow.

Workflow > Submit Review

Allows you to submit a
review on a document. See
the Workflow and Courier
Guide for more information.

Users assigned to perform a
review task in a workflow.

Courier > View transmission
status

Displays the Courier
transmission report for the
document. See the Workflow
and Courier Guide for more
information.

Senders of the transmission
and cabinet administrators or
higher role and are owners
of the cabinet.

Courier > Initiate <Courier
template name>

Select the Courier template
name from the list and start
a Courier transmission. See
the Workflow and Courier

Guide for more information.

Users with a document
publisher role or higher and
has permission to use
Courier.

Metadata and File Properties

Displays the Metadata and
file properties for a file stored
in the library.

All users with access to the
folder the document is in.

Edit Metadata

Displays the Metadata and
file properties for the
selected files and allows you
to edit the metadata en
masse.

Users with document
publisher rights or higher.

Link Documents (FDA)
Link (Web Client)

Displays the Create Links
window to link the selected
documents together.

Users with document
publisher rights or higher.
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Action /Function

Description

Permissions needed

View Linked Documents

Displays all documents that
are linked to a selected
document.

Users with access to the
folder the document is in.

Send to > Document Tray

Send a document to the
Document Tray.

Users with read only or
higher.

Send to > Virtual Folder

Send a document to a Virtual
Folder.

Users with read only roles or
higher.

Send to > Local Folder (FDA
only)

Downloads a copy of
document to a folder on your
local computer. You can
browse to where you want
the document downloaded.

Users with read only roles or
higher.

Send to > Export (FDA only)

Exports the documents to
your local computer in their
native format and an XML
file containing the metadata,
schema, and library location
for the selected documents.

Users with document
publisher roles or higher
unless restricted by
administration.

Send to > Email

Emails the document as an
attachment or a link to the
document in the document
management system.

Users with read only roles or
higher unless restricted by
administration.

Send to > Email and Check
Out

Emails the document as an
attachment or a link and
checks out the document at
the same time.

Users with document
publisher roles or higher.

Send to > Library Archive

Sends the document to the
Library Archive.

Users with library
administration or higher
unless restricted by
administration.

Send to > Printer (FDA only)

Send the document to your
printer. This function is
available if enabled and user
has a viewer license.

Users with document
publisher roles or higher
unless restricted by
administration.

Send to > Existing Workflow
(Web Client only)

Add to Existing Workflow
(FDA and Web Client)

Adds a main or supporting
document to an existing
workflow.

Users with document
publisher role or higher. User
must have access to all
added documents and be
owner of the document
version when adding main
documents.
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Action /Function

Description

Permissions needed

Reminder and/or cancel
ones that have been
created.

Publish As Allows users to convert Users with document
documents in FileHold to publisher role or higher
PDF, TIFF, DWF or CSF. unless restricted by
This function is available administration. Starting in
only if you have the Brava 2017, Brava viewer licenses
viewer. are no longer available for
new FileHold purchases.
Previously purchased Brava
viewer licenses are still
available for use in the
FileHold Desktop
Application.
Notify Me Create a Document Alert or | Users with access to the

document.

Create Shortcut

Allows the user to create a
shortcut to a selected
document in another Folder
located in the document
management system. Note
that this functionality is
disabled unless it is enabled
by an administrator.

Users with publisher access
rights or higher that have
access to the folder the
document is in.

Go to Document Location

Takes you to the folder
location of the selected
document. This function is
available when you are not
in a folder such as in My
Favorites, search results,
virtual folder and so on.

Users with access to the
document.

Copy or Move

Make a copy of a document
or move it to another location
in FileHold.

Document publisher and
publisher need to have
ownership of the document.
Organizers or higher
permissions can move
documents owned by
anyone. Restrictions on
where a document can be
moved to applies.

Delete

Delete a document from the
system.

All users with document
publisher + delete
permissions or higher (and in
some cases, they can only
delete their own documents.
See User Roles for more
information). Library
administrators can recover
deleted documents within the
configured number of days.
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Action /Function

Description

Permissions needed

Convert to Offline

Converts an electronic
document to an offline
document. Downloads the
file to the local machine and
deletes all versions of a file
from the document
management system.

Users with cabinet
administrator rights or higher
and are owners of the
cabinet.

Rename

Rename a document.

Users that created the file or
those with document
publisher or higher
permissions.

Change Document Owner

Change the owner of a
document version.
Ownership change can be
done one document at a
time.

Users with organizer role
and higher. Cabinet
administrators must own the
cabinet.

View Version History

Displays the usage logs for
the selected document
including:

e All versions of the
document. Actions that
users have taken on the
document by document
version.

o Edits to the document.

Users with access to the
folder the document is in.

Download as Zip File

Downloads multiple
documents as one zip file.
Note: This command only
appears if multiple

documents are selected first.

The zip file name includes
the user name and the
download date.

Users with access to the
folder the document is in.

10.1. ADDING DOCUMENTS TO FILEHOLD

Users with Document Publisher and higher permissions can add files to the document
management system. Documents can be brought into FileHold using several methods:

e Drag and drop — Drag and drop a document from your local computer.
e Directly within FileHold — In the FDA or Web Client.

o Microsoft Office applications — Use the integrated FileHold toolbar to add documents.

e Microsoft Outlook — Add emails using the integrated FileHold toolbar or the “watched

folder”.

e Watched Folders — Documents can be brought into the system automatically from a
scanner location. See Watched Folders for more information.
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10.2.

10.3.

e Manage Imports — Documents can be brought into the system automatically using the
Manage Imports tool. See the Library Administration Guide for more information.

o WebCap — Web-based scanning through the Web Client.

o For other ways to get documents into FileHold, see the Knowledge Base.

NOTE: If adding documents to FileHold and the ability to browse the drawer to which the
documents are being added is blocked, users do not see the added documents in the folder. In
the FDA, users can use the Recently Added folder under My FileHold or the Files in Transfer
queue. In the Web Client, if using the Add document wizard, the user is shown the Advanced
search screen with the added document displayed. If adding a document directly from a
blocked folder, a blank screen is displayed. In this case, users can use the Recently Added
folder under My FileHold to view the added document.

DRAGGING AND DROPPING DOCUMENTS

You can use Windows File Explorer to drag and drop one or many documents into a folder or
the Inbox of the FileHold Desktop Application (FDA). If dragging and dropping multiple
documents, they are automatically sent to the Inbox for processing. If dragging to a folder
location, the destination folder is automatically set.

You cannot drag and drop documents into the FileHold Web Client.

TO DRAG AND DROP DOCUMENTS
1. In Windows Explorer, select the files to be transferred to FileHold from the local computer.
2. Drag and drop them to their destination folder or to the Inbox.

3. For files dragged to a folder destination, enter the metadata (unless the folder is auto-
tagged) and click Add. The document is added to the location.

4. Forfiles dragged to the Inbox, enter the metadata and select a destination.

e Click Set Metadata and Set Destination to enter the metadata and select the destination
folder. See Entering Metadata for a Document for more information on setting metadata on
documents.

5. Click Send or Send All to send the document(s) to the folder.

ADDING DOCUMENTS DIRECTLY FROM THE FILEHOLD DESKTOP APPLICATION

There are many ways in which you can add one or documents directly from the FileHold
Desktop Application. If you are adding more than one document at a time, then the documents
automatically go to the Inbox for processing.

ToO ADD FILES DIRECTLY FROM THE FILEHOLD DESKTOP APPLICATION

1. Do one of the following:

e From the Inbox or a folder location, click Add File @ .
e Goto File > Add File to Library.
e Go to File > Add Folder to Library.

2. Select the file from the local computer and click OK.

74

’ HOld September 2025


http://www.filehold.com/help/user/adding-documents

End User Guide FileHold 17.1

3. If the file was added to the Inbox, the metadata and destination need to be set. Click Set
Metadata and Set Destination to enter the information. After the information is entered,
click Send or Send All. See Entering Metadata for a Document for more information on
setting metadata on documents.

4. If the file was added to a folder, enter the metadata and click Add.

10.4. ADDING DOCUMENTS THROUGH THE FILEHOLD WEB CLIENT

When adding documents via the web client, you can only add a single document at a time. If
you need to add multiple documents, use the FileHold Desktop Application. Since there is no
Inbox in the Web Client, you add a document from within the destination folder or use the Add
Document Wizard.

TO ADD A DOCUMENT VIA THE WEB CLIENT
1. In the destination folder, click Add File to Folder.

et a Cop eck Ou d etadata | Li elete onvert To - - 0 Default View (3 _ Ll
D Training and Support/FileHold 12/New Features '@
I:‘ Document Name Type Linked Ver Status Last Modified On'

[ @ g 37 Photos 0 1 Checked Out  4/3/2012 11:05:48 AM dit

O @ E 71 Photos 0 1 Checked In 41312012 11:16:09 AM dit

When the Metadata pane opens, select the Document Schema from the list.

2

3. Select the format of the document, if applicable.

4. Click Browse to locate the file that you want to add to the repository.
5

Fill out the required metadata fields. See Entering Metadata for a Document for more
information on setting metadata on documents.

6. Click Save.

To ADD A DOCUMENT USING THE ADD DOCUMENT WIZARD
1. In the Web Client, select Add Document from the library tree.

& FileHold

Select aFile Select a file to add tothe b rany
Select a Folder Sobect File*

Wetadata

[

[ wet || Swme || Coca |

2. Inthe Select a File page, select the document type:
e Add local file — Select this option to add a file from the local computer, network, etc.
e Add offline document — Select this option to add an offline document.

3. Do one of the following:

o If “Add local file” was selected, click Browse to locate the file to add to the repository.
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o [f “Add offline document” was selected, select the Use date/time check box to use the date
and timestamp as the document name or manually type a document name.

Click Next.

In the Select a Folder page, select a destination folder from the library tree or select the
Auto-file the document according to its metadata check box to automatically set the
destination. Note that auto-filing must be configured by your administrator in order to use it.
If you try to use auto-filing and it has not been configured, you receive a message stating
"The selected document schema doesn't have an associated auto-filing script."

6. Click Next.
7. In the Metadata page, select the schema and enter the metadata field values.

e If an offline document was added, only the list of offline schemas appears in the list. To
select an alternate schema format, select the Show all document schema formats check
box.

8. Click Submit.

ADDING DOCUMENTS FROM MICROSOFT OUTLOOK

Users can save entire emails, including attachments or save just the attachment without the
email. Emails can be brought into the system:

e Drag and drop emails from Microsoft Outlook into FileHold.

e Use the Add to FileHold button from the FileHold toolbar in Microsoft Outlook. The email
message has to be opened in order to use the Add to FileHold button as you cannot do it
from the messages view.

e Using a Microsoft Outlook ‘watched folder’ allows you to add any emails into the “watched
folder” in Outlook so that the emails are brought into a folder on the local computer or
network location. Then having a watched folder or managed import set up in the FileHold
Desktop Application (FDA) (see the Library Administrator Guide for more information on
managed imports), the emails automatically get brought into system for processing.

Emails are saved as msg files and open in Outlook with their attachments. The email header
information (To, From, CC, Date, Subject and Attachment) may be automatically extracted into
the metadata fields, depending on what your administrator has configured. That way, you do
not have to type this information in; instead, the system does it for you. See Exitraction Rules in
the Library Administration Guide for more information.

For the watched folder in Outlook, you can set up special email rules in Outlook to ensure the
correct emails are being moved into the document management system. You can also drag
and drop emails into the watched folder. Once an email has been sent into the document
management system, it can never be imported again.

To ADD EMAILS FROM MICROSOFT OUTLOOK
1. Do one of the following:

e From Microsoft Outlook, select one or more emails and drag and drop the files into either
the Inbox or a folder location. Enter any required metadata and/or destination information.
See Entering Metadata for a Document for more information on setting metadata on
documents.

e From Microsoft Outlook, open an email and go to the Add-Ins tab and click Add to
FileHold (+ sign). Select the folder location and enter the metadata and click Add. See
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Entering Metadata for a Document for more information on setting metadata on
documents.

e Drag and drop or set up an Outlook rule to send documents to the Outlook watched folder.
See below for more information.

DRAGGING AND DROPPING EMAILS FROM OUTLOOK

Drag and drop allows a user to move multiple emails from Outlook to the document
management system FDA.

1. Select the email(s) that are to be moved to the document management system.
2. Drag and Drop to the FDA.

3. Emails are automatically sent to the Inbox for processing.

To SET UP THE MICROSOFT OUTLOOK WATCHED FOLDER

1. Create a folder in Microsoft Outlook that you want add the emails to.

4 Cytlook Data File

Al 9 b
[ FileHold WWatched Falder for Emails

L.#| Drafts

2. On your local computer or network location, create a folder that you want FileHold to
“watch” for new emails to be brought into the repository.

3. Inthe FileHold Desktop Application, do one of the following:

e Set up the Watched Folder for the folder you just created on your local computer or
network drive. See Watched Folders for more information. Note that if you are using a
Watched Folder, the email header information is not extracted into the metadata fields of
the schema. If you want the email header information extracted into the metadata fields,
use a managed import instead.

e Have your library administrator set up a Managed Import for the folder that was created on
your local computer or network. If using a managed import to bring emails into FileHold,
ensure that the import format has been set to “Dynamic import / Classic FileHold XML” in
the user preferences. If the import format has been set to “Both” in the user preferences,
ensure that the import format is set to “Dynamic import / Classic FileHold XML” on the
individual managed import. See the End User Guide for more information on the User
Preferences setting or the Library Administration Guide for more information on Managed
Imports.

NOTE: If you are using the “Both” option in the user preferences, ensure that folder you
select for the import profile contains only one type of XML files. The rule also applied for
any of its subfolders. The XML files for the import formats cannot coexist in the same
folder tree.

4. In Outlook, select the FileHold tab and click FileHold Watched Folder.

In the FileHold Watched Folder Configuration window, click the Enable Outlook Watched
Folder check box.

6. Inthe Watched Folder in Outlook field, click Browse to select the watched folder you
created in Microsoft Outlook.

€ FileHold .
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7. In the Destination Folder for Export field, click Browse to select the watched folder on your
local computer or network drive.

8. To create an XML file when the emails are exported, select the Export XML files in
Document Import compatible format check box. This XML file is created for each .msg
file and can be using in conjunction with the Manage Imports tool to import emails into the
repository. The XML file contains the following message header information: To, From, CC,
Date, Subject, and Attachments. Note that this does not need to be turned on to work with
FileHold Watched Folders. The XML files do not get imported into the repository.

FileHold Watched Folder Configuration | x| |

[¥ Enable Cutlook Watched Folder

Watched Folder in Outlook:
I'l,'l,OutIu:u:uk Daka Filel InboxFileHold Wwatched Folder For Emails Browse

Destination Folder Faor expart:

IC:'I,LIsers'l,au:Iministratu:ur.DCEEIEIEi'l,Du:u:uments'l,FiIeHu:ulu:I Watched Folder

[™ Export %ML files in Document Import compatible Format

' Ik | Cancel |

9. Click OK.

10. Test your configuration by adding an msg file to your Outlook watched folder. Then go into
FileHold to ensure that the file has been brought into the Inbox for processing or sent to the
folder, depending on your configuration settings in the Watched Folder or Managed Import.
If you are setting up a managed import for emails, ensure that you have an email schema
and an email extraction rule configured.

TO ADD ONLY AN ATTACHMENT FROM AN EMAIL
If attachments are saved to the system without the email they are stored in their native format.

NOTE: You cannot drag and drop an email attachment. You need to use the Send to FileHold
command.

1. In Microsoft Outlook, select and open an email with an attachment.
2. Right-click on the attachment and select Add to FileHold.

3. Select a destination for the document.
4

Enter the metadata for the document. See Entering Metadata for a Document for more
information on setting metadata on documents.

5. Select the following options, if applicable:

e Close the document before | add it — Closes the document in the application you are
working in after you have added the file.

e Delete the local copy of this file after it has been successfully added — Deletes the copy of
the file from your local computer after it is added.

e Email notify all folder members that this document has been added to this folder — Sends
an email alert to all the members of the selected folder.
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6. Click Add or Auto-File if the document was added to a folder that is auto-tagged.

10.6. ADDING DOCUMENT FROM MICROSOFT OFFICE APPLICATIONS

FileHold has integration with Microsoft Office applications such as Word, Excel, PowerPoint,
Visio, and OneNote. The integrated toolbar can be found on the FileHold tab of the Office

applications.

The FileHold Office Client (FOC) window is used when adding, browsing, checking in, adding
attachments or approving documents in FileHold from within Microsoft Office applications.

It is not necessary to save the document prior to adding the document to the library. If the
document has not been already saved, then a generic file name, such as “Document1” is given
to the file. This name can be changed in FOC window or a custom naming pattern on the

schema can be used to automatically rename the documents.

%J Document? - Add Document to FileHold -

i3 Corporate

i & Development

+-E Engineering

=& Human Resources

(-2 Al Employees

=-{Z Policies and Proce
[ Corporate For Enter new

1 Corporate Poii document

G- Partners name here
H-E Qualty Assurance ¥

d
£
d
E

Invoices ~ Document Name Document Schema Linked Ver Status Last Modified On

Add Document Options
Close this document before I add it

Delete the local copy of this file after it has been successfully added

["] Email notify al folder members that this document has been added to this folder

Document Schema: |P0ﬁcy j Policy Number (db-lookup) *: | ﬂ
Last Name: | | First Name:
Expiration Date: ||:| April 12, 2018 (L | Comments:

Cancel

To ADD FILES FROM MICROSOFT OFFICE APPLICATIONS (EXCLUDING MICROSOFT OUTLOOK)

1. Create or open a document in a Microsoft Office application such as Microsoft Word.
2. In Microsoft Office, select the FileHold tab and click Add to FileHold (+ sign).

3. The FileHold Microsoft Office Client window opens. Enter a new file name manually, if

required, in the blue file name bar area.
Select a destination folder and enter the metadata.

Select the following options, if applicable:

e Close the document before | add it — Closes the document in the application you are

working in after you have added the file.
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e Delete the local copy of this file after it has been successfully added — Deletes the copy of
the file from your local computer after it is added.

e Email notify all folder members that this document has been added to this folder — Sends
an email alert to all the members of the selected folder.

6. Click Add or Auto-File if auto-filing has been configured on the schema.

10.7. ADDING OFFLINE DOCUMENTS

An offline document is something that cannot be stored in the document management system
such as a map, book, or blueprints. An offline document can be also used as a placeholder for
the purpose of maintaining searchable metadata or the addition of an electronic file at a later
date. You need to create an offline document schema in order to add offline documents.

Offline documents can be:

e Checked out — Offline documents are tracked in the system so you can see who has the
document out. In the example of physical items like a book or DVD, you can see who has
taken the item from its physical location.

e Converted to an electronic document
e Undergo a workflow
e View the version history

When a cabinet owner or administrator adds an offline document, all schemas are shown in the
list. For regular users, they are restricted to only those schemas whose format is set to offline.
The following table outlines the rules when adding offline documents:

Non-administrator or administrator with no format conversions or only documents to
records enabled’

Folder Button

properties Add (Add Offline Add Offline Add (Add Offiine
enabled) disabled)?

Default offline (at | Select file, blank Default schema, choice Default schema, choice

least one offline schema, choice of of offline of offline

membership) electronic

Default Select file, default Blank schema, choice of | Select file, default

electronic (at schema, choice of offline schema, choice of

least one electronic electronic

electronic

membership)

Auto-tag offline Disabled No choice of schema No choice of schema

Auto-tag Select file, no choice of | Disabled Select file, no choice of

electronic schema schema

" Permission settings are configured by a system administrator.
2 The Add Offline button can be hidden if the key “Display.EnableOfflineButton” in the Library
Manager web configuration file is set to “false”. By default, it is set to “true”.
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If a non-administrator is not a member of an offline schema, the Add Offline is disabled.

If a non-administrator is not a member of an electronic schema, the Add is disabled.

Administrator with converting offline to electronic documents permission enabled (favour
document)

Folder
properties

Button

Add

Add Offline

Add (Add Offline
disabled)

Default offline

Select file, default
schema (format =

document), choice of

all

Default schema, choice
of offline

Default schema, choice
of all

Default electronic

Select file, default
schema, choice of
electronic

Default schema (format =
offline), choice of all

Select file, default
schema, choice of
electronic

Auto-tag offline

Select file, no choice of

schema (format =
document)

No choice of schema

No choice of schema

Auto-tag
electronic

Select file, no choice of

schema

Disabled

Select file, no choice of
schema

offline)

Administrator with converting electronic documents to offline permission enabled (favor

Folder
properties

Button

Add

Add Offline

Add (Add Offline
disabled)

Default offline

Select file, default

schema, choice of all

Default schema, choice
of offline

Default schema, choice
of all

Default Select file, default Default schema (format Select file, default

electronic schema, choice of = offline), choice of all schema, choice of all
electronic

Auto-tag offline Disabled No choice of schema No choice of schema

Auto-tag Select file, no choice No choice of schema Select file, no choice of

electronic of schema (format = offline) schema
Administrator with converting to and from document and offline enabled

Folder Button

properties Add Add Offline Add (Add Offline

disabled)

Default offline

Select file, default

schema, choice of all

Default schema, choice
of all

Default schema, choice
of all

Default
electronic

Select file, default

schema, choice of all

Default schema, choice
of all

Select file, default
schema, choice of all
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Auto-tag offline Select file, no choice No choice of schema No choice of schema
of schema (format =
document)
Auto-tag Select file, no choice No choice of schema Select file, no choice of
electronic of schema (format = offline) schema

For all cases, if no schemas are defined both Add and Add Offline are disabled.

"format = <format-type>" means that the format for the document is changed from the schema
format to the specified format.

"choice of <type>" refers to the document schema dropdown in the metadata panel. Electronic
refers to both record and document.

TO ADD OFFLINE DOCUMENTS
1. Do one of the following:
e From a folder location or the Inbox in the FDA, go to File > Add Offline Document or click
Add Offline 0

e In the Web Client, select a folder and click Add File to Folder or use the Add Document
Wizard.

2. Select the Offline Document Schema name. See the Library Administration Guide on how
to create an offline document schema.

Fill out the required metadata fields and click Add.

Set a destination folder if adding the Offline document from the Inbox.

10.8. EXPORTING DOCUMENTS IN A VIEW TO A CSV FILE

From any folder view, search results or other FileHold view, you can export the columns and
associated values to a CSV file. The CSV file contains information from the entire folder list
columns except for the icons associated with the documents (i.e., favorites and permissions).

You can customize the view in order to export the data that you want by adding or removing
columns, grouping, sorting, and so on, using the View Preferences. You can also perform an
Advanced Search to achieve the data results you want to export.

NOTE: In the FDA, only the documents displayed on the current “page” is exported to the CSV
file. If you have additional pages of documents, you need to export each page to CSV. You can
also increase the number of documents displayed on a “page” in the View Preferences.

TO EXPORT FOLDER CONTENTS TO A CSV FILE
1. Open a folder or do a search to create a list of files to export.

2. Right-click in the column names header and select Export Grids to CSV.
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- Training and Support/FileHold 14/Training Materials

Select View:

Document Name

=@ Document Schema: Application (2 docum

Group By

Add / Bemove Column:

v Linked Ver Status Last Modified On

.

i B 7'_- travelauth

Export Grids to CSV

Checked In~ 12/17/2015 3:33 PM Edit

77 @ [E 9371

Collapse Al aroups

Expand All Groups

Checked In  12/17/2015 3:34 PM Edit

@ Document Schema: Bicycle Manuals (48 do
D E‘ﬂ Warranty

7 @ 8 thic is 2 new document thranah FOC

Bicyde Manuals

Bicvcle Manuals

0 Checked In ~ 12/17/2015 3:33 PM Edit
o 1 Cherked Tn 12/17/2015 3:33 PM Edit

3. Enter a name for the CSV file and select a location to save the document.

4. Click Save.

5. You can now open the document in a spreadsheet.

A B G
1 |D0cument Name |Type Linked Ver
2 HolidayPartyBudget HR - eveni 2
3 |FW Library Admin Training Inbound E 0

4 Copy of filehold-metadata-vl Policy
3

0

D E F G H
Status Last Modified On Approval Status Approval Date
1 CheckedIn  08/12/20109:56 Not Submitted For Approval
1 Checked In  24/05/2011 11:28 Mot Submitted For Approval
1 CheckedIn  15/03/2011 9:53 Mot Submitted For Approval

10.9. ENTERING METADATA FOR A DOCUMENT

The metadata pane displays the document schema and its associated metadata as well as
system values in the version properties area. The metadata and version properties are unique
for each version of every document in the system. All of these values are can be searched on

in the system.

When documents are being added to the library, it requires two pieces of information prior the

file being added:

1. Values for all required metadata fields.

2. A destination folder.

The status of the document is “Info Required” until the information is entered. Once the
required metadata is filled and a destination set, the status changes to “Ready to Send” and
document(s) can be sent to the library.

When entering metadata for document, all fields marked with an asterisk * indicate that the
field is mandatory and must be filled in. The type of metadata collected for a document schema
is determined by how you set up your metadata schema. Metadata is set in the Metadata

Pane.

TO OPEN THE METADATA PANE

1. In afolder or search results view, do one of the following:

¢ In the FileHold Desktop Application (FDA), click %

e Inthe Web Client or FDA, right-click and select Metadata & File Properties.

o Use the shortcut key Ctrl+Shift+P.
2. Inthe Inbox of the FDA, click Set Metadata or Edit Metadata or press the shortcut key

Ctrl+Shift+P.
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Once the metadata has been set, it is displayed in the Metadata Pane along with the file
version properties associated with the selected file. The version properties are displayed below
the metadata properties. Here, the document owner, version number, status, format, URL links,
file type, library location, markup status, and file size can be viewed. All of the version
properties of a file are searchable.

See the table below for details on the document version properties.

Version Property

Description

Version

Displays the number of versions for a document. Click the View All
Versions link to see all document versions. See Version History for
more information.

Owner

The user that initially added the file or the user that added the latest
version of the file.

Ownership is important when it comes to user roles and being able to
delete, move, etc.

Library Status

States if the document is checked in or checked out. If it is checked
out it, the user who has checked out the document and when it was
checked out is shown.

Has Markups

If any markups have been added via the Brava viewer, it states Yes. If
there are no markups, it states No. Starting in 2017, Brava viewer
licenses are no longer available for new FileHold purchases.
Previously purchased Brava viewer licenses are still available for use
in the FileHold Desktop Application.

FileHold ID A unique ID number given to every document in the system.
Documents are numbered sequentially as they are added. The
number after the period (.) indicates the version number.

Format Electronic Document — documents that can be checked out/in and

modified.

Electronic Record — records cannot be modified. There is only one
version of this file.

Offline Document — physical items that reside in your office or point to
documents that are not yet in electronic format in the document
management system.

Library Location

The cabinet / drawer / folder group (optional) / folder location of the
document.
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Version Property Description

Document URL Links that can be used to point to the document. There may be
different link types available depending upon what your library
administrator has configured. To copy the link, click the link and paste
the link into another document.

Copy Default URL - link to where the document resides using the
default URL configured by the administrator.

For example,
http://ffileholdserver/FH/FileHold/WebClient/LibraryForm.aspx?docld=1

or fda://document/1

All URLS - Displays the list of URLS that are available for use. The
list is configured by an administrator. If this option is not available,
then only the Default URL can be copied.

See your library administrator for details.

Type of File States the file type such as Microsoft Word, PDF, TXT, JPG, etc.

Size States the size of the file.

10.9.1. Entering Metadata for a Single or Multiple Documents

Before a document can be added to the library, it requires two pieces of information:

e Values for all required metadata fields - When entering metadata (also called tagging or
indexing) for document, all fields marked with a * indicate that the field is mandatory and
must be filled in. Metadata is set in the Metadata Pane.

e A destination folder - The folder in the library structure where the document resides.

IMPORTANT: The maximum number of characters in a document name is 100. This limit is in
place to reduce the risk of conflicts with filename and path length limits in Microsoft Windows.
The maximum size of the filename and path in Windows is 260 characters. This means that the
longest path that avoids conflict with Window's limit when making a local copy of a document
from the document management system is 160 characters. The user sees an error message if
the limit is exceeded.

TIP: There may be cases where you would like the name of the document to be longer than
100 characters. You can create a metadata text field large enough to hold the large name and
use custom naming to set the document name that would be used if the document is copied
outside of the document management system. The L mask operator can be used to truncate
the name to a length less than the maximum and an extra identifier like the document id or the
document create date and time could be added to simplify identifying the document outside of
the document management system.

TO ENTER METADATA FOR A SINGLE DOCUMENT

1. Add the file to the document management system. This can be done in the Inbox or a
folder location.

2. Do one of the following:
e Click the inline Set Metadata link.
e Click the Edit Metadata button.
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Right-click and select Edit Metadata.

Click the metadata pane button LO

Select the Document Schema from the list. The metadata fields change depending on
which schema you have chosen.

Enter in all the required metadata information. This is marked with an asterisk *.
Fill in the optional information if needed.

Select the check box to delete the local copy of the file after it is added to the Library if
required.

Select the check box to email all folder members that a document has been added to the
folder if required.

Click Add or Save & Next to add metadata to the next document in the list.

TO ENTER METADATA FOR MULTIPLE DOCUMENTS AT A TIME (FDA ONLY)

1.

Add the files to the FileHold Desktop Application. By default, these documents go to the
Inbox.

Select the files to be tagged (indexed). Use the CTRL or SHIFT keys to select multiple
documents.

Do one of the following:
Click the Edit Metadata button.
Right-click and select Edit Metadata.

NOTE: Do not click the inline Edit Metadata link. This causes you to edit the metadata for just
that selected document.

4.

5.

Select the Document Schema from the list. The metadata fields change depending on
which schema you have chosen.

Do one of the following:

To enter common values for all metadata fields for all of the selected files, select the Check

All check box and enter the metadata values.
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Metadata & File Properties

Apply Metadata to Multiple Files

w Metadata

Document schema *

IInvoices j

Format of Document *
IEIech’onic Document j

You have selected & files of type:Product Documentation (8)

Use the checkboxes to select metadata field(s) you
want to edit for all documents. Edit the field and click
Save to apply the changes.

Available IMetadata Fields for Invoices documents
¥ Check All

¥ Invoice Number *

¥ Invoice Date *

[ 23-12-2015 =l
¥ vendor

| =
¥ Total *

e To enter common values for only select metadata fields, select the check box next to the
metadata field names.

Metadata & File Properties

Apply Metadata to Multiple Files

w Metadata

Document schema *

IIn\mices j
Format of Document *
IEIeclmn\c Document j

‘fou have selected 6 files of type:Product Documentation (8)

Use the checkboxes to select metadata field(s) you
want to edit for all documents. Edit the field and click
Save to apply the changes.

Available Metadata Fields for Invoices documents

[T checkal

" Invoice Number *

™ Invoice Date *

T 23-12-2015 =l
" ¥ Vendor

[t =l
1 " Totar*

6. Select the check box to delete the local copy of the file after it is added to the Library if
required.

7. Select the check box to email all folder members that a document has been added to the
folder if required.

8. Click Save.
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9. If there are any required metadata fields that were not filled out, enter in all the required
values for the individual documents. Required fields are marked with an asterisk *.

10. Fill in the optional metadata fields if needed.
11. Click Save or Save & Next.

10.9.2. Entering Metadata Using Click to Tag

Click to Tag is a method of quickly assigning metadata to a document being added to the
repository using the FileHold Desktop Application. It allows you to “click” or “rubber band” text,
numbers, dates, etc. on the screen and inserts the value into the metadata field of the schema.
When using Click to Tag, the mechanism OCR’s (optical character recognition) the selected
area on the screen. This makes is possible to extract values not just from the document but
also from any external application accessible on the user’s computer.

In order to use Click to Tag, it must be enabled in the User Preferences. Note that this setting
may be overwritten by your administrator.

When Click to Tag is invoked in the metadata pane, the user is prompted to open the
document in the FileHold viewer, the document’s native application, or to not to open the
document. Not opening the document allows you to tag the document using an alternative file
or from another application.

Once an option to tag the document is selected, the screen is covered with an opaque white
mask called the “fold”. This indicates that the Click to Tag process is in effect. A tool tip
displaying the metadata field name to tag is shown. You can then click or rubber band the
value for the metadata field. After the first metadata field is tagged and validated, the next
metadata field in the list can be captured. The process is repeated until all the values have
been captured. The “fold” can be activated and deactivated at any time during the tagging
process in the event that a document needs to be scrolled to other page, zoomed, or tagged
from a different screen.

When tagging metadata fields, read-only and auto-tagged fields are skipped from the tagging
process. Check box type metadata fields are also skipped. For drop-down or drill down type
metadata fields, the information that is being selected on the screen must be an exact match. If
no matching value is found, an error message is displayed. Similarly, date type fields need to
be properly formatted on the screen or an error message is displayed. If date, currency,
number, or drop-down list values do not match what has been captured or is not formatted
correctly, the system prompts you to enter a correct value.

Click To Tag Correction %]

The selacted bext was nok recognized as a vabd dropdown Feld
walue, You can mansslly cormact b valos and bry sgain.

OCR Tet: [ICBC |

[ o | comen |

If no metadata fields are present in the selected schema, the Click to Tag button is not
available.

Note that the quality of the documents that are being tagged using Click to Tag need to be

reasonably high. For this reason, only documents that are electronic in origin should be
used with Click to Tag. Prior to using Click to Tag, you should test the tagging process with
your various electronic documents to ensure that it works well.

Font/text size needs to be of a reasonable size as Click to Tag does not work well with small
fonts. If Click to Tag is not working well with the current font size, zoom into the document to
increase the size of the font on the screen. Due to various quality, font size, or font type
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reasons, some text may not be able to be read (ORC’d) from the screen and cannot be tagged
using Click to Tag. In these cases, metadata values have to be entered manually.

Scanned documents may present issues in tagging due to poor quality scans so for this
reason, the OCR capabilities of your scanning software should be used to tag the documents
and not Click To Tag. See the Knowledge Base for more information on scanning documents
and importing metadata into the document management system.

Click to Tag supports only the English language “out of the box”. This can be modified in the
FDA.exe.config setting <add key="ClickToTagLanguage" value="eng"/>. For other
language support, contact FileHold Professional Services at sales@filehold.com.

TO ENTER METADATA USING CLICK TO TAG

1.
2.
3.

Metadata & File Properties *

scanned_pdf_bell-abc

Add a new document(s) or select an existing document(s).

Select a Document Schema from the list if adding a new document.

In the metadata pane, click to Tag.

w Metadata
Document schema *
I:Jroduct Documentation j
Format of Document *
IEIe-:trc-ni-: Document j

Document Name *

|scanned43df_bellwabc

Type of Documentation *

Version *

Author (file properties)

| CIid(ToTagl

In the Click to Tag window, select one of the following options:

Open the document in the native application — The document opens in its native
application. For example, if it is a PDF then it opens in Adobe Reader.

Open the document in the Brava viewer — The document opens in the Brava
viewer_Using_The Document in the FileHold Desktop Application. You may need to
undock the viewer, adjust the size, or move it to another monitor in order to tag the
document. You can do this by closing the “fold”. Starting in 2017, Brava viewer licenses are
no longer available for new FileHold purchases. Previously purchased Brava viewer
licenses are still available for use in the FileHold Desktop Application.

Open in the document in the PDF/Image viewer — Opens the document in the PDF/Image
viewer in the FDA. You may need to undock the viewer, adjust the size, or move it to
another monitor in order to tag the document. You can do this by closing the “fold”. Note
that the PDF/Image viewer is end of life and may not be enabled. See your administrator
for details.

Do not open the document — Does not open the document in any viewer or application.
Use this open to tag the document from an alternative file or from another application.
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NOTE: If you are tagging multiple documents at once, then this window does not appear. You
need to close the fold and open the document or application that you want to tag from and
then open the fold again to proceed with tagging.

5. Once an option is selected, the “fold”, a white opaque mask, appears over the screen.
This indicates the Click to Tag process is in effect. You may need to deactivate and
activate the fold to undock the viewer, adjust the size, scroll through a document,
zoomed, or move it to another monitor, and so on in order to tag the document. To
deactivate the fold, click Fold in the bottom right corner. To activate the fold, click the
Unfold button. See the example screen shots below:

e To deactivate or close the fold, you can also right-click on the activated fold and select
Fold.

e To move between windows, use Alt+Tab or the task bar instead of deactivating the fold.

T e T,

Deactivate Fold | Activate Fold

wopy of thisgle after it has ical copy of file after it has
sfully added

|
ilder members 3l Folder members &
sen added o this Fo \ { 15 been added to this Folder
Save & Mext | Capcgl R J Save & Next | Cang

6. Once the document is opened in the selected viewer and the fold is activated, the first
metadata field in the schema displays in a tool tip. Capture the value for the metadata field
by:

e Asingle word is captured by clicking on it.

e Multiple words or lines are captured by dragging a rectangle round the words (rubber
banding) All words located inside or intersecting the triangle are captured. See the example
below:
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= 1 =1 £

File  Edit View  Options  Measure  Help

- - Bl- - 0 M x

Invoice

"Rubber band" or click
on the metadata value

Pet Stare Supply
Your cots and dags love
250-4664 Loug Invoice Number: 8584

Date: 14/09/2011
Customer ID # 78525

var7-s3on - Opague white mask
covers the screen
called the "fold".

T al

To:

Pet Store Metadatta r|§|d
111 Marianas Trench Basie’'s Pet btore name tool tip
Vancouver BC V4R 3T5 111 Marianas

Vancouver BC

ShipTo:

SALESPERSON PO NUMBER SHIPPING SHIPPING TERMS | DELIVERY DATE PAYMENT TERMS
METHOD
Tom Mewtlon 785 Ground orioszon Due an receipt

7. Continue tagging the rest of the metadata fields in the schema using the click or rubber
band methods. A tool tip displays each metadata field name.

8. If you need to change a value or skip to another metadata field, right-click on the fold
while it is activated. The list of metadata fields for the selected schema is shown. Select
the desired metadata field name from the list. The metadata field that is currently being
tagged has a check mark next to its name.

~ (O[]

File  Edit Wiews  Options  Measure  Help

Z- =~ B~ im0 B x

Invoice

Pet Store Supply ustomor Nome: Basis P Current metadata
ustomer Name: Basie Pie " -

Your cots and dogs love us! f|E|d be|ng taQQEd

250-4664 Lougheed Hwy Clstaneiil) Invoice Number: 8584

oty S Invaice Date Date; 14/09/2011
SRR EE L T e Customer ID # 78525
Shipping Method
R Total
Pet Smre_ Salesperson B
111 Marianas Trench re 4
Vancouver BC VAR 375 Fold Trench | |
Close: V4R 3T5 |
9. If the value of the metadata field is not valid (does not match drop-down or drill down list

value, invalid date format or check box) or cannot be read due to reasons (such as poor
quality, font size, font type, and so on) an error message is shown stating the value is not

< FileHold 91

September 2025



FileHold 17.1 End User Guide

valid. Click OK to retry tagging the value. When tagging a currency, number, drop down
list, or date value and Click to Tag does not recognize the value, a window opens
prompting the user to enter the correct value.

Click To Tag Correction |

The selected text was naot recagnized as a valid dake, You can
manually correct the walue and try again,

OCR Text: |§

Ik I Cancel

10. Once the tagging is completed, right click on the activated fold and select Close.

e Alternatively, click ESC to end the Click to Tag process.

11. Click Save in the metadata pane to save the information.

10.9.3. Using drop-down menus and value pills

Most drop-down menus in the system show their values in a “pill”. A visually distinct element
resembling a capsule shape.

Approval Postponed X

Each pill contains an X on the left that can be used to erase the value. The value can also be
erased by pressing the backspace key when the cursor is to the right or the delete key with the
cursor is to the left of the pill.

The pills are color coded to indicate different conditions. Green indicates that everything is
normal. Red, and an error icon, is used when the user types an invalid value. It is not possible
to enter an invalid value when the user chooses from the list. Error values will be ignored.

(@ garbage )

A special case is available for metadata fields when an administrator has configured the
inactive value option. In this case, inactive values appear in yellow with a warning icon. Only
administrators can select yellow pills in the metadata panel. Non-administrators can edit other
metadata or select active items only when an inactive item is present. All users can select
inactive items in a search criterion.

Ay PRINOOOS X

When a list allows multiple selections, an additional X will appear on the far right of the field.
This will erase all pills at once. There is no preset limit to the number of value selections that
are possible in a multi-select list. The field will expand in size to accommodate the selected
pills.

A PRI00003 X ( PRIN0201 X)(@ pr99999 x)( PRI0OIDS X |w[X]
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10.9.4. Selecting metadata drop-down menu items

You can point and click to select drop-down menu items from a list. The list of options is
opened by pressing the expand list arrow on right and closed by pressing the collapse arrow.
As the cursor moves over the list, the current value will be highlighted. It can be selected by
clicking the value or pressing ENTER.

E lease Select... E

PRI00OOS1 - 3

/1, PRID0003

- TR |

Items can also be selected by typing one or more characters. Typing can be used if the list of
options is opened or not. The method used to find the item in the list depends on how the

administrator has configured the list. Your typing will either be matched against the values in
the list starting with the first character in the value or any character in the value.

10.9.5. Entering metadata into Database Drop-down Fields

Database managed drop-down menus are used in situations where values for the menu are
stored and managed outside of FileHold. For example, a list of clients can be displayed as a
drop-down menu that is dynamically populated from a central list of customers taken from an
existing CRM system.

When configuring database drop-down lists, up to four “search by” fields can be set to help
users choose the correct value from the list. Often the single lookup value is not sufficiently
descriptive so selecting the correct value from the list can be difficult due to having similar
names, long names or numbering. “Search by” fields help simplify the selection process. Once
the “search by” fields are configured, the end user has the ability to click the “search” button in
the metadata pane. In the search by window, the user has ability to view the search by
information, and filter and sort the data in order to select the correct value from the list. For
example, when putting employee information into the system, the lookup is done on the unique
employee number field. However, remembering the employee number for each employee is
not practical. Using this solution, the user can see the employee’s first and last name, title,
department and so on to ensure the correct employee number is selected.
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10.9.6.

Select a value in the Employee Number O X 20170801-0923
Apply Cancel s o
Drag a column header and drop it here to group by that column s e e
§ NationallDNumber § LastName § FistName 3§ JobTille 3 Department IEmpbyee Info (dblookup)
10708100 Miller Frank Production Technician - WC50 Production
"Search by" configured
109272464 Kearney Production Technician - WC10 Production for Employee Number
112432117 Welcker Vice President of Sales Sales database drop-cown
112457891 Walters mployee NUmber
113392530 Ting User_n:an see additional |nfonnat|t_m I jp
relating to the employee number in
113695504 Ciccu order to choose the correct value. Lisilins
121491555 Kahn 3 Columns can be sorted and filtered to \ |
mer| locate correct employee First Name *
s 1300049 Holliday ‘ |
131471224 Berglund Andreas ud urd e Uy A DOB
nd 132674823 Ford Jeffrey Production Technician - WC10 Production ‘D Aprl 09,2018 g |
s B
134219713 Varkey Chudukatil | Ranjit Sales Representative Sales GlrelEie
18y [] A 09,2018 B-]
134969118 Miller Dylan Research and Development Manager =~ Research and Devel
Plar| Title
ficey 138280935 Poland Carole Production Technician - WC30 Production ‘ |
tin
139397894 Ito Shu Sales Representative Sales Department
141165819 Altman Gary Facilities Manager Facilities and Mainte ‘ |
slati 14417807 Gilbert Guy Production Technician - WC60 Production Lookup
::Cr: 152085091 Tejani Sameer Production Technician - WC50 Production
-
are| R
vicel
nenq MW | <« 1 [ 60 ¥ items per page 1 - 60 of 290 items O

For more information on creating database drop down list metadata fields, see the Library
Administration Guide.

TO ENTER METADATA USING DATABASE DROP-DOWN LISTS

1. In the metadata pane, enter or select the value for the database drop-down list metadata
fields. You can start typing the value, manually scroll through the list, or scroll using the
mouse wheel or track pad gesture.

2. If the “Search by” feature is configured, click the Search button to display a table with
related database information. The table can be sorted and filtered in order to select the
correct value from the list. See How to manipulate the Batch Job report View for
information on how to manipulate the table view.

3. Enter values in any other required metadata fields or modify any of the values that were
retrieved.

4. Click Add or Save.
Entering Metadata using Schema Lookups

Metadata information can be automatically populated into many metadata fields based on a
single metadata “lookup” value that comes from a database such as an accounting database or
an ERP system.

If the administrator has configured the schema to use schema lookup, you see a Lookup
button in the Metadata pane. Clicking this button after entering or selecting the value from the
configured metadata field retrieves any mapped values from the database into the remaining
metadata field values of the schema. This can reduce the amount of time it takes to index a
document with metadata.
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Metadata & File Properties *

Invoice # 10393 Save-a-lot Markets

This wersion is Checked In

w Metadata
Document schema *
IInvoices (dblookup) j
Format of Document *
IEIech’onic Document ﬂ

Document Name *
IInvoice # 10393 Save-aHot Markets 03-Jan-1937

Invoice # (dblookup) *

|10393 |

Customer Name
ISaVEﬁ-lot Markets

Invoice Date

| 03-01-1397 |
Total

|25s6.95

Lookup |

Save | Saue&NextI Cancel |

If there are any blank required fields after the lookup is performed, you need to enter those
manually. The values of any read-only or automatically tagged fields are not affected by the
database lookup.

Lookups can be done on one or many documents at once. For example, if you are adding or
modifying five documents with the same project number, the lookup can be completed on all
five documents at a time. The schema lookup is done on the key field so it is possible that
there could be more than one schema in the selected documents which means there could be
more than one schema lookup definition. The following rules determine what happens when
the user clicks the Lookup button and there is more than one schema:

e If only one schema has a lookup defined, that definition is used.

e If more than one schema has a lookup defined, a drop-down list shows the schemas that
have a lookup definition where the lookup by is one of the common fields. By default, the
first schema in the list is selected.

If the selected lookup definition includes destination fields that are not among the common
fields, these are ignored (not filled by the lookup).

For the custom query cases where there can be multiple lookup by fields, the rule is the same,
but only if all lookup by fields are not displayed for all schema lookups. If the selected schema
lookup uses a custom query with multiple lookup-by fields and one or more of the fields is not
displayed, there is a warning message: "There are lookup-by fields defined that are not
displayed for one or more of the selected documents: <field-name-list>. Not displayed fields
will use a blank value in the lookup."

If a lookup is completed and it modifies one or more fields that are not displayed, a warning
message is displayed: "The lookup will change fields that are not displayed for one or more of
the selected documents: <field-name-list>.
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Metadata & File Properties b4 "

Select View: | Default View Apply Metadata to Multiple Files

Remove From Inbox Edit Metadata Edic Destination Send Send Al Auto-File Q
etadata

Document Name Status Document Schema Coming From Going To P e W SU——, =~

o Info Required Set Destination type selected (1), F-18-Quotations and
=] Info Required Set Metadata Set Destination Tenders-Brochures (1)

Use the checkboxes to select metadata
field(s) you want to edit for al documents.
Edit the field and click Save to apply the
changes.

Available Metadata Fields for Bicycles
documents

Check Al

Product ID *

‘835 j
Bike Model

17 |
Product Number

[FR-R72v-44 |
Standard Cost

[360.9428 |
Weight

[230 |

Select the schema to & Colour

use for the lookup if m |
multiple files are [« |

List Price

selected [594.8300 |

Load Metadata from

Select a File b Load
1o use as a Metadata Template.

Lookup using

sorces -

[ Delete the local copy of these files after they
have been successfully added
Email notify al folder members that these
[] documents have been added to their
respective folders

Save Save & Next Cancel

© oY

Up to five lookup fields can be configured for the metadata fields. For example, a customer is
classifying construction documents for a property. Construction is related to a lease and can
include one or more jobs. The customer would like the document to have the lease id, lease
name, job id, and job name metadata information populated. When the lease id and the job id
is selected from the drop-down list in the metadata pane and the Lookup button is pressed,
then the system retrieves both the lease and job names.
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Metadata & File Properties

FHInstall_16-04-2018

v Metadata
-

[Frinstal_16-04-2018 ]

I 1nbox Select Yiew: | Default View -

4F Remove From Inbox Edft Metadata Edtt Destmation Send Send Al v
Document Hame ~ Status Document Schema  Coming From Going To Progress

L Info Required SctMetadata

[) Pre-nstaticBuld20180412.1 Info Required St Metadata C:\Users\joey\Documents

Product ID
[713

Product Model ID
11

Multiple lookup
based on 3
parameters

Product SubCategory ID

21

Product Name

[Long-Sleeve Logo Jersey, 5 ]
Product Model Name

LongrSieve Logo Jersey ]
Product SubCategory Hame

ersers ]
Product Number

L1-01925 ‘
Colour

Muit ]
Size

s J

Weight

Standard Cost
38.4923

[ Delete the local copy of this fle after ithas
been successfully added

[ Emai notify al folder members that this
document has been added to this folder

Save Save aNext | Cancel

< >

For more information on schema lookup configuration, see the Library Administration Guide.

TO ENTER METADATA USING SCHEMA LOOKUPS
1. In the metadata pane, select the document schema that is configured for lookups.

2. Enter or select the value for the metadata fields that are configured to do the lookups.
There can be up to five metadata fields used as criteria for a lookup. See your
administrator for the fields that are required for a lookup.

3. If more than one document is highlighted in the Inbox or folder, select the schema name
from the Lookup using drop down list. If more than one schema has a lookup defined, the
drop-down shows the schemas that have a lookup definition where the lookup by is one of
the common fields. By default, the first schema in the list is selected.

4. Click Lookup. All of the metadata fields that are configured pull in the values from the
database.

e |If the selected schema lookup uses a custom query with multiple lookup-by fields and one
or more of the fields is not displayed, there is a warning message: "There are lookup-by
fields defined that are not displayed for one or more of the selected documents: <field-
name-list>. Not displayed fields will use a blank value in the lookup."

o If alookup is completed and it modifies one or more fields that are not displayed, a warning
message is displayed: "The lookup will change fields that are not displayed for one or more
of the selected documents: <field-name-list>.

e If you enter a value in the wrong metadata field, you receive an error message “Missing
value for <metadata field name>".

o If editing multiple documents with multiple schemas with hidden fields, this fails for integer
parameters. The message, “There are lookup-by fields defined that are not displayed for
one or more of the selected documents: <field-name-list>. Not displayed fields will pass a
null value to the custom SQL query" displays if this scenario occurs.

5. Enter values in any other required metadata fields or modify any of the values that were
retrieved.

6. Click Add or Save.
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10.9.7. Editing Metadata

If you have sufficient permissions (Document Publisher or higher role), you are able to edit the
metadata for a document.

TO EDIT METADATA

1. Locate the document whose metadata you want to edit and open the metadata pane.
2. Click Edit and make any changes to the existing values.

3. Click Save.

10.9.8. Copying Metadata
You can copy metadata values when the metadata panel is in its editable or non-editable form.
To COPY METADATA
1. Select a document and open the metadata pane.
2. Right-click and select Copy.
10.10. SETTING THE DESTINATION FOLDER

You need to determine which folder the documents are going to reside in the library structure.
You can set the destination for one or more documents at a time from the Inbox.

TIP: You can use the Recent Folders list if you are always adding documents to the same
folder location.

[ Inbox (Send to Library)
3;; My FilzHold
(-8 Reviews & Apprnva_ls
= Recent Folders
] Mew Features
| Carporate Policies
2 i a4
- Y
[ Staples
[ Puralatar
[ Fedex
[ BC Hydro
1 Day-3
[ Training Materials
=g Search
-5 Virtual Folders
=] Library
B[ Accounting

{5 Bark Statements

=] @ Invoices

[ BC Hydro

TO SET THE DESTINATION FOLDER FOR DOCUMENTS
1. Do one of the following:
e From the Inbox, select a single document and click Set Destination.

e From the Inbox, select one or multiple documents to be filed under the same folder and
click Edit Destination from the toolbar. If setting the destination for multiple documents, do
not use the Set Destination link.
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10.11.

10.12.

e Alternatively, drag and drop one or many documents to the folder location in the library
tree.

2. From the Select Location window, browse to the folder location in the library tree and click
OK. The destination for the documents is shown in the Inbox.

DELETING FILES

You may only delete files if you the correct permissions and/or are owner of the document. You
can also delete previous versions of a document.

TO DELETE A FILE

1. Select the document name and click Delete E!

CHECKING IN AND CHECKING OUT DOCUMENTS

Document version control ensures that changes made to documents are not accidentally
overwritten by other users. Checking out a document “locks” the document and prevents others
from making changes. Users can still get a local copy of the document (read-only) when a
document is checked out.

A unique copy of every version of a file checked into the system is retained to ensure that
documents can be reverted back to a previous version if needed. To view all versions of a
document, see the Version History.

It is important for users to remember to check documents in once they are finished editing.
Users cannot view your changes or check the document out until the document is checked
back in. To view all of the documents that you have checked out, go to My FileHold >
Checked Out Documents.

When the file is checked out, its status is set to Checked Out. In the Version Properties area
of the metadata pane, you can see who checked out the document and the date and time it
was checked out. When a document is checked in, its status is set to Checked In.

"7 B0 M] p.0.-Sauve_FileHol_17032011 Test 0 1 _ CheckedIn  17/03/2011 3:58 PM Continents North America »Canada »British

= Columbia =Burnaby
g .0, -ysadm_Self-5e_| =3 = ecked In 04y -

&@ P.O dm_Self-5e_07042011 Test o Checked I 07/04/2011 10:07 AM
T .0, -ysadm_Use of _| =3 pi} e u 04y :

(7] b p.o dm_L f _06042011 Test 1 Ch keT) it 06/04/2011 3:45 PM

Checked In Status

Checked Out Status w \ersion Properties

Version

1 of 1 View all versions

Owner

Marvin Mallett added on March-14-11 4:06 PM

Library Status
When and who checked out Checked Out by Marvin Mallett on March-15-11

the document 9:18 AM

m

TO CHECK OUT A DOCUMENT

1. Locate the document you want to check out in the Library and do one of the following:

e Click Check Out from the toolbar.
¢ Right-click and select Check Out This Document.
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e To check out and open the file in its native application, hold the CTRL key and double-click
the document name.

2. The document status changes to Checked Out and is downloaded to your working folder.
Your working folder is typically C:\Users\username\Documents\My FileHold Documents.
The working folder location is set in your User Preferences.

e If you selected to check out and open the file, it opens in its native application. For
example, a .docx document opens in Microsoft Word.

10.12.1. Checking in Documents

Only the user that checked the document out of the records management system can check
the document back in. You can check in a document from anywhere the document shows up in
the system such as the folder location, My Checked out Documents, or a Microsoft Office
application.

Documents can be deleted automatically upon check in if the setting “By default delete
documents that | Check In to FileHold” is enabled in the User Preferences. It may also be
locked down by an administrator and cannot be modified.

It is possible to enable the setting “Edit metadata upon Check In action” in the User
Preferences so that the metadata pane opens for editing after checking in a document into the
document management system. If configured to do so, then the metadata pane automatically
opens upon check in so the values can be modified. This option can be locked down by a
system administrator. See the System Administrator Guide for details.

Metadata field values may be cleared upon check-in if the option "Clear at Check In" has been
enabled in the schema. If enabled, then any required metadata fields (marked with an asterisk
*) in the schema are cleared forcing you to enter new values upon check in. See your library
administrator for details.

To CHECK IN FROM MY CHECKED OUT DOCUMENTS
1. Select document and do one of the following:
e Click Check In from the toolbar
e Right-click on the document name and select Check In This Document.

2. In the FileHold Office Client window, click Browse to go the folder location where the
document that you are checking in located, if needed. FileHold keeps track of where the
document was downloaded to so if the document is still in the same location, the path is
automatically entered.

3. Select any of the following options, if available/applicable:

e Edit metadata for these document(s) before check-in — This option opens the metadata
pane so the metadata field values can be edited. This option may be automatically selected
if the option “Edit metadata upon Check In action” is enabled in the User Preferences. It
may also be locked down by an administrator and cannot be modified.

e Delete the local copy of this file after it has been successfully checked in — This option
removes the local copy of the file from the user’s computer. This option may be
automatically selected if the option “By default delete documents that | Check In to
FileHold” is enabled in the User Preferences. It may also be locked down by an
administrator and cannot be modified.

e Email notify all folder members that these documents) have been checked in — This option
sends an email to all users and groups that have access to the folder. This option may not
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be available, depending on the Library Administration settings. See the Library
Administration Guide for more information.

Click Check In.

If the options “Edit metadata upon Check In action” or “Clear at Check In” are enabled, fill
out the required metadata values in the metadata pane and click Save.

TO CHECK IN DOCUMENTS FROM MICROSOFT OFFICE AND OUTLOOK

1. From a Microsoft Office application, click Check-In or Quick Check-in from the FileHold
toolbar.

2. The FileHold Office Client window opens. Enter or select in any of the required information
and click Save.

TO CHECK IN AN UNCHANGED DOCUMENTS (UNDO CHECKOUT)

1. After checking in a document, a window prompts you to select the new version the
document. At the top of the box is the option ‘Il have not changed these document(s).
Please undo the check out of these files'. Select the check box to undo the checkout
leaving the last version of the document as the most recent version.

o |If this option is not selected the when the user clicks the Check-In button, the “new” file
uploads to the documents management system as the latest version of the file.

ToO CHECK IN MULTIPLE DOCUMENTS

1. From the My Checked Out Documents view, select the documents to check in and click
Check In.

e This option is not available through the Web Client.

2. Alternatively, use the Working Documents feature to check in multiple documents at once.

10.12.2. Quick Check-in

The “Quick Check-in” option allows users to bypass the FileHold Office Client (FOC) window
when checking in a new version from Microsoft Office applications.

e Upon clicking the Quick check-in button « the file is saved if needed and added to
FileHold without further prompt.

o Metadata from the prior document version is copied to the new document version.

e The prior document name is copied to the new version.

e When the check-in is complete, the document in the Microsoft Office application is closed
and the local file is deleted.

o |If the “Clear at check in” option is enabled for a required field, there are no changes to the
above except that the FOC window opens in order to fill in the required metadata.

10.13. COPYING OR MOVING FILES

The Copy or Move function in FileHold allows you to make a copy of a document and/or move
it to another location in the library.
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In order to move or copy documents, Document Publishers and Publishers need to have
ownership of the document. Users who are Organizers or higher permissions can move
documents owned by anyone. Restrictions on where a document can be moved to apply.

TO COPY OR MOVE A FILE

1. Select one or many documents.

2. Right-click and select Copy or Move.

3. Inthe Copy/Move window, select one of the following options:
o Move files to a new location in the library
e Copy files to a new location in the library

4. Click Next.

5. Select the destination in the library for the documents or folder and click OK. The
documents are moved and/or copied to the new location.

10.14. MAKING A LOCAL COPY

You can make a copy (download) of a document to your local machine. The document is
downloaded to the working folder location specified in your User Preferences. This is typically
in the location C:\Users\username\Documents\My FileHold Documents.

TO MAKE A LOCAL COPY OF A DOCUMENT

1. Locate the document in the Library and do one of the following:

e Inthe FDA, click Make a Local Copy from the toolbar.
e In Web Client, select the check box next to the document name and click Get Copy.
e In Web Client or FDA, right-click on the document and select Make a local copy.

2. The document is downloaded to your working folder location.

10.15. EMAILING, AND EMAILING AND CHECKING OUT DOCUMENTS

You are able to email and “email and check out” documents from the Library. When sending
files from the document management system, it is important to send the file in a manner that
allows the other user to access the information while keeping sensitive data safe.

When emailing a link or attachment, emails retain the properties of your Microsoft Outlook
messages including signature blocks and other added items like legal disclaimers.

There are two ways to send files:
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e Send as an attachment — Attachments are the most common way of sharing files via email;

however, they are the least secure as anyone who receives the attachment can open the
document.

B Hd = Untitled - Message (HTML) T H - O %
MESSAGE | INSERT OPTIONS ~ FORMATTEXT  REVIEW  FileHold

-0

M [cotbi@oc- i -[A A E-E- 2z} 5“'@ [UJ Y Q > Follow Up - Q

X ' High Importance
Paste v B I U W A E=E= £ Address Check  Attach Attach Signature Zoom
- n Book Mames  File Ttem~ - ¥ LowImpartance
Clipboard & Basic Text ] Mames Include Tags . Zoom -
To.
=1
Ce.
Send
Bee.
Subject
Attached

v5 FH15-Online-Help-System-Guide.docx (3 ME

Regards,
Renée Sauvé

FileHold Systems Inc

e Send as a link — Links are not as common as attachments when sharing documents;
however, they are the most secure. Those that do not permission in the library to access
the file are unable to open the document via the link. In other words, in order to access a
file via a link, the recipient must also have access to the document in the system. Both the
Web Client URL and FDA link are appended to the body of the email.

EH® O = Untitled - Message (HTML) 7T H - 0 X%
FILE MESSAGE ~ INSERT ~ OPTIONS ~ FORMATTEXT  REVIEW  FileHold
-

0 TimesNew~[12 -/ A" A7 2= A |28 é"@ [”J d Q 1> Follow Up - Q

. ' High Importance
Paste " B I U aj“/-A- === & 3= Address Check  Attach Attach Signature Zoom
- - Book Mames File Item~ - 4 LowImportance
Clipboard & Basic Text [F] Mames Include Tags ' Zoom ~
To.
Ce.
Send
Bee
Subject

The following document(s) attached to this mail are stored on the FileHold server. Please click on a
link next to the document name to go directly to the document.

FH15-Online-Help-System-Guide (Direct access, Full user interface, Internal FH use only - FDA)

Administrators can configure how emails are to be sent from FileHold — either links or
attachments or both.

Emails can be sent either through Microsoft Outlook or via the built-in email client in the Web
Client. When emailing from Microsoft Outlook, emails retain the properties of messages
including signature blocks and other added items like legal disclaimers.
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When sending an email using the built-in web email client, it can use the logged in users email
address or the email address configured in the outbound email settings as the “From” address.
A key, “Email.FromGlobalUser” can be configured in the Library Manager web config file. For
new installs, the value defaults to true. For upgrades prior to 16.2, the default value is false.
Setting this key to true emails using the outbound email address as the From address. While it
may be desirable to send email using the true From address, some email server configuration
may prevent this. In those cases, it is still possible to send email but all messages have a
single From address from the main FileHold email settings. Customers that wish individually
addressed email where their email server prevents it can purchase a subscription from
FileHold to a special email service. You must have your own internet domain name and be
able to maintain your domain name service (DNS) records. This does not replace your normal
email service; it works along side it. This feature has no impact on users with their own email
client outside of FileHold.

NOTE: Users can also send a link using the Copy URL or Copy FDA Link in the Metadata
pane. The link can then be pasted into an email. See Adding Metadata and File Properties for
more information.

TO EMAIL A DOCUMENT FROM THE FDA

1. Inthe FDA, locate the file you want to email in the Library and click Email X on the
toolbar.

2. In the Email Attachment Settings window, select one of the following and click OK:
e Attachments to the email — Sends the document as an attachment to the email.

e Links at the end of the email body — Appends the FDA and FOC (web client) to the body of
the email. When a user clicks on the link, the user needs to login to FileHold to access the
document. If the user does not have the correct permissions, they are not able to access
the document.

NOTE: The library administrator can configure the system to send files as either an
attachment or as a link or allow the user to decide. If the function is set to allow the user to
decide then they are prompted to select an option. If not, the file is automatically inserted
into the email in the format chosen by the library administrator. See the Library
Administration Guide for more information.

Email Attachment Settings [iz-]

How would you like to send selected decument(s) ?

Send az | Please select
Please select

Attachments to the email
Links at the end of the email body

3. The email message is created in Microsoft Outlook with either the attachment or the links
appended to the body of the email.

TO EMAIL A FILE FROM THE WEB CLIENT

1. In the Web Client, select the documents that you want to send by selecting the check box
next to the document name.

Select Send to > Email or Email and Checkout from the FileHold toolbar.

The FileHold email client page opens. If configured, you can change to send the type of email
sent: as attachments or links.
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Te... IFlndUset”

cc... | Find user ||

BCC... [ Find User |

Subject |

Send documents as Aftachments to the email E3

Attachmentis {o the email

SLECRE Links at the end of the email body old Express
] ARMA Chapter Meeting April 28
(] Blog - calendar

= -

4. Click Send.

TO EMAIL DOCUMENTS FROM MICROSOFT OUTLOOK

Create a new message in Microsoft Outlook.

From the FileHold integration toolbar, click the Add Attachment from FileHold icon.

The FileHold Office Client (FOC) window opens. Select the files that you want to attach.
Click Attach.

o &~ b=

The files are attached to the message as attachments.

TO CHECK OUT AND EMAIL A DOCUMENT
1. Locate the file you want to email in the library.
2. Right-click and select Send to > Email and check-out.

3. In the Email Attachment Settings window, select if you want to send the document as an
attachment or a link and click OK. See the previous section for details.
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4. The email message is created in Microsoft Outlook with either the attachment or the links
appended to the body of the email. The document is also checked out of the system and
the status is changed to “checked out”.

=@ Type: Test (3 documents)

1] p.0.-5auve_FileHol_ es 1 ecked In a3/ :
fo ] p.0.-5 FileHol_17032011 Test i} 1 Checked I 17/03/2011 3:58 PM
77 B "\E‘ﬂ P.0.-ysadm_Self-Se_07042011 Test a 2 07/04/2011 10:07 AM
0B 1
o = -
-"/D’a.\"' = . ¥ )5 Untitled - Message (HTML)

] =
—/ Message Insert Options Format Text Developer d-Ins Adobe PDF @)

=) & A A g O & = - %
=} = ||[B I »||iE - = || EE EE| 0 L]
Paste — Names Spellin
- (22 A-|E= == - P pend
Clipboard ™ Basic Text Include 5 || Proofing
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Cc..
sema | Lo |

The following documents attached to this maif are stored on the
FileHold server. Please click on the documentfname to open a web
% browser and go directly to the document.

P.O.-ysadm Use of 06042011 (View in FDA, View in WebClient) E

[im] » (&1

10.15.1. Using the Document URLs

You can use the URLs provided in the Version Properties area of the metadata pane to send
links to other FileHold users instead of sending the entire document.

Depending on how your library administrator has configured it, you may be able to copy only
the default URL or all configured URLs.

Click the link to copy the URL. The link is copied and you can paste the link using Ctrl+V.

To LINK FDA AND WEB CLIENT URLS TO A WEB PAGE

You can link both Web Client URLs and FileHold Desktop Application (FDA) URLs to a web
page; however, these links still use the security set on the document. The user attempting to
open a URL must have the cabinet, folder, and schema permissions in order to access the
document.

1. Open the metadata pane for the document's link you want to copy.

2. Under Version Properties > Document URL, click Copy URL for the web client URL or
click Copy FDA Link for the FileHold Desktop Application link.

TIP: Due to browser security, in order to copy links in Mozilla Firefox or Google Chrome, you
need to right-click on the link and select Copy Link Location. You can then paste the link
into an email or document.

You can paste these links into your web page using CTRL+V.

4. When the URL link is clicked from a web page, you need log in to FileHold; either the web
client or FileHold Desktop Application, depending on the link type. Both the FileHold
Desktop Application (FDA) URL and the Web Client URL are maintained.

5. Once you are in FileHold, the document appears highlighted in the folder list. You can get
a local copy, check out, view version history, etc.
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10.16. LINKING DOCUMENTS

The ability to link documents together is a key feature that helps to organize documents into
logical groups. Links give users quick and efficient access to files that are related to the
document they are working with no matter where the file is stored in the library. For example, a
master contract document may be linked to its amendments.

Linking can be accomplished:
e Manually linking documents together from a view.

e Automatically by matching common metadata field values from within the same schema, a
non-matching schema, or all schemas. Common metadata field values can also be
searched on from the metadata pane.

Linked documents can be viewed in the Linked documents pane. The Linked documents pane
can be pinned in place using the Pin icon '”.

Schema
options list

Metadata fields
list

Pin icon (pinned
state)

Unlink icon (inactive)

Documents Linked to Invoice # 10393 ... Linked by Invoice # (dblookup) w  Matching schema - Select View:  Default View: - :"| e | @ x

Document Name ~ File Name Document Sch( Al schemas s Last Modified On
@ ) Invoice # 10393 Save-a-ot Markets ... Invoice # 10393 Save-a-lot Markets ... Invoices (dblooky Matching schema ked In 6/16/2020 12:11 PM

@ % Invoice #
@ E) invoice #
@ &) Invoice #
@ @) Invoice #

Save-a-bot Markets ... Invoice # 10393 Save-a-iot Markets ...  Invoices (dblooky Not matching schema fed In 6/16/2020 12:11 PM
ot Markets ... Invoice # 10393 Save-a-ot Markets ... Invoices (dblookup] i 1 Checked In 6/16/2020 12:11 PM
3 Save-a-iot Markets ... Invoice # 10393 Save-a-lot Markets ...  Invoices (dbiookup) 0 1 CheckedIn 6/16/2020 12:11 PM
3 Save-a-ot Markets .. Invoice # 10393 Save-a-iot Markets ... Invoices (dblookup) 1 1 CheckedIn 6/16/2020 12:11 PM

TO VIEW DOCUMENT LINKS

1. Do one of the following:
e Right-click on a document and select View Linked Documents.
e From the Linked column, double-click on the “linked” number.

e Search for linked documents from the metadata pane.

2. The Documents linked to...<document name> pane opens. All of the documents that are
linked to the selected document are shown.

3. Click on the Up or Down arrow in the Parent/Child column to view the parents (Up red
arrow) or children (Down green arrow) of the linked document.

4. Click the pinicon - to keep the pane in place.
5. Click Close Rad to close the pane.

10.16.1. Manually Linking Documents

Manually linking documents allows users to maintain a parent-child relationship between the
documents that are linked together. In other words, one document, the “parent”, serves as the
main document that all other files, the “children”, refers to. When linking two or more
documents together the user must specify the parent document in the linking relationship.

The Linked column is visible in most views and shows the total number of documents that are
directly linked to that document. These links may be of either parent or child relationship.

You are able to link documents that are in the same folder or from disparate areas of the library
such as the search results, virtual folder, or document tray.
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TO CREATE A LINK BETWEEN TWO OR MORE DOCUMENTS IN THE SAME FOLDER

1.

Select the files that are to be linked within a folder. At least two files must be selected.

Click Link .

In the Create Links Between Documents window, select the “parent” document from the
list and click Link. The other files are considered “children” to the “parent” file. The
documents are linked.

TO CREATE LINKS BETWEEN DOCUMENTS FOUND IN A SEARCH

1.

2.

Run a search.

Select the documents to link together and click Link . At least two files must be
selected.

In the Create Links Between Documents window, select the “parent” document from the list
and click Link. The other files are considered “children” to the “parent” file. The documents
are linked.

TO LINK DOCUMENTS IN THE DOCUMENT TRAY

“Send” all of the documents you want to link into the Document Tray.

In the Document Tray, select the files you want to link and right-click to select Link
Documents.

In the Create Links Between Documents window, select the “parent” document from the
list and click Link. The other files are considered “children” to the “parent” file.

The documents are now linked. You can see how many files a document is linked to in the
Linked column.

TO SEARCH FOR MANUALLY LINKED DOCUMENTS

1.

From the Advanced Search screen, select the search criteria Special Fields > Has Link.

2. Select Yes or No from the drop-down list and click Search.

10.16.2. Linking by metadata field

Since users are typically looking for related documents, FileHold can show documents in the
Linked documents pane that are related by:

A metadata field value in all schemas.
A metadata field value and matching schema.

A metadata field value and not match the schema.

This reduces the manual effort of users to manually link documents together.

The selected linking option is maintained when the Linked documents pane is opened. The
default is saved across sessions. If the default linking option cannot be applied, documents
related to the first metadata field value in the schema is used.

TO VIEW DOCUMENTS LINKED BY METADATA FIELD VALUES

1.

In a view, right-click on a document and select View Linked Documents.
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2. Inthe Linked documents pane, select the Linked by options:
e Select the metadata field name from the list.

o Alternatively, select Manual links to view links manually created by users.

e Select which schemas to match to:
o All schemas — Finds all matching metadata field values in all schemas.

o Matching schema — Finds all matching metadata field values in the same schema
as the selected document.

o Not matching schema — Finds all matching metadata field values that are not in the
same schema as the selected document.

3. The related documents are displayed in the Linked documents pane.
10.16.3. Removing document links

Links can be removed from documents that have been manually linked together and have a
parent/child relationship. Removing the link removes the relationship between the documents.

TO REMOVE DOCUMENT LINKS

1. In the Linked documents pane, select the documents and click Remove Link . The link
is removed.

10.16.4. Finding related (linked) documents from the metadata pane

Options are available in the FDA metadata pane that allow users to find documents with
related (linked) metadata. A user can right-click on a metadata field in the pane and select one
of the options:

e Linked by value
e Linked by value and schema
e Linked by value and not schema

The documents matching the selected option are displayed in the Linked Documents pane.
See Document links for more information.

NOTE: The right-click options are not available if there isn't a value in the metadata field.
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Metadata & File Properties X

Invoice # 10393 Save-a-lot
This version is Checked In

¥ Metadata

Document schema
Invoices (dblookup)

Document Name
Invoice # 10393 Save-a-lot Markets 03-Jan-1997

Invoice # (dblookup)
103 Copy
cu Linked by value
Savi
. Linked by value and schema
nwi )
Frida Linked by value and not schema
Total
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Check #

Edit

10.17. CHANGING THE DOCUMENT VERSION OWNER

Every document has an owner. A document owner is the user who has added that version of
the document into the repository. The owner may need to be changed during the life of a
document.

Organizers and cabinet administrators, for cabinets they own, can change the ownership of a
document version. You can change ownership for one document at a time; it cannot be
performed en masse. Cabinet administrators and higher roles can change ownership en masse
using a utility.

This is useful when certain users need to initiate workflows and the system administrator
permission setting “Ilgnore document version ownership when initiating workflows or sending
Courier transmissions” is not enabled. For example, in a workflow template, the task can
automatically be assigned to the document owner instead of having to set the user name each
time a workflow is initiated. See the Workflow and Courier Guide for more information.

Inpprove Document =7 l

Approvers * "
—I _l 'l
[
I ¥ Include Document Yersion Cvner Il_ Inchude WorkFlow Initisbor
BT F Force reservation ¥ Allow Check Qut
TO CHANGE THE OWNERSHIP OF A DOCUMENT VERSION
1. Inthe FDA, right-click on the document and select Change Document Owner.

e Inthe Web Client, using the context sensitive menu, select Change Document Owner.

2. Inthe Find People window, enter a first and/or last name and click Find Now.
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3. Inthe search results, select the user and click Select. The ownership of the document is
changed to the selected user.

10.18. RENAMING DOCUMENTS
You are able to rename documents in the library if you have access and have a role of
Publisher or higher.

Note that you cannot rename a document if the schema has a custom file naming pattern
configured. See your library administrator for details.

TO RENAME A DOCUMENT
1. Right-click on a document and select Rename.

e You can also click the Edit link that is in line with the document name in the folder or
search view.

e You can also edit the file name in the Metadata pane.

2. Enter a new name for the document and click Save.

@ Type: Engineering Drawing (2 documents)

17 o D wing Engineering Drawing 0 4 Checked In  08/12/2010 2:14PM Edit
7 6o kad_drawing_1 Engineering Drawing 0 i Checked In  08/12,/2010 2:10 PM ave Cancel

10.19. EXPORTING DOCUMENTS IN THE FDA

You can export all documents from a cabinet, drawer, folder groups, or folders using the Export
option. You can also export one or more documents from a folder. Once the Export command
is selected, you can select where you want to export the documents on your local machine.

When documents are exported, they are exported with an XML file and a Documents folder
containing all of the exported documents in their native format. The folder name and xml file
that is generated is named with a date and timestamp appended to the end. For example:
documents2015100882302.

The XML file stores the metadata of all the selected documents in a FileHold compatible
format. This allows for the importation of the documents back into the document management
system. For example, if you are exporting documents out of a demo system and importing
them back into a production system.

Exporting can be done by users with a Document Publisher role or higher if they have access
to those areas and are dependent on the role that you have:

Role Can export

Document Publisher, Document Publisher + Documents that they own.

Delete

Publishers, Publisher + Delete Documents, folder groups, and folders that
they own.

Organizer, Organizer + Delete Any documents, any folder groups and any
folders for the cabinets they have access to.

Cabinet Administrators If not a cabinet owner: documents, folder
groups, and folders that they own.
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10.20.

10.21.

If a cabinet owner: all drawers, folder
groups, folders, and documents.

Library and system administrators All areas of the library structure and
documents.

TO EXPORT DOCUMENTS FROM THE DOCUMENT MANAGEMENT SYSTEM

1. Right-click on a cabinet, drawer, folder, folder group, folder or document(s) name and
select Export or Send to > Export.

2. You receive a warning message asking if you want to continue with the export: "If you are
attempting to export x number of documents. Are you sure you want to continue?" Click
OK to proceed with the export.

3. Browse for the folder location where you want to export your documents and click OK. The
documents are exported to the selected location in the Documents folder along with the
XML file that contains the metadata information for each document. Both folder containing
the documents and the xml file are named documents[date][time] and
documents[date][time].xml, respectively.

DOWNLOADING DOCUMENTS TO A LOCAL FOLDER

You can download a copy of document to a folder on your local computer. You can browse to
where you want the document downloaded. Users with a document publisher role or higher
can access this function.

TO DOWNLOAD A DOCUMENT TO A LOCAL FOLDER

1. Navigate or search for the document you want to download.

2. Right-click on the document name and select Send To > Local Folder.
3. Select the folder location on your local computer and click OK.
4

A copy of the document is downloaded to the folder.

VIEWING VERSION HISTORY

The document management system retains a unique copy of each version of each file as it is
checked out and back into the Library. When a document is checked in and changes have
been made, FileHold automatically creates a new version of the document. FileHold versioning
are simply numbered as 1,2,3,4, and so on. You can create your own numbering system with
document control and version control numbers. See the Library Administration Guide for more
information.

When viewing a list of documents (folder view, search view), only the most recent version of
the document is displayed. The 'Ver' column shows the number of versions of a given
document. You can view previous versions of a file through the version history.

ar Y g L7

Document Name Type Invoice # Linked Ver Status Last Modified On

@ Type: Invoice (3 documents)

7 @ B 1nvoice-TPO300018852  Invoice 123445 0 2 |checkedIn  08/12/2010 12:45PM Edit
7 © B tnvoice-TPO300018851  Invoice 12345 0 1 |CheckedIn  08/12/2010 8:55 AM Edit
7 @ W& nvoice-TPO300029031  Invoice 238512 0 1 |checked Qut 08/12/2010 12:51PM
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When document is added to the library, it starts as version 1 and is "owned" by the person who
added the document. As the document is checked out and checked back in, that number
increases by 1 and the "owner" of the version changes to the person who has checked the
document in. For example, Paul added a file to the document management system. That file
starts as version 1 and is owned by Paul. Sally has access to the file and decides to check out
the file in order to modify it with the latest report information. Sally checks the file back into the
system. That file is now at version 2 and is owned by Sally.

Users can be restricted from viewing all versions except the most recently approved version.
For details, see the Workflow and Courier Guide.

10.21.1. Viewing Previous Versions of a Document

When viewing the version history of a document, the "History of Document Versions for
Document Name" window opens with the list of the previous versions of the document shown.
The document name, document schema, number of linked documents, version number, status,
last modified on date, owner, and approval status is shown in the view. This view cannot be
modified.

You can get a copy, delete, or email older versions of documents. You cannot check out, check
out and email, or link older versions of documents. In order to work with an older version of a
document, you can reinstate it as the current version (see below) or download a copy and
upload it into the document management system as a new document.

TO VIEW PREVIOUS VERSION OF A DOCUMENT
1. Select a document and click on the number of versions link in the Ver column.

e Alternatively, click on View all versions in the Version Properties area of the Metadata
Pane.

2. Alist of the previous versions appear. To go back to the folder list, click Back to Folder.
10.21.2. Deleting Previous Versions

Library administrators or document owners that have Document Publisher + Delete
permissions are able to delete previous versions of files. Document owners may only delete
the previous version of a document whereas library administrators can delete any version(s) of
the file in the document management system. This means that the versions shown in the
version history list are the ones that have not been explicitly deleted.

TO DELETE A PREVIOUS VERSION OF A DOCUMENT

1. View tha/ersion History of a document. Select the version you want to delete and click
Delete Kad.

2. In the Delete Files window, select a deletion option:
e Delete only the versions of the files | have selected.

e Delete all versions of each file that | have permission to delete.
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Delete Files ® |

Whatwould you like to delete?

@ Delete only the versions of the files I selected.

() Delete all versions of each file that I have permission to delete

NOTE: This delete action cannot be undone. Please contact your administrator
if you have acddentally deleted file(s).

[ QK ] [ Cancel

3. Click OK. The version of the document is removed. If you need to recover the document,
contact your library administrator.

10.21.3. Reinstating a Previous Version as the Latest Version

When viewing previous versions of a document the user can reinstate any of the previous
versions of the document as the latest version. This allows users to work with older versions of
documents such as checking out, initiating a workflow, or linking to other documents. For
example, the current version is 5 but a lot of mistakes occurred in that version and you would
like to restart from version 4. Since you cannot check out version 4, you can reinstate it as the
latest version (which would be 6) in order to check out and work on the document.

TO REINSTATE A PREVIOUS VERSION AS THE LATEST VERSION

1. Select a previous version of a document and click Reinstate as Latest Version.
2. Inthe Reinstate as Latest Version window, select one of the following options:

e Yes, reinstate the selected version’s metadata.

* No, keep current metadata values.

Reinstate as Latest Version @

The selected version of FileHold_EndUser_Guide_v09 will be reinstated as the latest version. Do
you want to also reinstate the metadata?

@ Yes, reinstate the selected version's metadata

() Mo, keep current metadata values

[ QK ][ Cancel ]

3. Click OK. The document is reinstated as the latest version. In other words, the version
number increases by 1 with the older document as the latest version.

10.21.4. Viewing Edits to Metadata for Older Document Versions
The system logs all edits to metadata for each version of a document.

To VIEW EDITS TO METADATA

1. To view the metadata edits for a version of a document, select the version(s) from the
history of versions list and click Edits to Metadata.
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2. To view a detailed description, click Show Metadata Edits link in the Metadata Change
History view. The metadata pane opens with a list of who made the metadata change,
when it was made and what was changed. Any changes are shown in bold font.

10.21.5. Viewing the Document Usage of Document Versions

You can view how one or more of a document version has been used. The document
management system tracks how a document has been used. For example, if a document has
been emailed, checked out, linked, viewed, and so on you can see what actions have been
taken on a document. You can see who the action performer is and when the action was
performed plus any details pertaining to the action (such as a change in ownership.

Library administrators can also use the Document Usage Log to see how documents were
used.

TO VIEW THE USAGE OF A FILE

1. In the Version History list, select one or more (using the CTRL or SHIFT keys) document
versions and click Usage of File.

2. The File Usage for Document Name window opens with a list of all of the actions taken
upon the document versions, which user performed the action and when the action was
performed.

3. To return to the version history, click Version History.
10.21.6. Viewing the Sign Off Sheet
The Sign Off Sheet shows a list of all users that either approved or rejected this version of the

document when they did it and if they signed-off on behalf of someone else.

If this was a multi-document workflow, all documents that were a part of the approval process
are shown in the sign off sheet. For more information on workflows, see the Workflow and
Courier Guide.

TO VIEW THE SIGN OFF SHEET

1. In the folder or search view, do one of the following;
¢ Right-click on a document and select Workflow > View Sign Off Sheet.
¢ In the Version History screen, click Sign-off Sheet.

2. The Sign Off Sheet pane opens below with a list of all users that have approved or
rejected all of the documents in the workflow.

3. Click X to close the Sign Off Sheet pane.
10.21.7. Viewing Workflow Reviews and Approvals

The review and approval history show each task that was completed in the workflow. The first
level in the workflow shows information about the workflow instance itself. Information includes
the type of workflow (the workflow template name), the name and version of the document,
who the initiator is, when the workflow started and when it is due and if the workflow resulted in
the document being approved or not.

To expand the workflow details, click the + sign in the FDA or the > arrow in the Web Client
next to the document name. In the task details, the percentage completed, the comments or
feedback documents provided by participants, the completion date, the due date, and status
(reviewed or approved) is shown.
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The review and approval history can only be seen by those users who have completed the task
and senior administrators.

For more information on workflows, see the Workflow and Courier Guide.

TO VIEW THE WORKFLOW REVIEWS AND APPROVALS
1. In the folder or search view, do one of the following;

e Inthe FDA, right-click on a document and select Workflow > View Review and Approval
History.

¢ |In the Web Client, click the arrow next to the document name and select Review and
Approval History.

e In the Version History screen, click Reviews & Approvals.

2. The Document Review and Approval History window opens with a list of all workflow
tasks.

3. To print the list of reviews and approvals click Print (FDA only). Note: The report is
printed exactly how it appears on the screen.

4. To export the list of reviews and approvals click Export (FDA only). When exporting the
report, you can choose to export only the workflow or you can include both the workflows
and the tasks. The report can be exported to CSV or HTML. Note that for the HTML
report, the workflow must be expanded in the Workflow Status Report results to print the
tasks. In other words, the HTML report is exported to look exactly how it appears on the
screen.

To return to the version history, click Back to Version History.

To return to the folder, click Back to Folder.

10.22. SETTING DOCUMENT ALERTS AND REMINDERS

Document alerts allow you to be alerted of changes that occur to files or folders kept in the
library. For example, a user in payroll subscribes to an Expense Reports folder that notifies
them of when an expense report needs processing by sending an alert. You can choose to set
alerts on both folders and/or documents. Once changes have been made to either the folder or
the document, you receive an alert in the Document Alerts area of My FileHold. You can set
the type of document or folder changes you want to be notified of and the email address to
send the notifications to in your Alert Preferences.

Document reminders allow you to be reminded of when a document requires attention in the
future. For example, you can be reminded monthly to update expense reports or to review
yearly employee contracts that are up for renewal. Once a reminder comes due, you receive
an email (if configured) and an alert in the Document Reminders area of My FileHold. You can
set reminder preferences in your Alert Preferences.

TO SET AN ALERT ON A FOLDER OR DOCUMENT
1. Right-click on a folder or document and select:
e Alert Me of Changes on a folder.
e Notify Me > Alert Me of Changes on a document.

2. You receive a message stating that “You have subscribed to be alerted when this file
changes”. Click OK.
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If you subscribed to a folder, the folder icon has an email icon on it = indicating you
are subscribed to the folder.

3. You receive email notifications about your alerts if the system has been configured. You
can also view and manage your alerts in My FileHold > Document Alerts. See how to
manage your alerts.

TO SET A REMINDER ON A DOCUMENT

1. Right-click on a folder or document and select Notify Me > Set a Reminder on a
document.

2. In the Add Reminder for Document Name window, enter the date in which you wish to
receive the reminder.

3. Enter the frequency in which you wish to receive the reminder: Once Only, Daily, Weekly,
Monthly, Quarterly, Bi-Annually, or Annually.

Click OK.

You receive email notifications about your reminders if the system has been configured.
You can also view and manage your alerts in My FileHold > Document Reminders. See
how to manage your reminders.

10.22.1. Managing Alerts and Reminders
Users can view and manage their document subscriptions (alerts and reminders) in the
Document Alerts and Document Reminders areas of My FileHold.

Document reminders are those documents that require attention on a certain date and time
period. You can view your document reminders in My FileHold > Document Reminders. You
may also receive an email notification if your alert preferences are configured to do so.

Document alerts are those documents or folders that have been set to trigger an alert. You can
view your document alerts in My FileHold > Document Alerts. You may also receive an email
notification if your alert preferences are configured to do so. Folder alerts are triggered when:

e New documents are added to the folder.

e Documents are transferred to the folders.

e Documents are deleted from folders.
Document alerts are triggered when:

e A new version of a document is checked in.

¢ Metadata values are updated.

In order to receive any new alerts on a document, the current alert must be "marked as read".
Once documents are marked as read, then any new alerts are emailed and appear in the
Document Alerts folder.

Users must be subscribed to the folder or document prior to receiving an alert. See Setting
Document Alerts and Reminders.

You can determine which type of alerts you want to receive by setting the Alert Preferences.
See Alert Preferences for more information.
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TO MARK AN ALERT OR REMINDER AS READ

1. Go to My FileHold > Document Alerts or Document Reminders and select an alert or
reminder.

2. Click Mark as Read. The alert or reminder is removed from the list.

TO REMOVE AN ALERT OR REMINDER

1. Go to My FileHold > Document Alerts or Document Reminders and click Manage
Alerts or Manage Reminders.

2. In the Manage My Alerts or Manage My Reminders window, select the file or folder you
want to remove the subscription to and click Remove X.

[ Manage My Alerts mw

Manage My Alerts
Document Name 4+ Location Type

0 ar Canadian Union / Accounting Folder Alert
D HolidayPartyBudget Canadian Union /HR f 2010 File Alert
D P.0.-Sauve_FileHol_17032011 Product Development [ Guides [ User Guide File Alert
[ P.0.-ysadm_Chatiog_04032011 Legal / Mortgages / 2010 File Alert
] SysAdmin Product Development [ Guides Folder Alert

TO DISABLE AN ALERT ON A FOLDER

1. Right-click on a folder that has an alert and select Disable this Alert.
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11.LIBRARY ARCHIVE

The Library Archive is the area where documents that are no longer in use but still need to be
kept for historical record purposes reside. The advantage of archiving is that it keeps your
current documents in the library and search results uncluttered with old or obsolete information.
Once documents are in the Library Archive, they can still be searched using the Include
archive in search check box under the Advanced Search area.

Documents can be archived using two methods:

e Manually archiving. Users with a cabinet administrator role or higher can move electronic
documents manually from the library into the library archive. Cabinet and library
administrators must be the owners of the cabinets in the library archive area in order to
move documents in and out of the archive. You need to enable the permission setting in
the Administration Panel.

e Using a scheduled event to automatically archive documents. See the Library
Administration Guide for more information on scheduled events.

Documents that have been placed in the library archive:
e Leftin the library archive indefinitely.

e Deleted from the library archive using an Event Schedule. See the Library Administration
Guide for more information on scheduled events.

e Moved back into the library manually should the need arise.

e Have a purple dot icon @,

When documents are sent to the archive, the cabinet/drawer/folder group/folder structure is
automatically duplicated. There is no need to recreate the structure. The security settings at
the cabinet and folder levels are also maintained.

The ability to browse the contents of specific drawers can be prevented. This can be done via
an API call or modifying a setting in the database. Contact support@filehold.com for more
information.

NOTE: The ability to browse drawers can be blocked by your administrator. If browsing a
drawer is blocked in the library, browsing the drawer in the library archive is also blocked.

TO MANUALLY SEND A DOCUMENT, CABINET, DRAWER, FOLDER GROUP, OR FOLDER INTO THE
ARCHIVE

1. Right-click on a folder and select Archive Folder or document and select Send to >
Library Archive.

2. The documents and/or folders are sent to the Library Archive and the cabinet/drawer/folder
group/folder structure is copied as well.

TO MOVE ARCHIVED ITEMS BACK TO THE LIBRARY

1. Inthe Library Archive, select the document or folder and select Copy or Move.
2. Select the Move files to a new location in the Library option and click Next.
3. Select the destination in the Library for the documents or folder and click OK.
4

At the alert message click OK. The documents and/or folder are moved back to the Library.
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12.MICROSOFT 365 TEAMS

12.1.

When configured by your administrator, you can see your documents in Microsoft Teams
inside the FileHold user interface.

Microsoft Teams is a common tool for collaborating on documents and allows multiple users to
edit documents at the same time. The FileHold integration with Teams allows you to apply
normal controls to these documents as though you were working with them on your local
workstation, but they exist in Teams.

Many scenarios are possible when working with FileHold and Teams. Start project documents
in Teams and when they are ready for full records control, add them to FileHold in one step.
Get to a review step in a workflow and check the documents out of FileHold and into Teams to
allow collaborative revisions before checking them back in and completing the workflow
activity. Automatically synchronize changes between FileHold and Teams in both directions.

TEAMS IN THE LIBRARY TREE

Once the user is successfully logged in using an Microsoft 365 account which has permission
to Teams, the “Teams” node will show in the FileHold library tree.

[%] Inbox (Send to Library)
- £2 My FileHold
@ E‘, Reviews & Approvals
[ Recent Folders
= Q Search
B ﬁVirtual Folders
I Reports
o Library
- Library Archive

= ﬂ Teams

=i Datacenter

=] E General

&[] p1058

S W Engineering drawings

E Internal IT todo

| abe .. - . -

The view in the library panel corresponds to the Your teams section and Files tab in the Teams
application. It will show up to 8 levels of folders in a Teams channel.
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. p [ ]
(7 < Q. Search (Ctri+E) S :
Q Teams - Qv - General Posts Files ~ Controlled documents  Controlled documents 2
Activity
@ Unread T Upload B Editin grid view & Share
Chat
i Teams and channels Documents General > P1058
feams & support team
= N v Modified ~
- Datacenter k ame eame
Calendar i o
General 82712020 BB Engineering drawings 4 minutes ago
Internal IT todo 1/25/2023

If there have been changes in your teams, channels, or folders since you logged in, you can
right-click and select Refresh changes.

To ADD A DOCUMENT FROM FILEHOLD TO A TEAM

Documents can be checked out or copied to a Team using the same method as for a local file.
When you choose Make a copy or Check-out document(s) from the context menu, choose the
Teams option.

You will be prompted with the Teams location browser. Select the Team channel or folder
where you want to save the file.

Every time a document is transferred between FileHold and Teams an association is created
and remembered inside FileHold. A single document in FileHold can only be added to a single
location in Teams.

12.2. WORKING WITH TEAMS’ DOCUMENTS

When a user opens a team directory, they see all documents available to them in a typical
document grid with the following headings.

¢ Name in Teams — document name in team; name of the same document in FileHold and
team may be different in some scenarios,

e Ver - specific number of FileHold document version, which is linked to team,

o Status — FileHold document status; it can be Checked In, or Checked Out, or empty if not
linked,

o FileHold — status of document in FileHold; it can be Latest version, or Old version, or Not
added,

o Teams - status of document in team; it can be Modified, or Unmodified, or empty if not
linked,

e Created By — name of user who created document in team,
e Created On — date when document has been created in team,
¢ Last Modified By — name of user who recently modified document in team,

e Last Modified On — date when document has been recently modified in team.
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To ADD A TEAM FILE TO FILEHOLD

One or more documents can be selected and added to the FileHold library by using Add to
library option from the toolbar or context menu. This operation uses the add document wizard
to complete the document details. When more than one document is added, they will all share
the same location and metadata.

By default, you will first be prompted about whether you want to delete the source files.

A system administrator can change the default behavior when adding documents using the
managed option Teams.SourceFilesDisposition. The following options are available:

e AlwaysDelete - Do not show the prompt, always delete the files from Teams.

o DefaultDelete - Show the prompt and default to deleting the files. This is the default
setting.

o AlwaysPreserve - Do not show the prompt, never delete the files from Teams.

o DefaultPreserve - Show the prompt and default to NOT delete the files.

TO CHECK IN A TEAM FILE

Select one or more modified documents. Use the toolbar or right-click menu to select Quick
check-in. The document name and metadata values are copied from the previous version.
Documents do not need to first be checked out from FileHold.

TO UPDATE THE TEAM FILE WITH THE LATEST DOCUMENT VERSION

Use the toolbar or right-click menu to select Get latest version. If there is an existing file in
Teams that has been modified, a warning message will be displayed before overwriting the file.

TO REMOVE OLD OR DUPLICATE FILES IN A TEAM

Use the toolbar or right-click menu to select Remove old or duplicate files. Files in Teams
will be deleted where a newer version or the same version exists in FileHold. If a document is
checked out from FileHold or modified in Teams, it will be ignored.

TO REMOVE THE LINK BETWEEN A TEAM FILE AND A FILEHOLD DOCUMENT

Select one or more files. Use the right-click menu to select Remove link to Filehold. The
tracking between FileHold and Teams will be deleted. The synchronization options will no
longer be applied to the Teams file.

TO GO TO A DOCUMENT LOCATION IN THE FILEHOLD LIBRARY

Select one document and use the right-click menu to select Go to document. The document
list will change to the folder where the selected document is located.

13.USING THE DOCUMENT TRAY

The Document Tray allows users to collect and perform actions on documents that are filed in
various folders throughout the system. The document tray behaves much like a shopping cart
in an e-commerce application in that it provides a temporary holding bin for documents that
users wish to perform actions on.
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The Document Tray helps users perform the same actions on documents that are stored in
different folders. All actions available on the toolbar and right click commands are supported in
the document tray including get copy, check out, move/copy, email, link and delete.

NOTE: Documents that are in the Document Tray are not copied or moved. The Document
Tray is only making reference to the documents located elsewhere in library.

Document Tray My Personal View -~ Q ? x

Document Name Location Document Schema Linked Ver Status Last Modified On

i f. b} Clear-button Product Development / Icons / Source Product icon 0 1  Checked In 2023-03-29 3:34 PM

v '._ | Close-button Product Development / Icons / Source Product icon 0 1 Checked In 2023-03-29 3:34 PM

b f. 1 Cockpit-icons Product Development / Icons / Source Product icon 0 9  Checked In 2023-08-23 12:02 PM
(=]
)
&

To OPEN THE DOCUMENT TRAY

-
1. In FDA, click on the Document Tray icon on the lower right side of the screen.

2. In the Web Client, click Document Tray located at the top of the hierarchy panel.
€ FileHold

a Document Tray

h Add Document
= &3 My FileHold

ir Favorites

[¥ Checked Out Documents
r. Document Alerts

B3 Document Reminders

The Document Tray opens at the bottom of the screen. In FDA, you can adjust the size of
the Document Tray using the slider arrow. The Document Tray in the Web Client is self-
adjusting. It expands to fit the documents automatically.

To ADD DOCUMENTS TO THE DOCUMENT TRAY

1. There are many ways to send documents to the FileHold to the Document Tray. Do one of
the following:

¢ In FDA or Web Client, select the document you wish to add to the document tray. Right-
click on the file and select Send to > Document Tray. You can select multiple documents
and send them to the Document Tray en masse.

¢ Inthe Web Client, place a check mark next to the documents you want to move into the
Document Tray and select Sent To > Tray.

e In FDA, drag and drop document(s) from one or more folders and into the Document Tray.
WARNING: You cannot drag and drop documents in the Web Client.

TO CLEAR FILES FROM THE DOCUMENT TRAY

Removing documents from the document tray does not delete the file from the library. The
document remains in the same location.
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x .

1. Select the documents you wish to remove from the tray and click remove
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14.USING THE DOCUMENT VIEWERS

Viewers have many user features and many benefits that increase productivity and save
companies money. Viewers come included with each registered user license and assigned to
registered users by the system administrator. Different viewers are available for use with

FileHold:

e FileHold viewer level 1 (web and FDA)

e FileHold viewer level 2 (web and FDA)

o FileHold viewer level 3 (web and FDA)

o PDF/Image Viewer (FDA only). This viewer may be disabled. See your system

administrator for details.

If a user is assigned a FileHold viewer level 1, 2 or 3 viewer license, then they are also able to

use the PDF/Image viewer in the FDA (if it is enabled by an administrator).

Viewer behavior can be configured in the User Preferences > Viewer tab.

14.1.

FULL AND PARTIAL SCREEN VIEWS IN THE FDA

The interface of the FileHold Desktop Application (FDA) can be modified to accommodate
seeing more information in the library tree and metadata pane when the viewer is in use.

Both the library tree and the metadata pane can be set to “full” or “partial’ view mode when the
viewer is open. Full mode extends the panes to the bottom of the screen where partial mode
decreases the pane size to the same level as the viewer pane. This full mode feature allows
users to look at more information in these areas while still viewing a document.

The Full and Partial buttons appear in the Library Tree and Metadata Pane only when the
viewer is activated. Full mode is useful when looking at a document and entering metadata at

the same time.
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14.2.

The FDA with the library tree in "partial" mode and metadata pane in “full” mode

FILEHOLD VIEWER LEVEL 1, 2, AND 3

The FileHold viewers allow users to view files in both the Web Client and FileHold Desktop
Application (FDA). Each registered user account comes standard with a FileHold level 1
viewer. A system administrator can change this to a level 2 or 3 viewer in the user account, if

purchased.

The FileHold viewers are primarily used with a mouse but supported browser keystrokes can
be used such as arrows, home, end, page up, and page down buttons for scrolling page in the
viewer panel. “Copy” (Ctrl+C) can be used when text is selected in a document and “Enter”
when the focus is either in the text search or the page navigation text input.

The table below shows the features supported by the viewers (provided that they have been

enabled by a system administrator).

Feature Level 1 Level 2 Level 3
Open documents X X X
Publish document to local computer X X X
Publish document to FileHold X X X
Print document X X X
Automatically open documents in folders and X X X
search results
Annotations and markup X X
Annotations — multi-user tracked markup X X
Annotations — view only (annotations cannot be X
viewed in Microsoft Word (.docx) files)
Search and highlight search results X X X
High fidelity rendering X X
Manipulate pages X X X
Redaction — add or edit X
Redaction — view only X X

(C_)anr_10t

view in

.docx files)
Comments X X
Bookmarks panel - view X X X
Attachments pane — view X X X
Supports a large number of file types X X
Document assembly X X
Automatic watermark display X X
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The level 1 viewer uses low fidelity rendering for docx files. The level 2 and 3 viewers use high-
fidelity rendering for supported file types which means documents are converted to PDF format
before being displayed in the viewer. With the FileHold viewer, some features of the supported
file formats are not supported for viewing. It is recommended that you test your documents in
the viewer in order to determine how your documents are rendered.

The temporary PDF files for the high-fidelity rendering are stored in a cache and are cleaned
up in the scheduled task “FH clean web viewer cache”. By default, the task runs once per day.
The number of days to store the cached documents can be configured in the web config file
setting “ViewerCachelLife" in C:\Program Files\FileHold Systems\Application
Server\LibraryManager. The default number of days to store the cached files is 1095 days.

To enable external links in the documents viewed in the FileHold viewers, set the
"EnableExternalLinksForHtmlIViewing" key to “true” in the C:\Program Files\FileHold
Systems\Application Server\DocumentRepository web config file.

The side panel is always opened when a document is opened for viewing. There are a number
of use cases where this is not needed. To disable the side panel, add the key
“Viewer.ShowThumbnails” and set it to "false" in the web.config file in C:\Program
Files\FileHold Systems\Application Server\WC2. By default, the value is true. If the value is set
to false, a user can still open the side panel by clicking any of the panel icons.

14.2.1. Supported file types

The following file formats are supported by the level 1, 2, and 3 viewers:

File format Level 1 Level 2 and 3
3fr

ai

arw

azw3

bay

bmp X

bmqg

cap

chm

cine

cr2

crw

cs1

cur

cut

dc2

dcm

der

X| X[ X| X| X| X| X| X| X| X| X| X| X| X| X| X| X| X| X

dds
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File format Level 1 Level 2 and 3

dib

dng

doc

docm

docx X

dot

dotm

dotx

drf

dsc

dxf

emf

eml

epub

erf

exr

fax

fopc

jb2

X| X| X| X| X| X| X| X| X| X| X| X]| X| X]| X| X| X| X| X| X| X| X| X| X| X| X| X| X| X| X| X| X| X| X

jbg
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File format

Level 1

Level 2 and 3

joig

jbig2

ifi

jfif

jif

ing

ip2

jpc

jpe

jpf

irglipeg

jpg2

jpm

jpx

k25

kc2

kdc

koa

Ibm

md

mdc

mef

mht

mhtml

mng

mobi

mos

mrw

msg

nef

nrw

odt

orf

ott

X| X| X| X| X| X| X| X| X| X| X| X| X| X]| X| X| X| X| X| X| X| X| X| X| X| X| X| X| X| X| X| X| X| X
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File format

Level 1

Level 2 and 3

pbm

pcd

pct

pcx

pdf

pef

pfm

pgm

pic

pict

png

pnm

pot

ppm

ppt

pptx

pptm

psd

ptx

pxn

gtk

raf

raw

rdc

rle

rtf

rw1/rw2

rwz

sgi

sr2

srf

Srw

sti

sun

X| X| X| X| X| X| X| X| X| X| X| X]| X| X]| X| X| X| X| X| X| X| X| X| X| X| X| X| X| X| X| X| X| X| X
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File format Level 1 Level 2 and 3

svg

targa

tga

tiff/tif X

txt

wap

wbm

wbmp

webp

wmf

wsq

xbm

xht

xhtml

xls

xlsx

xlsm

xlt

xml

X| X| X| X| X| X| X| X| X]| X| X| X| X| X| X| X| X| X| X| X

Xpm

14.2.2. All FileHold viewers — Page manipulation and using the viewer toolbar

Pages in a document can be manipulated, such as adding, deleting, copying, dragging and
dropping pages, rotating, and flipping, in all FileHold viewers, if permitted by an administrator.
Enabling or disabling annotation mode is permitted in level 2 and 3 viewers.

For a complete list of functionality availability for each viewer, see FileHold Viewer Level 1, 2,
and 3.

NOTE: A system administrator may have restricted page manipulation.

To USE THE FILEHOLD VIEWER

1. Using the contextual menu, select Open in FileHold Viewer. The document is opened
with thumbnails displayed on the left side of the viewer. The currently selected page is
displayed in the main part of the viewer.

2. To manipulate the pages, use the toolbar buttons to zoom in and out, navigate between
pages, and close the viewer to return to the list of documents. See the table below for a
complete list of functions and descriptions.

e One or more pages can be selected in the thumbnail view. To select multiple pages, use
the SHIFT and/or CTRL keys.

< Hold .
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Function

Description

Publish document

Add document as a PDF into the FileHold
repository as a new document, as a new
version, or save as a local copy of the
document.

Also available from right-click menu on
thumbnail.

Print %

Prints the document.

Previous Page

Previous image is displayed in the document.

2z 12
<page number> -

Enter a page number to show the image.

Next Page

Next image is displayed in the document.

Fit to Width Ia Q?cj;ltjr?tc?fttrr]mz iir:”nnaa%?a -on the screen to fit the full
Fit Page ﬁ;gsg?;ré?sg?e?feed?n the screen so the entire
Full Size Shows the full image size.

Zoom In Zooms in on the image.

Zoom Out

Zooms out from the image.

Edit Iz

When enabled, viewer is in annotation mode
and annotations can be applied to the
document. Other users are blocked from
annotating or checking out the document.

When disabled, viewer is not in annotation
mode. Annotations cannot be made to the
document and any existing annotations are
read only. Other users may edit annotations.

Only available for L2 and L3 viewers.

Save @

Saves annotations to the markup layer.

Only available for L2 and L3 viewers.

Select text/area =

Allows the user to select text and/or an area
on the page to annotate.

Only available for L2 and L3 viewers.
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Function Description
) ) I_ﬂ Displays the previous annotation on the
Previous annotation * document.
. 7 Displays the next annotation on the
Next annotation E’ docum):ent.
. Adds one or many files before or after the
Add pages y

selected page. Files can be added from a
local file, clipboard, or the FileHold library.

Also available from right-click menu on
thumbnail.

Limited to PDF and image files for level 1
viewer.

Deletes the selected pages.
Delete pages @ pag

Also available from right-click menu on
thumbnail.

Limited to PDF and image files for level 1
viewer.

Copy to clipboard i'] Copies selected pages to the clipboard.

Also available from right-click menu on
thumbnail.

Once the page is copied, it can be added
back into the document using Add Pages >
Clipboard option.

Limited to PDF and image files for level 1

viewer.
\ Rotates page(s) 90 degrees to the left.
Rotate Left page(s) 9
Also available from right-click menu on
thumbnail.

Limited to PDF and image files for level 1

viewer.

Rotate Right Rotates page(s) 90 degrees to the right.
Also available from right-click menu on
thumbnail.

Limited to PDF and image files for level 1
viewer.

Flips th horizontally.
Flip Horizontal @ Ips the page(s) horizontally
Limited to PDF and image files for level 1

viewer.

< Hold s
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Function

Description

Flip Vertical @

Flips the page(s) vertically.

Limited to PDF and image files for level 1
viewer.

Close Viewer m

Closes the viewer and returns to the folder.

Available in the Web Client only.

Drag and drop

One or many pages can be dragged and
dropped into a new position in the thumbnail
view.

Use the CTRL and/or SHIFT keys to select
multiple pages.

Limited to PDF and image files for level 1
viewer.

3. A context menu is available on the thumbnails for certain functions. Right-click on a
page(s) in the thumbnail view to do one of the following:

e Insert

e Copy to clipboard
e Delete page(s)

¢ Rotate left
e Rotate right

e  Flip horizontal

o Flip vertical

e Publish document

4. Click Publish or Save to save changes.

14.2.3. All FileHold viewers — Highlight search results

FileHold can display the search terms highlighted within searchable documents. Searches can
be conducted from the FileHold library or using the Search pane directly in the FileHold viewer.

Search results are highlighted in green.

In the Search pane, whole word and case-sensitive options are available. Searches can be
done in current page only or in the entire document.

The Search feature is available in all viewers. If a user has a viewer level 2 or 3, annotations
can be applied to the search results using the context toolbar in the Matches area. The
annotation can be applied to the selected match or the entire document.
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Creating Fastfind Templates B3|

Search

fastiind
() Whole word
] Case sensitive

[ Any word

U

andmenuareasoftheformiosearctrie

isused 2 GotoFile>PreferencesandSt
>PreferencesandSettings>FastFindF
EnableFastFindcheckbox, ClickOK.3.

GotoTools>FastFindTemplates. 4 inth
AddTemplate. 5 Themessage “Activate
6.A%snapshot oftheapplicationwilinow
repeatstep. 7 Enteranameanddescr
5 Matches Page 5

amountwasaddedassources. 21.Click

FastFindtemniate 22 GotnFile>Drate ~

Creating FastFind|Templates

FastFind allows you to search FileHold decument management software from third party Microsoft
forms-based applications such as an accounting or ERP system. You create the templates for the third
party application and assign “hot keys” or shortcut keys to search the various areas of the forms-based
application. This allows users to quickly search FileHold and access information related to the file they
are working on in the third party application.

Each template can have multiple “sources” and all templates should have multiple “rules” in order to
ensure a good search. For example in an invoice form, sources can be set for the fields, Customer Name,
Customer Number, Amount Owed, Date Billed and Due Date while the rules determine the areas like the
header, body, footer and menu areas of the form to search.

To create a FastFind template

. Open the third party application that you are creating the template for. In this example, a
Microsoft Money invoice is used.
. Go to File > Preferences and Settings > FastFind Preferences and select the Enable FastFind
check box. Click OK.
. Go to Tools > FastFind Templates.
4. In the list of FastFind Templates window, click Add Template.
5. The message “Activate the window you want the FastFind Template to be associated with and

press Alt+N." appearseSelect ird;party application AltN,
6. A"snapshot"ghh iftno E it 115§st die ltwinduw.lfthe
incorrect wins wasThvoked, click SelectNe ndow and repeat s g

A Fastid Temgite
et Mo Wi Tost Tamplee it o Tources | At ode | 464 Sowrces

[
5

December 12012 View or edit an existing invoice: Accounts Receiva

1 Comencn sk Cotone [t
—

TO HIGHLIGHT RESULTS IN DOCUMENTS FROM LIBRARY SEARCHES

1. Execute a simple, advanced, or saved search using at least one full text search condition.

2. In the search results, right-click and select Open in FileHold viewer.

3. The FileHold viewer opens with the search terms highlighted and the Search pane. Scroll
through the search results using the Search pane in the viewer.

NOTE: THE CONTENTS OF A LIBRARY SEARCH ARE SIMPLY COPIED TO THE SEARCH PANE IN THE
VIEWER AS IS, BUT THE SEARCH METHODS ARE DIFFERENT IN EACH CASE, SO RESULTS MAY VARY.
FOR EXAMPLE, IF YOU SEARCH FOR “DYNAMIC IMPORT” IN THE LIBRARY SEARCH, THEN OPEN THE
VIEWER ON ONE OF THE RESULTS THE SEARCH TERM INCLUDING THE QUOTATION MARKS WILL BE
COPIED TO THE VIEWER SEARCH. HOWEVER, THE LIBRARY SEARCH TREATS THE QUOATIONS AS
DELIMITING A PHRASE AND THE VIEWER SEARCH TREATS THE QUOTATION MARKS AS ABSOLUTE
TEXT.TO SEARCH IN THE FILEHOLD VIEWER

1. In the FileHold viewer, select the Search icon from the side panel.

2. Enter the search term.

3. Select any of the following options:
e Whole word — Disabled by default.

o Case sensitive — Disabled by default.

¢ Any word — Disabled by default.

e Current page D— Searches through the current page only.

e Whole document — Searches through the whole document. This is the default setting.
4. Click Search. The search terms are highlighted.

September 2025

< FileHold

135



FileHold 17.1 End User Guide

TO APPLY ANNOTATIONS TO SEARCH RESULTS

1. In the FileHold viewer, with annotation mode enabled (click Edit Z ), search for a word or
phrase.

2. In the search results area, right-click on a match. The context toolbar appears.
Select one of the options: redaction, highlight, strikeout, underline, erase, or comment.
4. In the pop-up window, select one of the following options and click OK:
e Apply to the current selected text only
e Apply to all search results

5. Save as a markup layer or publish as a new version.
14.2.4. All FileHold viewers— Publish as PDF

If a document has been updated through page manipulation or annotations, the newly updated
document can:

e Published as a new document on the local computer.
e Published as a new document in the FileHold library.
e Published as a new version of the document in the library.

NOTE: Your system administrator may have restricted publishing.

To PUBLISH AS A PDF DOCUMENT

1. Click Publish .

2. Select one of the options:

e Save this published version as a new local document - Saves the document to your local
computer. Save or open the file to the local computer.

e Save this published version as a new document in FileHold - Saves the document as a
new document to the library. If saving as a new document in the library, set the folder
location for the document and fill out any related metadata and click Submit.

o Create a new version of the file you are publishing — Creates a new version of the
document. A new version is automatically created.

3. Click OK.

14.2.5. All FileHold viewers - Bookmarks pane

Bookmarks can be viewed in the Bookmarks pane m All viewer levels can view bookmarks.

If using document assembly, bookmarks are added to the PDF for each file when merging files.
The bookmark name is the document name.

14.2.6. FileHold level 2 and 3 viewer — Annotations

Annotations allow users to add stamps, text, sticky notes, shapes, highlights, comments,
redaction, and so on to documents in the FileHold library. Annotations can be viewed in every
FileHold viewer level. They can be edited in the FileHold viewer level 2 and 3. Annotations can
be made using the annotation pane or the context toolbar on a page.
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Annotations made on a document can be published as a new document, new version, or local
document, or saved as a separate markup layer. A markup layer is an “overlay” of annotations
on a document, they are not “burned” into the document itself. Only one markup layer can be
created on a document; however, many users can contribute to the markup. If a document has
a markup, the “Has Markups” section in the metadata pane is set to “Yes” with a link to view
the markup. Clicking the link opens the document with the markup layer visible. If a document
is published as a new version or new document, the annotations are “burned” into the
document; it is not a separate layer.

¥ \ersion Properties

- ~
Version

1 of 1 View all versions

Owner

added on Thursday, September
6, 2018 2:18 PM

Library Status
Checked In

Has Markups
Yes View markup

The properties of an annotation (style, color, font, etc.) do not persist from document to
document but some preset stamps are available: Paid, Approved, Rejected, Expunged. The
existing annotation presets can be modified or new preset annotations can be created in the
Microsoft SQL database for reuse. The. See the FileHold Knowledge Base for more
information on customizing preset annotations.

In order to annotate a file, the documents must be in annotation edit mode (E ). Annotations
are locked down to their owner which means only the user who created the markup can edit
their own annotations. If a user attempts to annotate the document while being annotated by
another user, a message displays stating the document is in use.

Annotations created by other users are displayed in read-only mode with the exception for
cabinet administrator or higher roles. Administrators can remove any annotations but cannot
modify them. Users can only remove pages that do not contain annotations or if all the
annotations are created by them. In other words, page removal is not possible if it contains
annotations created by another user. Administrators can remove any pages.

When a user is annotating a file, it cannot be modified or checked out by another user. If a user
attempts to annotate the document while being annotated by another user, a message displays
stating the document is in use. When the user has completed the markup and attempts to
leave the viewer, the user is prompted to save the markup. In order for the document to be
unlocked from annotation mode, the current user must do one of the following to leave
annotation mode:

e Click the Edit button Z to end annotation mode.

e Close the viewer tab in the FDA:

Document Viewer

PROJ_12345_Filetold K|

|,

Annotation mode on a document automatically ends within 24 hours.
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Since annotations are locked to their owner, the owner’'s name (and their GUID), and the
creation and modification dates are displayed for each annotation. To display the annotation
owner information, select the annotation and hover over it.

Document Viewer

DEF Co Contract.v1vivivi  Ed|

s Performed For:

ABC Co
12345 ABC St,

Burnaby BC V5C5T5S Burnaby BC V4v4v4

This Statement of Work (SOW) is issued pursuant to the Consultant Services Master Agreement

0 (-Client) and FileHold Svstems Inc (Contract L{the

fective

Created at 9/27/2021 1:05 PM
Modified at 9/27/2021 1:05 PM

terms of this SOW and the terms of this Agreement, the terms of this SOW shall govern and

prevail

Pearind nf Parformance

Markup layers can be searched using an advanced search on “Has Markup”. See Advanced
Searches for more information.

WARNING: If you have markup created in the legacy Brava viewer, the FileHold viewer
annotations feature is not available.

TO USE ANNOTATIONS FOR THE FILEHOLD VIEWER LEVEL 2 AND 3

1. Using the contextual menu, select Open in FileHold viewer. The document is opened with
thumbnails displayed on the left side of the viewer. The currently selected page is
displayed in the main part of the viewer.

2. Click Edit E The document is now in annotation mode. No other user can annotate or
check out the document.

3. Select the Annotations I:I or Annotation Presets Z icons from the left side of the
viewer.

TIP: You can navigate to the Thumbnails or Search views while in Annotation mode if
needed.

4. Select an annotation option, fill out the related annotation properties, and then draw on the
screen where the annotation is to be placed. Use the following table to learn more about
annotations:
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Function Description

Allows you to add a rectangle highlighter
\& annotation onto a document. A number of
— highlighter properties are available to set the

Highlighter colour and rotation.

Allows you to draw a freehand highlighter
annotation onto a document. A number of
Freehand highlighter — freehand highlighter properties are available
to set the colour, rotation, and border width.

Allows you to add a rubber stamp annotation
onto a document. A number of stamp

Rubber stamp —— properties are available such as font, colour,
opacity, rotation, borders, radius, and line
styles.

Allows you to add a rectangle annotation

onto a document. A number of rectangle

Rectangle properties are available to set the colour,
opacity, rotation, borders, radius, and line
styles.

Allows you to add an ellipse annotation onto
' a document. A number of ellipse properties
— are available to set the colour, opacity,
rotation, borders, and line styles.

Ellipse

Allows you to add a line annotation onto a
document. A number of line properties are
Line available to set the colour, start and end cap,
opacity, rotation, borders, and line styles.

Allows you to add a connected line
, j\ annotation onto a document. A number of
Connected lines connected line properties are available to set
the colour, opacity, rotation, borders, and
line styles.

Allows you to draw a freehand annotation
Freehand N onto a document. A number of freehand

properties are available to set the colour,
opacity, rotation, borders, and line styles.

Allows you to add a line arrow annotation
/' onto a document. A number of arrow
properties are available to set the arrow
height, width, colour, opacity, rotation,
borders, and line styles.

Arrow
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Function

Description

Ruler @

Allows you to add a ruler annotation onto a
document. The total length of the line is
displayed. A number of ruler properties are
available to set the font, font size, colour,
opacity, rotation, borders, and line styles.

Polygon ruler EE]

Allows you to add a polygon ruler annotation
onto a document. The total length of the
polygon is displayed. A number of polygon
ruler properties are available to set the font,
font size, colour, opacity, rotation, borders,
and line styles.

T]

Text

Allows you to add a text annotation onto a
document. A number of text properties are
available to set the measurement unit,
colour, position, justification, opacity,
rotation, borders, and line styles.

=l

Sticky note

Allows you to add a sticky note annotation
onto a document. A number of sticky note
properties are available to set the font, font
size, colour, position, justification, opacity,
rotation, borders, and line styles.

ZAnnotation Presets > Paid

Adds a “Paid” stamp to the document.

ZAnnotation Presets > Approved

Adds an “Approved” stamp to the document.

ZAnnotation Presets > Rejected

Adds a “Rejected” stamp to the document.

ZAnnotation Presets > Expunged

Adds an “Expunged” stamp to the document.

5. When text, area, or an existing annotation is selected on a page in the viewer, a context
toolbar appears. The following table describes the icons in the toolbar.

Icon Description
™ Copy selected text
T] Select text area
Redact
4 Highlight
Ab Strikeout
19) Underline
K Erase

®
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Icon Description

Comment

Edit annotation properties

Delete annotation

SIANR

6. To save the markup layer, click Save Annotations B .
To save as a new document or version with the annotations “burned” into the document,

click Publish . See FileHold viewers level 1 and 2 — Publish as PDF for more
information on publishing.

8. Click Annotate to exit annotation mode. You must exit annotation mode in order for
other users to annotate the document.

14.2.7. FileHold viewer level 2 and 3 — Comments

Comments are available in the levels 2 and 3 viewers. The comment feature allows users to
comment on specific text or areas on a page. Comments can be viewed in the viewer

.

comments pane

>
save
Hl comments < e o
- o
p E Date Services Performed By Services Performed For:
’ Sort by | page v GJ July 17, 2017 FileHold Systems Inc ABC Co
g‘ et 250-4664 Lougheed Hwy 12345 ABC St.
¥ Joe Smith SRR (4] Burnaby BC V5C5T5 Burnaby BC V4V4V4
[ !
L] @Basie This is a comment for Basie (D
75 Statement of WOrK (SUW 1S 1S5Ued pursuant 10 the Consultant Services aster Rgreemenl
B []Page ® ¢ Q between ABC Co (“Client”) and FileHold Systems Inc (“Contractor”), effective August 1, 2017 (the
'Agreement”). This SOW is subject to the terms and conditions contained in the Agreement
between the parties and is made a part thereof. Any term not otherwise defined herein shall have
@Deborah This is a comment for Deborah he meaning specified in the Agreement. In the event of any conflict or inconsistency between the
erms of this SOW and the terms of this Agreement, the terms of this SOW shall govern and
[ page ¢ Q revail.
k RIS SOW # 12345 (nereinafter called the oUW i) effective as of August 1, 2017, is entered into
by and between Contractor and Client, and is subject to the terms and conditions specified
gpelow. The Exhibit(s) to this SOW, if any, shall be deemed to be a part hereof. In the event of any
nconsistencies between the terms of the body of this SOW and the terms of the Exhibit(s)
ereto, the terms of the body of this SOW shall prevail

The author of the comment is automatically set to the user's name. Comments can be directed
to other users using the @ symbol. Once the annotations are saved, email notifications are
sent to the users that have been mentioned in the comments. Emails are sent according the
user preferences. The link in the email directs the user to the comment in the document.

*FileHold
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Comments can be sorted by page, author or date. They can also be expanded or collapsed in
the pane.

Sorted by author

Comments Comments are
collapsed
» Lucky 09/29/2021
r Charms 14:24
(]

[#

A status can be applied to the comments after their creation: approved, cancelled, finished, or
rejected. The colour and icon on the comment changes according to the status. The comment
status can be modified by any users with sufficient permissions.

Edit comment >

Author Joe Smith ‘

Status Approved v
None
Approved
Canceled

Finished Cancel Delete m

Rejected

TO CREATE A COMMENT

1. Open afile in the FileHold viewer and click Edit E The document is now in annotation
mode. No other user can annotate or check out the document.

Select text or an area on the page and click Comment ,
In the Comment window, the Author name is set to your username.
Enter any comments in the Message area.

e To direct a comment to a particular user, use the @ symbol and start to type a name to
bring up a list of matching users. Select the user's name from the list.

5. Click Publish to save the comment.
6. Click Save @ in order to send notification emails for any users tagged in the comments.

7. Click Edit to exit annotation mode. You must exit annotation mode in order for other
users to annotate the document.
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TO MODIFY A COMMENT

1. In the Comments panel, click Edit Qa on a comment.
Modify the message, as needed.

To apply a status to the comment, select one of the following:

e Approved
e Canceled ®
e Finished

o Rejected @
4. Click Save to save the changes.

o Alternatively, click Delete to delete the comment.

TO REPLY TO A COMMENT

1. In the Comments panel, click Answer + on a comment.
2. In the Answer window, enter any comments in the message area.

o Use @ to direct a comment to a specific user. Start to type a name to bring up a list of
matching users. Select the user’'s name from the list.

3. Click Publish to save the comment.
4. Click Save E in order to send notification emails for any users tagged in the comments.

5. Click Edit to exit annotation mode. You must exit annotation mode in order for other
users to annotate the document.

14.2.8. FileHold viewer level 3 — Redaction

Redaction is available in the FileHold level 3 viewer. Redactions are used to conceal sensitive
information for legal, financial, privacy, and security reasons, for example. Redactions
associated with the published document can never be edited or removed by the end-user and
the text and images beneath the redaction entities can not be viewed, copied, or searched.

You can redact text, areas, pages, images, or use the search function to find and redact. To
apply the redaction, the document must be published otherwise the redaction remains as a part
of the markup layer and can be modified by users.
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Document Viewer Undockviewer | () X

ABC Co Contractvlviviv  Ed|

Redacted
markup

“ Whole word

% ] Case sensitive
*

() Any word

U
This SOW # 12345 (hereinafter called the “SOW"), effective as of August 1, 2017, is entered into

by and between Contractor and Client, and is subject to the terms and conditions specified

below. The Exhibit(s) to this SOW, if any. shall be deemed to be a part hereof. In the event of any

inconsistencies between the terms of the body of this SOW and the terms of the Exhibit(s)

hereto, the terms of the body of this SOW shall prevail.

Period of Performance O WL U Qe

Redact
The Services shall commence on August 14, 2L‘1Wn'wuﬂh August 31, 2017.

Select text or area to
redact

After publishing, the redacted content is unreadable and not searchable.

6 July 17, 2017 FileHold Systems Inc ABC Co

-— 250-4664 Lougheed Hwy 12345 ABC St.

© Burnaby BC V5C5T5 Burnaby BC VAV4V4
w

Period of Performance

The Services shall commence on August 14, 2017, and shall continue through August 31, 2017.

Statement of Work for ABC Co = July 17, 2017

The redaction colours can be modified in the web config file in C:\Program Files\FileHold
Systems\Application Server\WC2. The following keys can be added to set the pre- and post-
redaction colours:

e <add key="Viewer.PreRedactionColor" value=" <hex value>"/>

e <add key="Viewer.PostRedactionColor" value=" <hex value>"/>
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TO ADD REDACTION

1.  Open afile in the FileHold viewer and click Edit Z . The document is now in annotation
mode. No other user can annotate or check out the document.

2. Select text or an area on the page and click Redact .
The selected area or text is greyed out.

4. Do one of the following:

e To keep the redaction as part of the markup layer, click Save E .

e To burn the redaction into the document and make the redacted areas unreadable and not

searchable, click Publish @

5. Click Edit to exit annotation mode. You must exit annotation mode in order for other
users to annotate the document.

14.3. ALL VIEWERS - PDF/IMAGE VIEWER

WARNING: By default, the PDF/Image viewer is automatically disabled. The PDF/Image
viewer has been deprecated so it is recommended that users transition to the FileHold
viewer. Users may be able re-enable the PDF/Image viewer in their User Preferences >
Viewer tab. See your system administrator if the option is disabled.

The PDF/Image viewer supports the following file formats:
o PDF
e TIFF (single or multi-page)
e Image files (jpg, png, gif, bmp)

The PDF/Image viewer can be used in the FileHold Desktop Application and allows users to do
a number of actions on files.
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Action PDF/Viewer Function

Modify a PDF e Reorder pages using drag and drop
or TIFF file e Insert a PDF or TIFF file into the current PDF or TIFF file.

e Drag and drop pages between PDF and TIFF documents (of the same
format) if the option to open documents in separate tabs is enabled. This
can be enabled in the User Preferences > Viewer tab.

e Delete pages

e Publish as a PDF as a new document, a new version of a document, or as
a local document.

e Open multiple documents at a time. Each file is shown on a separate tab.
Note that the tabbing feature needs to be enabled in the User Preferences
> Viewer tab.

Modify how the
file is viewed

e View thumbnails pages of a document. The thumbnail pane can be

e Change the orientation of the thumbnail pane. It can be set to the top,
bottom, left or right side of the viewer pane. The orientation of the pane is
set in the User Preferences > Viewer tab.

expanded or collapsed using a button on the toolbar.

e Select multiple pages of the document via the thumbnails.

e Undock the viewer so it is in its own window.
o) I |

e The size of the image can zoom and can be set to a fixed zoom level. For

e Pages can be rotated 90 degrees clockwise or counter-clockwise.

&

example, 100%, 150%, page width and so on. gl

e Scroll between pages. Mool 16 af 46

Modify an e Append an image to the current image file.

image file « Insert an image from one image file to another image file using drag and
drop.

e Save the image file as a jpeg file or publish as a TIFF file.

e Delete images.

Other actions e Print the document.

e Open documents in FileHold or from your local computer.

e Open documents in the Brava viewer (if you are assigned a license).
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If a

user is assigned a Brava viewer license, they can also use the PDF/Image viewer with the

Brava viewer, with the Brava viewer being the default viewer. They can use the function Open
to Reorder Pages/Images to open the document in the PDF/Image viewer. Note that starting in
2017, Brava viewer licenses are no longer available for new FileHold purchases. Previously
purchased Brava viewer licenses are still available for use.

NOTE: If you have the "Automatically open Document in Viewer" options selected in the User
Preferences, the documents are opened in a single pane as you scroll through the documents.

14.3.1.

Modifying a PDF or TIFF File

The following actions can be taken on a PDF or TIFF file:

To
1.

2.

To
1.

Reorder pages using drag and drop
Insert a PDF or TIFF file into the current PDF or TIFF file.

Drag and drop pages between PDF and TIFF documents (of the same format) if the option
to open documents in separate tabs is enabled. This can be enabled in the User
Preferences > Viewer tab.

Delete pages

Publish as a PDF as a new document, a new version of a document, or as a local
document.

USE THE PDF/IMAGE VIEWER TO REORDER PAGES OR IMAGES

Right-click on a PDF or multiple page TIFF file and select Open to Reorder
Pages/Images. The document opens in the viewer.

Move the pages around using the drag and drop method.

DRAG AND DROP A PAGE BETWEEN TWO FILES

Have two PDF or TIFF files open in separate tabs in the PDF/Image viewer. In order to do
this, you need the "Open documents in the Document Viewer using separate tabs" option
selected in the User Preferences > Viewer tab.

Select one or more page from the originating document.
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3. Drag and drop a page from one tab to the other tab and select a location for the page(s) in
the thumbnail view. A black bar is shown where the page(s) are moved to.

To PUBLISH AS A PDF DOCUMENT
1. After modifying a PDF document in the PDF/Image viewer, go to File > Publish to PDF.
2. Select one of the options:

e Save this published version as a new local document - Saves the document to your local
computer. Save or open the file to the local computer.

e Save this published version as a new document in FileHold - Saves the document as a
new document to the library. If saving as a new document in the library, set the folder
location for the document and fill out any related metadata and click Submit.

e Create a new version of the file you are publishing — Creates a new version of the
document. A new version is automatically created.

TO DELETE PAGES FROM A FILE

1. Select the page or pages you want to delete in the thumbnail images. You can multi-select
pages using the CTRL or SHIFT keys.

2. Goto Edit > Remove Pages or click the Remove Pages button.

To INSERT A PDF OR TIFF FILE INTO A PDF OR TIFF FILE

1. Open the document to be modified.

2. Select the page in the thumbnail view that you want to insert pages before or after the
currently selected image.

3. Goto Edit > Insert File Before or Insert File After.

4. Select the file to be inserted. It can be a local file or a file from the FileHold library. The file is
inserted into the current document.

14.3.2. Modifying an Image File

The following actions can be taken on image files (jpg, gif, png, bmp):
e Append an image to the current image file.
e Insert an image from one image file to another image file using drag and drop.

e Save the image file as a jpeg file or publish as a TIFF file.

TO INSERT AN IMAGE FILE INTO AN IMAGE FILE
1. Open the document to be modified.

2. Select the page in the thumbnail view that you want to insert pages before or after the
currently selected image.

Go to Edit > Insert File Before or Insert File After.

Select the file to be inserted. It can be a local file or a file from the FileHold library. The file
is inserted into the current document.
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TO DRAG AND DROP AN IMAGE FILE INTO ANOTHER IMAGE FILE

1. Have two image files open in separate tabs in the PDF/Image viewer. In order to do this,
you need the "Open documents in the Document Viewer using separate tabs" option
selected in the User Preferences.

2. Drag and drop an image from one tab to the other tab.

TO SAVE A PAGE AS AN IMAGE FILE (JPEG)
1. After modifying a PDF document in the PDF/Image viewer, go to File > Save Page As.

2. Save the current page to your local machine as a jpeg file.

14.3.3. Other Actions of the PDF/Image Viewer

TO PRINT A DOCUMENT

e Go to File > Print or click the Print button.

TO UNDOCK THE VIEWER
e Click the Undock Viewer button.

TO CLOSE A DOCUMENT IN A TAB
e Click the X in the tab or go to File > Close File.

NOTE: If you have the "Automatically open Document in Viewer" options selected in the User
Preferences, the documents are opened in a single pane as you scroll through the documents.
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15.ASSEMBLING DOCUMENTS

The assemble documents feature can be used to automatically construct new documents
based on the rules set in the assembly configuration.

A user must have a FileHold viewer level 2 or 3 in order to use the assemble documents
feature. This feature is only available in the FileHold Desktop Application (FDA). Any supported
file types can be used to merge documents together; they do not have to belong to the same
file type. The file types that are supported those supported by the FileHold level 2 and 3
viewers.

With the assemble documents feature you can:
e Create standalone documents

e Merge documents together. When merging documents, bookmarks are added to the PDF
for each file when merging files with document assembly. The bookmark name is the
document name.

e Append and prepend documents

e Use converter templates to populate certain field information (similar to the workflow covert
to PDF feature)

e  Output documents to PDF, PDF/A-1A, or PDF/A-1B

e Order the documents for assembly

¢ Rename the newly assembled document

e Create new documents for the FileHold library

e Check in as new version of an existing document

e Create a temporary document for viewing

e Apply PDF security options

e View the assembled document in the FileHold viewer post-assembly
e Initiate a workflow post-assembly

e Initiate a Courier transmission post-assembly

e Add watermarks from templates or ad-hoc. Up to three watermarks can be used per
document.

e Place merge tags into documents.

Documents are placed in queue and assembled on the FileHold server. A scheduled task “FH
process batch jobs” can control how often the batches are run. By default, the scheduled task
runs every 10 minutes.

Renaming a document in "Do not merge" mode is allowed when only one input document was
selected. If more than one document is selected, the document name and metadata for the
assembled document is taken from the first document selected.

Renaming and ordering of the documents is allowed in “Merge all documents to one” mode.
The metadata for the assembled document is taken from the first document in the document
order list.

Due to the number of variables with the assemble documents feature, it is recommended that
customers test the feature with their own documents in their FileHold environment. Note that
larger number of documents or larger file sizes take longer to assemble.
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Users can see their jobs in the Batch jobs report in the FileHold Desktop Application or in the
Web Client > Administration reports > Batch jobs. See Batch jobs report for more information.

Once the job has completed, the user receives an “Assemble documents batch job ready”
email with links to the batch job details or open the document in the viewer if the option was
enabled in the job settings.

FileHold notification - Assemble document(s) batch job re...

Help  FileHold  Q Tell me what you want to do

& x ’— aReply m [ FileHold Voo O ":I € MarkUnread | 1 Q
GaReply All | |3 To Manager . g = i Categorize -

e Delete Archive L_" = By~ _-i‘ o anage Move f Assign —~ gort Editing Zoom

S (3 Forward = Team Email - - EP- policy- > Followup- -

Delete Respond Quick Steps Move Tags N Zoom ~

Tue 2018-04-03 11:35 AM

FileHold notification - Assemble document(s) batch job ready

We are sending this email because batch job Assemble document(s) (1013) has been successfully processed and
is waiting for your further actions

You can execute post-process actions or check job details by selecting one of the following links:

Open with WebClient

Open with FDA

TO ASSEMBLE DOCUMENTS
1. Select the documents that you want to assemble. They do not have to be the same file type.

2. Do one of the following:

e Click Assemble t’ in the toolbar.
¢ Right-click and select Publish As > Assemble to PDF.
3. Inthe Input tab, select one of the following options:
e Do not merge documents — This option is enabled if only one document is selected.

e Merge all documents into one — This option is enabled if more than one document is
selected.

4. If the Merge all documents to one option was selected, click ... in the Order Documents field
to set the order of the documents for the merging.

¢ In the Order documents window, enter the output document name. Note that the newly
assembled document copies the metadata from the first document in the list.

e In the Order column, click in the row to set the order of the documents.

e Click Close when done.
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Order documents X

Qutput document name Agenda for March 13, 2018
Order Version Id Name Approval status
1 v | 18 PDFconverter-diagram Not submitted for approval

25 test2 Not submitted for approval

2
’ > » 1-2of 2 items
Click Next.

In the Output tab, select one of the following options:
e Create new document(s)- Click ... to select a library location for the document.

o Create temporary document(s) for viewing — Opens the document in the FileHold viewer.
Documents can be modified in the viewer prior to saving.

e Check in as new version — To check the input documents as a new version, leave option as
“Input document”. Alternatively, click ... to select a document from the Checked Out
Documents list.

7. In the Output file format field, select one of the following options:

. PDF
« PDF/A-1a
« PDF/A-1b

NOTE: PDF/A formats are direct conversions from the source documents. They will need to be
independently verified as fully PDF/A compatible.

8. Click Next.
In the Assembly options tab, enter the following options:
e Append page(s) from template — Click ... to select a document from the library.
e Prepend page(s) from template — Click ... to select a document from the library.

e Process tags in input documents — Select the check box if the input documents contain
tags that should be processed. Tags allow information to be inserted into a document. See
Using Template Tags when Assembling Documents for more information.

e Set the template opening tag delimiter — Enter the opening tag delimiter for the PDF
converter template. By default, this is [[.

e Set the template closing tag delimiter — Enter the closing tag delimiter for the PDF
converter template. By default, this is ]].

Set the template tag field delimiter — Enter the field delimiter. By default, this is |.
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10. Click Next.
11. In the Watermarks tab, do the following:

e Select a watermark template for the Top, Bottom, or Center of the document. Watermark
templates are created by an administrator. Watermark templates are available if the
optional workflow feature has been purchased. See the Library Administration Guide for
more information.

e Create a custom watermark. See Creating custom watermarks for more information.

12. In the PDF options tab, select any of the following options:
e Allow printing - Allows printing of the document. Enabled by default.
e Allow high resolution printing - Allows high resolution printing. Enabled by default.
e Allow changing the document - Allows changing the document. Disabled by default.
e Allow content copying - Allows copying the content. Enabled by default.

e All content accessibility enabled - Allow accessibility software to use the document
contents. Enabled by default.

e Allow document assembly - If this is disabled, inserting, deleting or rotating pages, or
creating bookmarks and thumbnails is prohibited. Disabled by default.

e Open password for main documents - Specifies the password required for opening the
encrypted PDF document. This can be left blank.

e Open password for embed documents — Used with the embed merge tag. This prompts a
user to enter a password it they attempt to open an embedded document.

13. Click Next.
14. In the Actions tab, select any of the following options:

e Open finished document(s) in viewer — Select the check box to view the newly assembled
documents in the FileHold viewer.

e Initiate workflow — Select the workflow template name from the list to initiate a workflow
post-assembly.

e Initiate Courier transmission — Select the Courier template from the list to initiate a Courier
transmission

15. Click Next.

16. In the Summary tab, review the selected options. Click Previous to change any of the
settings.

17. Click Assemble.

18. A message “Assemble document(s) (job number) job has been successfully initiated appears.
The job status, queued time, batch job name, and user name is displayed.

19. To cancel the assemble job, click Cancel job.
20. To pause the assemble job, click Pause job.
21. To review the job settings, click Details.

22. After the processing is complete, click Complete user actions to view the document in the
FileHold viewer.

23. To close the window, click Close.
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15.1.

TO VIEW THE DOCUMENT ASSEMBLY JOB

1.

Right-click on a document that was included in the PDF assembly and select Publish As >
Open batch job.

2. One of the following actions may occur:

If the batch processing has completed, the document opens in the viewer if the option was
enabled in the job settings.

If the batch processing has not completed, the Batch job manager opens where you can
cancel, pause, or view the details of the batch job.

3. Click Close.

CREATING CUSTOM WATERMARKS

Users with the document assembly feature can create a single ad-hoc custom watermark. Up
to 3 watermarks (custom and templates - one per position) can be used with document
assembly.

TO CREATE A CUSTOM WATERMARK TEMPLATE

1.

Select the documents that you want to assemble. They do not have to be the same file
type.

Do one of the following:

Click Assemble t’ in the toolbar.
Right-click and select Publish As > Assemble to PDF.

G

In the Edit custom watermark screen, design the watermark:

In the Watermarks tab, click Edit custom watermark

Select the Position: Top, Center -45°, Center, Center 45°, or Bottom.

Select the Font style.

IT.

Select the text size in pixels

A .
Select a colour for the text === . Select a colour from the colour picker or enter a Hex colour
value.

Select a colour for the background ' Select a colour from the colour picker or enter a
Hex colour value. Click & for a clear background.

Select a justification: full, left, center, or right.

Select an opacity in percent % Q.

Enter the content for the watermark. For example, “DRAFT — DO NOT COPY”. Tag fields
can be used to insert certain FileHold content. See Using tags when assembling
documents for more information.

Using the Margin area, determine the position for the watermark. The position of the
watermark is relative to the margin, so if using “Top’ position it is the top margin, not the top
of the page unless the margin is 0. Inches or centimeters (cm) can be used.
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15.2.

5. Click OK.

6. Toremove the custom watermark, click X in the Watermarks tab.

USING MERGE TAGS WHEN ASSEMBLING DOCUMENTS

Merge tags can be strategically placed within a Microsoft Word document to insert information
into the assembled PDF document. Information such as metadata field values, system
information, and workflow information can be inserted into the newly generated document.

Tags can be used to “build” documents, such as an agenda. The tags can link to other
documents into FileHold using their FileHold ID. For closed items, embedded documents or
embedded and password protected can be added. Text from one document can also be
inserted directly into the template document.

Tags can also be used with watermarks to insert information into the assembled PDF
document. Information such as metadata field values, system information, and workflow
information can be inserted as a watermark into the newly generated document. Tags can be
used in watermark templates and with custom watermarks. For more information on watermark
templates, see the Library Administration Guide. Tags can also be used to build the contents of
a document using merge tags. Documents can be linked, embedded, or expanded in the
source document.

The ability to link metadata and system values using merge tags to document properties in a
Microsoft Word document is available. When the document is assembled, the current metadata
values are displayed in the resulting PDF.

For more details about merge tags, see the Knowledge Base.

16.BATCH JOBS REPORT

The batch jobs report displays a list of the documents that were constructed using the
assemble documents or export scripts features. In the report you can view the status of the
batch job and pause, cancel, or view the details of the job.

Only the last 7 queued days is visible. Users can view only the jobs they have added to the
batch queue unless they have an administrator role.

TO USE THE BATCH JOBS REPORT

1. Do one of the following:

)
» Inthe FDA, click the Batch jobs icon @

e Inthe Web Client, go to Administration > Full Administration Menu > Administration
reports > Batch jobs.

2. The following batch job information is displayed:

Column Description
Batch ID The batch number
Queued time The dat(_e and time the documents were submitted for batch
processing
Start time The date and time the documents started to be processed
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Column

Description

Status

Statuses include:

Queued — Job is added to queue
Paused — Job has been postponed by user
In progress — Job is being currently processed

User action pending — Job processing is done but waiting for user
actions to be performed such as view document in FileHold viewer

Complete — Job processing is done and there are no user actions to
perform

Cancelled — Job has been cancelled by user

Error — An error occurred during job processing

User name

The user who submitted the batch job to the queue

Batch job name

This value is always “Assemble document(s)”.

End time

The date and time the batch processing completed.

N o g s~ w

User Action.

To view the batch job details, double-click on the row.

To cancel the assemble job, click Cancel job.

To pause the assemble job, click Pause job. To resume a paused job, click Resume.
To review the job settings, click Details.

To view the document in the FileHold viewer (if the option was enabled), click Complete

8. To close the window, click Close.

16.1. HOW TO MANIPULATE THE BATCH JOB REPORT VIEW
The batch jobs report can be modified to add or remove columns, resize or change the order of
the columns, sort ascending or descending, filter the results, and save these different views.
The displayed information can be exported out of the system in order to do further analysis on
user accounts.
Function Description
Sort Click on the column header to sort ascending or descending.
ascending/descendin :
g Alternatively, click ® in the column header and select Sort
Ascending or Sort Descending.
An up or down arrow shows in the column header indicating the sort
order.
écc)ilﬂr(r)]:];emove Click # in the column header and select Columns. Select the check
boxes for the columns to be displayed. Clear the check boxes to
remove the header.
<L
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Function

Description

Resize columns

Hover the cursor between the column headers to resize a column.

}  Email address @er statu_..

Filter

Click ® in the column header and select Filter. Select the filter
options and click Filter. The filter options available depend on what
type of column is selected.

A white filter icon is shown in the header if the column is

being filtered.

To clear the filter, go to Filter and click Clear.

Change column
position

Drag and drop columns to the desired position.

Group by a column

Drag and drop a column header to top blue bar that says “Drag a
column header and drop it here to group by that column”.

To remove the grouping, click the X next to the header name in the
blue bar.

3 Swnume i seus b Username

M08 10SAM Finishe
31372018 1104 A ed

ed Assembie &

" Finishe Assemble o

31372018 939 Al Finished Drag and drop column fssemole o

31302018 9.38 AM Finished header {o biue bar to S o
group by that column

19208 938 AM complete assemoie o

31372018 8:53 AM

Scroll through pages

In the bottom left corner, use the scroll settings to:
¢ Go to first page

e Go to previous page

e Go to next page

¢ Go to last page

e Adjust the number of items per page: 15, 30, 60

4 | I 30  w  items per page

Refresh screen

Click Refresh in the bottom right corner.

1- 11 of 11 items
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17.SETTING PREFERENCES

Preferences and Settings allows you to modify the document management system to suit your
personal needs. You can modify your password, document list views, document alerts,
workflow (if purchased), and FastFind preferences (if purchased).

Some, none, or all of these settings may be determined and/or enforced by your system
administrator. See your system administrator for details.

TO SET PREFERENCES
1. Do one of the following:
e InFDA, goto File > Preferences and Settings.

e In Web Client, right-click on My FileHold to access View, Alert and User preferences.
Right-click on Reviews & Approvals to access the Workflow preferences.

¢ Inthe Web Client, go to Administration Panel > My FileHold.
2. Set the following preferences:

e View Preferences

e User Preferences

e Alert Preferences

o Workflow Preferences

o FastFind Preferences (FDA only)

o Reset My Password (Web Client only)

17.1. USER PREFERENCES

The User Preferences allows you to edit your contact and password information. This includes
the users account information, contact information, company information as well as default
language preferences.

The General tab contains user’s account setting information. The Contact and Company tabs
contain user contact and company information respectively. The Advanced tab allows the user
manage the functionality of the system. Some, none, or all of these settings may be
determined and/or enforced by your system administrator. See your system administrator for
details.

TO SET THE USER PREFERENCES

1. In FileHold Desktop Application (FDA), go to File menu > Preferences and Settings >
User Preferences.

¢ Inthe Web Client, right-click on My FileHold and select My User Preferences.
e Inthe Web Client, go to Administration Panel > My FileHold > User Preferences.

2. The General tab contains the user account information. Use the following table to fill out
the information in the General tab:

Field Name Description

First Name Your first name.
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Field Name

Description

Last Name

Your last name.

User Logon Name

You are not able to modify your user name in
the User Preferences. Contact your system
administrator if you need to change your user
name.

Source

Local FileHold account or a domain account
(synchronized with Microsoft Active Directory).

Default Language

Select the default language. This is typically
English. If the language you want is not
available, please contact your system
administrator and ask them about obtaining
additional language packs from FileHold
Systems.

Time zone

Select a time zone. By default, this is set to the
time zone of the local computer.

Default page after log in (Web Client
only)

Determines the window that is displayed after
log in: Blank, Simple Search, Advanced Search,
My Tasks, or Dashboard (if permitted. See your
system administrator for details).

Edit metadata upon Check In Action
(Web Client only)

When enabled, the metadata pane is displayed
in edit mode after a new version is checked in.
This allows the user to enter new metadata. If
disabled, the user can check the document back
in without editing metadata.

Clear required metadata fields upon
Check In (Web Client only)

When enabled, any required fields in the
schema are automatically blanked out (current
value is deleted) when checking in a new
version of a document. The users are forced to
fill in the required field prior to checking in the
document.

Number of expanded drawers (Web
Client only)

The number of drawers that can be
simultaneously expanded in the library tree can
be set. The lower number of expanded drawers
allows for a faster page loading time due to the
lower number of permissions that needs to be
calculated before displaying the library structure
to the user. The last drawers that were opened
by the user are preserved when the library is
refreshed. The default is 3.

Short date format

Set the short date format. Options include:

o Midlyyyy
e dd/MM/yyyy
e yyyy-MM-dd

e Default — Set by your system administrator

See the Date and Time Format Identifiers table
in the Knowledge Base for more information.
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Field Name Description

Long date format Set the long date format. Options include:

e dddd, MMMM d, yyyy

e dd MMMM yyyy

e MMMM d, yyyy

o Default — Set by your system administrator

See the Date and Time Format Identifiers table
in the Knowledge Base for more information.

Short time format Set the short time format. Options include:
e h:mmtt
e HH:mm
e HHmMmM

e Default — Set by your system administrator

See the Date and Time Format Identifiers table
in the Knowledge Base for more information.

Long time format Set the long time format.

e h:mm:sstt

e HH:mm:ss

e HHmmss

e Default — Set by your system administrator

See the Date and Time Format Identifiers table
in the Knowledge Base for more information.

Reset all “Don’t Show This Message If you have selected any “don’t show this
Again” reminders (Web Client Only) message again” check boxes in various
windows, you can have them reappear by
clicking Reset.

Change Password (FDA only) Click Change Password to change your
password if you are using a locally-managed
account. In the Set Password, enter your old
password and a new password twice and click
OK. NOTE: If you are using a domain user
account (Active Directory), you are not able to
change your password. See your system
administrator.

Default Local Working Folder (FDA only) | This is where your working documents are
stored on your local machine. This is the path to
where documents are checked out and
downloaded. To change the path, click Browse
and select the new working folder location.

NOTE: For the Web Client, documents are
downloaded to the location that is set in your
web browser settings.
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3. Inthe FDA only, in the Advanced tab, select the settings you want enabled. NOTE: These
options may be locked down by your system administrator.

Field Name

Description

Default page at start-up

Determines the window that is displayed
after log in: Blank, Simple Search, Advanced
Search, My Tasks

Format of document imports

Select one of the following options:

e QuickScan Pro — select this option if you
are using the EMC Captiva QuickScan Prg
scanning software. or using the Dynamic

Import Format.

e Capture — select this option if you are
using SmartSoft Capture scanning
software.

¢ Both — select this option if any users could
be using both QuickScan Pro and Capture
at the same scanning station, for example
sharing inboxes and imports, or using the
Outlook Watched folder and Capture at
this computer.

If you are using the “Both” option, ensure
that folder you select for the import profile
contains only one type of XML files. The rule
also applied for any of its subfolders.
Capture and QSP XML files cannot coexist
in the same folder tree.

Number of expanded drawers

The number of drawers that can be
simultaneously expanded in the library tree
can be set. The lower number of expanded
drawers allows for a faster page loading time
due to the lower number of permissions that
needs to be calculated before displaying the
library structure to the user. The last drawers
that were opened by the user are preserved
when the library is refreshed. The default is
3.

Enable Click To Tag

When enabled, the Click To Tag button
appears in the metadata pane and allows
you to “click” or “rubber band” text, numbers,
dates, etc. on the screen and inserts the
value into the metadata field of the schema.

If disabled, the Click to Tag button does not
appear in the metadata pane.

Show Welcome Screen at Startup

Displays the FileHold Welcome Screen after
you start the FDA: Blank, Simple Search,
Advanced Search, Inbox, My Tasks, or
Calendar.

make copies of files

Prompt me for download location when |

Allows you to select a location on your local
machine to save your copied files.
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Field Name

Description

Prompt me for download location when |
check out files

Allows you to select a location on your local
machine to save your checked out files.

Prompt me to remove files when sending
them from the Inbox

A prompt asks you if you want to remove the
files from your local machine when sending
them from the Inbox.

Automatically clean up my working
documents

Documents in the working documents folder
are cleaned up automatically or with a
prompt message depending if the option
“Prompt before automatically cleaning up
user’s working documents” is enabled.

The working documents folder may
automatically be cleaned under certain
conditions:

e When the FDA is minimized to the system
tray.

e When the user logs out.

e \When the FDA detects it has been
disconnected from the FileHold server.

e When the FDA receives a message from
Windows to shut down.

Local files that are in use by another process
are not deleted and remain in the working
documents and are processed the next time
there is a trigger condition. Local files
associated with electronic documents that
are modified are not deleted. These files
should be managed using manual check in
or the working documents synchronization
tool. Once the documents have been
checked in / synchronized they are subject to
the automatic deletion rules.

See your system administrator for details.
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Field Name

Description

Prompt me before automatically cleaning up
my working documents

A prompt asks you if you want to remove the
files in your working documents folder. The
option “Automatically clean up user’s
working documents” must be enabled for this
option to work.

You may be prompted to clean up the
working documents folder under certain
conditions:

e When the FDA is minimized to the system
tray.

e When the user logs out.

e When the FDA detects it has been
disconnected from the FileHold server.

e When the FDA receives a message from
Windows to shut down.

See your system administrator for details.

By default close documents that | add/check
in to FileHold

Documents are closed in their native
application when it is checked in or added to
the Library.

By default delete documents that | add to
FileHold

Documents are deleted from the working
folder on your local machine after they are
added to the Library.

By default delete documents that | Check In
to FileHold

Documents are deleted from the working
folder on your local machine after they are
checked into the Library.

Auto-send documents to Auto-Tagged
folders

Documents in the Inbox are automatically
sent to their location in the Library if the
folder is Auto-tagged. You do not need to
click the Auto-File button.

Auto-send documents after completing
metadata

Documents in the Inbox are automatically
sent to their location in the Library after the
metadata has been sent. You do not need to
click the Send or Send All button.

Move to recycle bin instead of permanently
deleting

Documents that are set to be deleted after
checking in or adding to the Library are
moved to the Recycle Bin on your local
machine instead of being deleted.
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Field Name

Description

Enable Smart Check In and Smart Check
Out messages

Smart messages are the messages that
appear when checking in and out a
document using Microsoft Office
applications. This setting is enabled by
default. To turn off "Smart Messages", clear
the check box. Examples of smart messages
that are displayed in Microsoft Office
applications from FileHold are:

e When saving and closing a document
without checking in a checked-out
document.

e When getting a local copy of a document,
making edits, and saving without checking
out the document.

e When checking out and opening a
document and close the document after
making no changes.

e When opening and checking out a
document (CTRL+double-click) and closing
the document without making any changes.

Edit metadata upon Check in action

When enabled, the metadata pane is
displayed in edit mode after a new version is
checked in. This allows the user to enter new
metadata. If disabled, the user can check the
document back in without editing metadata.

Clear required metadata fields upon Check
In

When enabled, any required fields in the
schema are automatically blanked out
(current value is deleted) when checking in a
new version of a document. The users are
forced to fill in the required field prior to
checking in the document.

Reset all “Don’t Show This Message Again”
reminders

If you have selected any “don’t show this
message again” check boxes in various
windows, you can have them reappear by
clicking Reset.

4. Inthe Viewer tab (FDA only), select the check boxes next to the features to enable.
NOTE: These options may be locked down by your system administrator.
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Field Name

Description

PDF/Image viewer only

Enable the This viewer is end-of-life and is disabled by default. Transition to the FileHold
old FDA viewer as soon as possible.

PDF/Image

viewer.

Orientation Select the position of the thumbnails in the PDF/Image viewer: Top, Bottom,
of thumbnail | Right or Left.

view

PDF/Image viewer and Brava viewer

Automatically

Any selected document in the Inbox opens in the Viewer automatically. If this

open in the option is selected, only one tab is opened at a time. This prevents users from
Viewer opening several tabs at a time and using up a lot of system memory in the
selected process.
?ocument N | NOTE: Starting in 2017, Brava viewer licenses are no longer available for
nbox ; . . .
new FileHold purchases. Previously purchased Brava viewer licenses are
still available for use in the FileHold Desktop Application.
Open Documents are opened in multiple tabs in the viewer. NOTE: This option
documents in | cannot be selected in conjunction with the "Automatically open in the Viewer
the selected document in folders and search results" or "Automatically open in
Document the Viewer selected document in Inbox" options.
Viewer using
separate
tabs
Allow A single document can be opened several times in multiple tabs using both
opening one | Brava and PDF/Image viewers. Note that "Open documents in the Document
documentin | Viewer using separate tabs" needs to be enabled in order to enable this
multiple tabs | feature. This feature is useful in multiple monitor situations.
All viewers

Automatically
open in the
Viewer
selected
document in
folders and
search
results

Any selected document in the folder view or search results opens in the
Viewer automatically. If this option is selected, only one tab is opened at a
time. This prevents users from opening several tabs at a time and using up a
lot of system memory in the process.

5. In the Font Scaling tab (FDA only), set the font scaling factor for several panels in the
DMS cockpit. You can adjust the font size from 80% to 200% for the library panel,
documents lists, metadata and file properties panel, and the batch jobs panel. These
values can also be adjusted indirectly by moving the cursor to the panel you want to scale
and holding the CTRL key while performing a scroll gesture on a mouse or trackpad.
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6. Inthe Contact Information tab, enter your personal contact information. This is for both the
FDA and the Web Client. This information may be filled out if you are an Active Directory
user.

7. Inthe Company tab, enter your organization information. This is for both the FDA and
Web Client. This information may be filled out if you are an Active Directory user.

8. Click OK.

17.2. VIEW PREFERENCES

You can create or modify “views” in order to suit how you want documents displayed. There
are several different view types, such as the folder list, checked-out documents, Inbox,
Document Tray, and so on. You can customize each view to display specific columns and
determine how you want the view sorted and grouped. The views can be made private or
public which allows other users to access them. Users can also set a default view which
displays the documents according to the default type unless otherwise specified. Changes to
your view settings does not affect how other users view their folders or lists.

The following is an example of a folder list view. You can change your view type by selecting
an option from the Select View drop-down list.

- Product Development/ Guides/User Guide Select View: | My Personal View

.;I‘}:. & f ] 7 Default View
Document Name Type Linked Ver Status Last Modified On i My Personal View

e @_] FileHold_EndUser_Guide_v09  Quality Assurance 1] 1 Checked Out  14/03/2011 4:06 PM

7 B ¥ p.0.-5auve_FileHol_17032011 Test 0 1 cChededIn 17/03/2011 3:58 PM Edit

7 B B p.0.-ysadm_Self-Se_07042011 Test 0 2 CheckedIn  07/04/2011 10:07 AM Edit

7 B ] p.0.-ysadm_Use of _06042011 Test 0 1 CheckedIn 06/04/2011 3:46 PM Edit

The benefit of customizing the views is that the user is able to see key information on a file
without having to open up the file or view its metadata. For example, if a user is working in an
engineering department and the majority of documents to be stored in the library have a 'Part
Number' metadata value associated with it, then the part number field can be added as a
column in the user’s folder display.

The number of documents that are displayed per “page” is set in the view preferences. In the
FDA, there can be 5 to 1000 documents displayed per page. In the Web Client, there can be 5
to 30 documents displayed per page. The page numbers are shown in the right-hand top and
bottom areas of the screen. The number of documents that are shown in the FileHold Office
Client window when using the Microsoft Office Add-Ins can also be configured.

- Training and Support/FileHold 14/ Training Materials Select View: My Personal View

1234

Document Name Document Schema Linked Ver v Status Last Modified On

2 Document Schema: Application (2 documents)
7 @ ',E travelauth Application a i Checked In ~ 12/172015 3:33 PM Edit
i %@ [] 9371 Application 1]

Checked In  12/172015 3:34 PM Edit
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| | | 3 My Personal View » Ll o)

Training and SupportiFileHold 14/Training Materials L7 Add File to Folder

Document name
¢ @ [H 13112008232

< @ [H 131120
;@ [E 131206

Document schema Linked Ver Status
Bicycle Manuals ] 1 CheckedIn

Schema with all md field types (1) 1 Checked In

Credit Card ] 1 CheckedIn

Library administrators can create views and set them as the system default for all users. They
can also reset the personal views of other users to a global view of their choice. They can also
assign default views to cabinets, folders, virtual folders, and saved searches.

View settings are exclusive to the user; however, Views can be made public allowing other
users of the document management system to use them if you are an Administrator. Changes
to one user’s view settings does not affect how other users view their folders or lists.

NOTE: If you are logged in as an Administrator and are modifying a Public View (such as
adding or removing columns), the document management software automatically creates a
new Personal view using the changes made to the existing Public view.

TO SET YOUR VIEW PREFERENCES

1. Do one of the following:

e In FDA, go to File > Preferences and Settings > View Preferences.

¢ In Web Client, right-click on My FileHold and select View Preferences.

e Inthe Web Client, go to Administration Panel > My FileHold > View Preferences.

2. In My Global View Preferences window, use the following table to fill out the form.

Field

Description

Select View Type

Select the view type you want to customize: Checked Out Documents,
Document Alerts, Document Reminders, Document Tray, Folder List,
Inbox, Linked Document List, My Favourites, My Workflow Tasks,
Recently Accessed, Recently Added, Search Results, Workflow
Documents (Show Documents pane), and Virtual Folder.

For example, Checked out Documents customizes the My FileHold >
Checked out Documents list. Inbox customizes the Inbox view.

Select View

Select a view from the list if it already exists for that view.

Add

Click Add to create new view. Enter a view name and select if it is a
Personal or Public view and click OK. A personal view is only visible to
you while public views can be seen by all users. Only Administrators
can create public views.

Edit

Click Edit to modify the name of the view. Rename the view and/or
select a view type (personal or public) and click OK.

Delete

Click Delete to delete a view. Click OK at the confirmation message.
The view is deleted.

Set as System
Default View

When logged in as Library or system administrator, you can add a new
System Default View for the system. When creating a new System
Default View, you must make the new view a Public view. Then click
Set as System Default View. Now all users see this view when
logging onto the system.
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Field

Description

Set as My Default
View

When creating a new view, you can set it as your own default view.
This view overrides the System Default View in any of the view types
that do not have a designated view applied to them.

Create My
Personal View

Create a personal view for a view type not seen by any other user such
as personal search view or personal virtual folder.

Current
Fields/Columns
used in this view

Lists all the column names, their descriptions, and the order they are
sorted across the screen.

To reorder the columns, select a number from the drop-down list.

To remove a column, click the X.

Add a field
(column) to the
view

Select a metadata or system value to add to the view from the list and
click Add Field.

Once you have added a field, you can sort the order of the columns in
the Order Column.

Sort view by Select the column you want to sort by from the drop-down list and
select if you want the documents displayed in ascending or descending
order.

Group by Select the check box and select how you want the documents grouped.

Select a descending or ascending order. This is only available in the
FDA. Adjust the number of documents per page as needed to increase
the usefulness of grouping.

In the example below, the documents are grouped by the
Classification (ps) metadata field:

I Professional Services/Active [PRI0O =

20

Results 1-7 of 7

Document Name Ver Linked LastEdited On FileHold ID

= Classification (ps): Customer sample - PPI (personal private information) (1 document)
W f.m Sample JDE screens 1 0

2024-08-23 5:58 PM  213326.1

= Classification (ps): Customer specification (5 documents)

vr €@ ! IDE FH INTEGRATION NOTES - SL 2 0 2024-08-235:57 PM 213576.2
i '. E JDE Fields for Payment Groups 1 0 2024-08-23 5:56 PM  213453.1
'. | RE_ FileHold_JDE Integration Design il 0 2024-08-23 5:55 PM 213577.1
l‘. E FileHold JDE Automation i 0 2024-08-23 5:54 PM  213454.1
¢ € YR FileHold JDE AP Payment JDE Integration SLU... 2 0 2024-08-235:52PM 213575.2
= Classification (ps): Deliverables - design/spec (1 document)

77 €@ I PRI0O; wa-JDE-integration-soln-design ... 3 0 2024-08-23 5:57 PM 213458.3

Show x items in

Enter the number of documents you want displayed in the Web Client.

this view (Web Enter a value from 5 to 30.
Client only)
Number of Enter the number of documents you want displayed “per page” in the

documents per
page — Main FDA
window (FDA
only)

FileHold Desktop Application. For example, if you have 4000
documents in a single folder, then 500 documents are shown on a
“page”. It is recommended that this value be set to 500.
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Field Description
Number of Enter the number of documents you want displayed “per page” in the
documents — FOC | FileHold Office Client window. It is recommended that this value be set
windows (FDA to 20.
only)

Select View Type: | R

Manage Folder List Views

Select View:

My Personal View - Add | Edit Delete |

This is your personal view. Itis selected as your default view,

Set as System Default View | Reset to System Default View | Create My Personal View |

Current Fields (Columns) Used in This View

ColumnName Column Description Order
! |Document Name A Document Name system field. 1 j
¢ |Document Schema A Document Schema system field. 2 j
Linked A Linked system field, 3 j
Ver A Ver system field, 4 j
Status A Status system field. 5 j
L |LastModified On A Last Modified On system field. [ j
0
\' Modify My Personal View:
Add  field (column) to this view  [Accepted / Refused >|  AddField |

Sort view by I\n'er

j in IDescending j order

v Group by IDocumentSchema j in IAscending j order

' Number of documents per page

' Main FDA window:

FOC windows:

ISU 3: (recommended values from 5-100)
IZU 33

oK. I Cancel | Apply |

3. Click Apply or OK to save the view settings.

17.2.1. Creating Ad-Hoc Views

You can modify any view by adding or removing columns, grouping documents, expand or
collapse groups, or reorder columns “on the fly”.

TO CREATE AD-HOC VIEWS

1. Inany view, right-click on a column header and select one of the following:

e Group By — Group documents by a system or metadata field that is included in the view.
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Nascumsant Srhama |
| Group by 4 Document Name
Add / remove columns 3 Document Schema D
Open view editor Linked
g Export grids to C5Y Ver D
e Status
A : Last Modified O
ide FileHolq = ™ec™edtn 0
File Size
= Type of Contract
FileHold—T® |

e Add/Remove Columns — Add or remove columns from the view. All system values and
metadata values can be added or removed from the view. All values with a check mark
beside the name are shown in the view. To add or remove the column, click on the field
name. The list of fields will remain displayed until you press ESC or click outside the list.
Use the cursor keys, the top or bottom scroll button, or the mouse or trackpad scroll
gesture if there are more fields than can be displayed on screen at one time.

Document Name
— 2 -~ !ZI Document Schema
Group by 3 Document Status - Drill

Add / remove columns  » Document Version

Open view editor Due Date

Export grids to CSV em Attachments
TITST TOTer T ooy
em CC

FileHold Prodd "™

em Subject

FileHold Prodd "™

Email Address

; Empl
e FileHold Prody ™%
Expense Code

- File Name
FileHold ProdL Flosine

. FileHeld Component
FileHold Prody "~ =

e Open view editor — This opens the Global View Preferences window. You can reorder the
columns in the Order column. See View Preferences for more information.

o Expand/ Collapse All Groups — This expands/collapses grouped documents. You can also
click the +/- sign next to the Group Name.

For exporting the document list to a CSV file, see Exporting Documents in a View to a CSV
File.

17.2.2. Showing the Review or Approval Status in the Folder View
Adding the Review and Approval Status field to a folder view allows the user to be able to tell
at a glance the state of approval for all documents contained in that folder.

These fields can be added (or removed) in all views including search results, my FileHold, or
any other list customizable with the user’s personal view preferences.

TO ADD THE REVIEW OR APPROVAL STATUS COLUMN TO A VIEW ON THE FLY
1. Right-click column header and select Add/Remove Columns.

2. Select Review Status or Approval Status from the list. The Approval Status is added as a
column to the view.
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TO MODIFY THE VIEW PREFERENCES TO ADD THE REVIEW OR APPROVAL STATUS COLUMN

1. Go to View Preferences and select the view you want to modify from the list.

2. Inthe Add Field drop down list, select Approval Status or Review Status and click Add
Field.

3. Click OK to save changes.

17.2.3. Setting the Default Cabinet Drawer, Folder Group, Virtual Folder, or Saved Search

17.3.

View

Cabinets, drawers, folder groups, virtual folders, and saved searches can have specific views
created and assigned to them so that the views are displayed in a certain way. Administrators
can create public views in the View preferences area and then assign the default view to the
search. Users can also do this for their "My Saved Searches" and “My Virtual Folders” using
personal views.

You can set a default view for a folder but it cannot be made default or forced.

TO SET THE DEFAULT VIEW FOR A CABINET, FOLDER, VIRTUAL FOLDER, OR SAVED SEARCH

1. Create a new view to be used. For folders, cabinets, public saved searches and public
virtual folders, administrators need to create a public view. For personal saved searches
(My Saved Searches) end users can create personal views. See View Preferences for
more information.

2. Right click on the folder, cabinet, virtual folder or saved search name and select Set
Default View.

3. Select the view you want to use from the drop-down list. To use the global default view,
select the Use global default view check box.

4. To make this the default view all users, select the Make it the default setting for all
users check box.

5. To enforce the use of this view for this saved search, select the Reset all users to use
this default setting check box.

6. Click OK to save your settings.

ALERT PREFERENCES

You can set alert preferences so that you are notified when a change occurs to a document or
folder. You can view alerts in My FileHold > Document Alerts and/or receive an email alert, if
your system has been configured. In order to receive an alert, you must have set an alert on a
document or folder. See Setting Document Alerts and Reminders for more information.

The alert preferences allow you to determine which type of change you want to be notified of,
such as a document addition, change to metadata, or when a file is checked. Users can also
be notified via email and alerts of specific date-based events call user defined events. For
example, policies must be updated or reinstated at least once every three years. The policy
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17.4.

team would like to review the documents 60 days before the three-year anniversary. The event
can be set up so that every three years, the owner of the policy is notified 60 days prior to the
policy expiry date. User defined events are set on the document schema by the library
administrator. For more information, see the Library Administration Guide.

Some, none, or all of these settings may be determined and/or enforced by your system
administrator. See your system administrator for details.

TO SET ALERT PREFERENCES
1. Do one of the following:
e In FDA, go to File > Preferences and Settings > View Preferences.
e In Web Client, right-click on My FileHold and select View Preferences.
e In the Web Client, go to Administration Panel > My FileHold > View Preferences.
2. In the My Alert Setting window, select the following folder alert options:
¢ New documents/versions are added to folders | have subscribed to.
e Documents are transferred to folders | have subscribed to.
e Documents are deleted from folders | have subscribed to.
3. Select the following File (document) alert preferences:
e A new version of a document | have subscribed to is checked-in.
o Metadata values are updated for a document | have subscribed to.

4. In the Email Alert Preferences, select the check box if you wish to receive an email in
addition to displaying alerts in the My FileHold > Document Alerts area.

5. Enter the email address that the alert should be emailed to.
Select an alert frequency:
e Send email immediately — Sends the email as soon as the change is made.
e Send a daily summary — Sends the email once per day with a summary of all the alerts.
e Send a weekly summary — Sends the email once per week with a summary of all the alerts.

7. Inthe Reminders area, select the Send email... check box to have reminders emailed to
the specified account.

8. Select an email reminder frequency:
e Send email immediately.
e Send a daily summary.

9. Click OK.

WORKFLOW PREFERENCES

You can set preferences to be notified via email when certain workflow events involving you
occur and delegate your tasks to someone else if you are away from the office for a period of
time. See the Workflow and Courier Guide for more information.
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17.5. FASTFIND PREFERENCES

FastFind provides search capability from third party windows-based forms applications such as
Windows Desktop Applications such as accounting or GIS software. FastFind works in
conjunction with the FileHold Desktop Application (FDA). Users can use keyboard shortcut
shortcuts that perform searches directly from the chosen application in the document
management system to find relevant data instantly.

FastFind is relatively easy to set up and use by most users with some basic instructions;
however, FastFind can be leveraged to perform a more dynamic search of the document
management system by someone who can work with regular expressions. You can also set up
FastFind templates to improve your searches from various third-party applications.

For example, a search in a Microsoft Word document for the term “FastFind” using the shortcut
key CTRL +D, returns the search results in the FileHold Desktop Application. In the example
below, there are 97 results found.

Advanced Search Hide Advanced '@"

File or Metadata ¥ | Contains ‘ E Search

[7] search Metadata Only [ Indude Archivein Search  [—] Indude All Document Versions [~ Search Using Historical Metadata Fields

/.. Search Results 1-97 of 97 Select View: | Default View
[/ % % 1 =7 Save as Saved Search Highlight Results 7]
Document Name Location Type Linked Ver Status o
7 @ [= Invoices for October 2010 Product Development f General f LGBS - Invoice... Project Management 0 1 Checked In
7 @ = Invoice for November 2010 Product Development / General / LGES - Invoice... Project Management 1} 1 Checked In
1 =

7 @ = Invoices for December 2010 Product Development / General / LGES - Invoice... Project Management 0 Checked In

FastFind searches can be based on a full text search (file and metadata search) or a quick
search. If based on a quick search, it searches on that specific search parameter and nothing
else in the system (unlike a full text search which searches through everything). Advantages of
using up a quick search with FastFind would be to be able to limit the search results. For
example, if FastFind was only used to locate an invoice in FileHold from your accounting
software, the search results would be limited to what documents would be found using “Invoice
Number” quick search. See Quick Searches for more information on configuring quick
searches.

NOTE: FastFind preferences can only be set in the FileHold Desktop Application. It cannot be
set in the Web Client.

Some, none, or all of these settings may be determined and/or enforced by your system
administrator. See your system administrator for details.

In order to use FastFind, you must purchase this optional feature. Contact sales@filehold.com
to purchase the FastFind module.
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My FastFind Preferences ? ¥

Enable FastFind [] Update FastFind templates when 1 log in to FilsHald
Enable mouse search Alt+5

Enable selection search Ctrl+D

Enable Clipboard search Alt+C

Enable screen OCR. search Alt+F

Searchusing:  (®) File and metadata

() Quick search

Shortcut Summary

Name Description Last Modified Date Last Modified By

Cancel Apply

To SeT THE FASTFIND PREFERENCES

1.

5.

In FDA, go to File > Preferences and Settings > FastFind Preferences. NOTE: These
options may be locked down by your system administrator.

To enable FastFind, select the Enable FastFind check box.

To have the FastFind templates updated when you log onto the document management
system, select the Update FastFind templates... check box. Read more about FastFind

templates.
Select the check boxes for the following shortcut key options:

Mouse Search (Alt + S) — Activates an on-the-fly screen scraper. When this is done a
green bar appears in the bottom-left corner of the user’'s desktop screen. Users can now
start moving their mouse over screen form objects such as data fields or field labels. The
text under the current mouse position is captured and displayed in the green bar. If a user
wishes to search with the captured text, they may left click to invoke the FileHold search.
This initiates the Full Text and Metadata search in FileHold and the search results are
displayed within the standard search results screen. Pressing the ESC button at any time
stops the mouse search mode.

Selection Search (Alt + D) — Highlighting a word or string or partial string in a third party
application and pressing Alt+D initiates a Full Text and Metadata search and display results
within FileHold application.

Clipboard Search (Alt + C) — This uses a 2-step process to search for documents in the
Library. First, you copy any text from the screen to the Windows clipboard using traditional
“Copy” menu option or the Alt+C shortcut available in most Windows applications. Next,
press Alt+C to use the contents of the Windows clipboard to activate a Full Text and
Metadata search in FileHold. Since FastFind uses the contents of the clipboard, any string
or partial strings can be copied to the clipboard and searched upon.

Enable screen OCR search (Alt + F) — Allows you to do a search based on the Click to Tag
functionality. Once the shortcut key is invoked, you can click on the text on the screen or
draw a bounding box (rubber band) around the text. Then a search is performed in FileHold
to meet the selected criteria from the screen.

In the Search using area, select one of the following:
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e File and metadata — Searches document name, metadata, document contents and file
properties

e Quick search — Searches for only the quick search parameter. Click ... to select the quick

search. To learn how to create a quick search, see Quick Searches.

6. To activate FastFind templates, select the check box next to the template name. Learn
more about creating FastFind templates.
7. Click OK.

17.5.1. Changing the FastFind Keyboard Shortcuts

17.6.

You can change the predefined keyboard shortcuts to a different shortcut key. You would do
this if the default FastFind shortcut key conflicts with another preset shortcut key in the
application that you are doing the searching from. For example, you can change the mouse
search shortcut to Shift + F3 instead of using Alt+S.

TO CHANGE THE SHORTCUT KEY

1. In FDA, go to File > Preferences and Settings > FastFind Preferences. NOTE: These
options may be locked down by your system administrator.

2. Click the keyboard shortcut type you want to change (mouse search, selection search, or
clipboard search).
3. Inthe Change Shortcut screen, change the default keyboard combination and click OK.
My FastFind Preferences 7] x|
™ Enable FastFind ™ Update FastFind templates when I log in ta FileHald
™ Enable mouse search Alt+5
™ Enable selection search Chrl+Dr
[ Enable Clipboard search Ale+iC * Click shortcut to change it

™ Enable screen OCR search Ale+F

Change shortcut b
J B Shaorbouk Summary
Select new shortcut
Last Modified By
I shit I cul ¥ ar |F =l
ak. | Cahicel |

RESET MY PASSWORD (WEB CLIENT)
A locally managed user (non-Active Directory user) can change their password at any time.
This section describes the process on how to change a password via the Web Client.
To change your password in the FileHold Desktop Application, go to the user preferences.

Note: If FileHold is synchronized with Active Directory, this option is not available. See your
system administrator to change your password if using Active Directory.

TO CHANGE YOUR PASSWORD USING THE WEB CLIENT
1. In Web Client, right-click My FileHold and select Reset My Password.

2. Enter your current password.
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3. Enter your new password twice.

4. Click Update. The new password takes effect next time that you log in.
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18.WORKING DOCUMENTS

FileHold makes managing the documents that users have downloaded to their local machine
easy. These "working documents" can be ones that have been checked out of FileHold for
editing or downloaded as local copies for local reference.

When the user wants to clean up the files that they have downloaded or checked out to their
local machine they can do so by logging into the FileHold Desktop Client and using the
Working Documents tool.

You may be prompted to clean up your working documents when the following occurs:
o When the FDA is minimized to the system tray.
e  When the user logs out.
* When the FDA detects it has been disconnected from the FileHold server.
e When the FDA receives a message from Microsoft Windows to shut down.
e When a user exits the FDA.

The Working Documents window displays the contents of the default "local folder"*. It lets
users know if the file has been checked out, the local version number and whether it is the last
version located in FileHold. This information helps users decide what action to take for each
file.

NOTE: The "local folder" is the "My FileHold Documents” folder that is automatically created by
FileHold when it is installed on a local computer. This is typically under /My Documents/My
FileHold Documents folder.

In order to see documents that a user may have downloaded to folders other than the default
folder, the user can clear the Show my local working folder only check box setting. The list
of all documents that a user has downloaded or checked out appears.

9

| Show my local working folder only (C:\Users\renee\Documents\My FileHold Documents) @
Local File Path Local Version Last Version Status Modified
DEF Co Contract.docx 1 Yes CheckedIn  No
| | parksnrec contract.pdf 1 Yes CheckedIn  No
Terms and Conditions for Professional Services. pdf 1 Yes Checked Out No
Synchronize Local Files with the FileHold Library ? X

This utiity wil synchronize files you have stored on your local computer with files stored in the FileHold lbrary. It does thi
| machine are older, newer or the same as the ones stored in the FileHold server. By selecting a synchronization option an|
‘ wil be able to view and select exactly which fies wil be processed.

Select a Synchronization Option >~

Select a Synchronization Option
Get newer version of fles from the library

Check-in files I have updated local Cancel
Remove duplicate or older fies that I have on my local computer

o] =

Users can then select files one at a time or in groups and using the Synchronize button at the
bottom of the results screen, choose which local folder(s) clean-up function they would like to
perform. Users have 3 functions to select from:
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Get newer version of files from the library —Downloads a more recent version of a
document from FileHold to the local folder when the version on FileHold is newer than the
one in the local machine.

Check-in files that | have updated locally — Checks in files that users have updated locally
but not yet returned to the library.

Remove duplicate or older files that | have on my local computer— Checks for files that are
duplicated or are older versions of documents that have newer versions available and
deletes them from the local folder.

The Working documents list can be accessed when users are disconnected from the server
and working offline, however they are not able to synchronize the files until they are again
hooked up to the server. This means that they may not have access to the very latest version
of a document or that any updating that they do to a document offline has to wait until they are
reconnected to the server to be updated in FileHold.

Working documents may automatically be cleaned up without any user intervention depending
upon what has been configured. Some clean up settings in be configured in the User
Preferences. See your system administrator for details.

TO ACCESS THE WORKING DOCUMENTS TOOL

1.

2
3.
4.
5

Open the FileHold Desktop Application.

Select Tools > Working Documents. The list of working documents appears.
Click Synchronize.

Select from the options outlined above and click Preview.

Follow the prompts and click OK.
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19.WATCHED FOLDERS

Watched folders is a tool available in the FileHold Desktop Application. Watched folders create
a kind of direct line from a folder local on the local computer or network to FileHold. It allows
users to drop documents into this specific folder location in which FileHold “watches” and
uploads to the FileHold library automatically.

Users can create as many watched folders as they need. Extraction rules and auto-filing can
work with the Watched Folders tool. Using the extraction rules and auto-filing features require
the Automatic Document Importation (ADI) feature to be enabled in the license. Extraction and
auto-filing rules are configured by a library administrator or higher role.

If you are a library administrator or higher role, auto-filing templates, auto-filing scripts, or the
auto-filing rule applied to the document schema can be used. For non-administrators, the auto-
filing rules use the schema default.

Users have the option of setting specific schema and metadata values for the incoming
documents or use extraction rules. If using extraction rules, the schema and metadata is
determined according to the rule. If both extraction rules are configured on the schema and
values are set in the watched folder properties, the watched folder values overwrite the
extraction rule values.

If there are missing required metadata fields or the file path cannot be resolved, documents go
the user’s Inbox for processing.

TIP: If scanning with SmartSoft Capture, use the Manage Imports tool.

NOTE: The following file types cannot be brought into FileHold using Watched Folders: asp,

asx, bas, bat, cer, chm, cmd, com, cpl, crt, csh, exe, fxp, hlp, hta, inf, ins, isp, js, jse, ksh, Ink,
mda, mdb, mdt, mdw, mde, mdz, msc, msi, msp, mst, ops, pif, prf, prg, reg, scf, scr, sct, shb,
shs, tmp, vb, vbe, vbs, vsmacros, vss, vst, vsw, ws, wsc, wsf, and wsh.

To CREATE A WATCHED FOLDER
1. In FDA, go to Tools > Watched Folders and click Add.

2. In the Browse for Folder window, select the folder that you want to "watch" on your local
computer or network drive. For example, select the output folder for a scanned batch of
documents.

In the Watched Folder Properties window, the Folder Path to the Watched Folder is shown.

To set a folder location in the library, select the Set a destination library location check
box and select one of the following options:

e Folder location — Click ... and select a folder. Click OK.
e Auto-file using — Select one of the auto-filing options:

o Document schema — The document is filed according to the auto-filing rule set in
the schema. If you are not an administrator, this may be the only option available.

o <Auto-filing template name> — Select the name of the auto-filing template from the
list.

o <Auto-filing script> — Select the auto-filing script from the list.
NOTE: If no folder location is selected, documents go to the user’s Inbox.

5. To set the metadata for the documents, select the Set metadata for input files check box
and select the Document Schema name from the list.

e Use only extraction rules — Extraction rules are used to set the metadata.
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6.

<Document schema name> — Select the schema name from the list and enter any
metadata field values. If any metadata values are set, a fixed value is applied to all the
documents. If any required fields do not contain values, the option “Automatically send files
to the FileHold Library” cannot be enabled since the required value is missing and need to
be entered in the Inbox. If the metadata field is set to “read-only”, then you cannot enter a
value; this field always uses the default initial value set up in the schema.

Select the Automatically "Send files" to the FileHold Library to automatically send the
files to the set folder location. If you do not select this option, then all files go to the Inbox
instead of being automatically sent to the folder location. This option is not available unless
the Set metadata for input files is enabled.

To delete the files that are successfully imported into the library, select the Delete input
files sent to library check box. This keeps the folder clean and reduces the folder size;
this could potentially get quite large if you are scanning a lot of documents.

Click Save .
The new Watched Folder appears in the List of Watched Folders.

. To delete a Watched Folder, click the red X next to the Watched Folder name in the

Watched Folders list.
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20.VIEWING ALL FILES IN TRANSFER

If you are moving a bulk load of files into the system, you can view the files that are in transfer
into the document management system. This is helpful when you want to see how the file
transfer is progressing, or if you need to pause or cancel a transfer.

In the View Files in Transfer window, you can pause, resume, cancel, or clear completed and
cancelled transfers into the system. You can also view only those files that are being sent into
the Library at the current time.

. Al Files in Transfer

Pase Resume Cancel Clear Completed & Canceled
¥ Inchude 'Caming From' lrary Swhus: W pendng ¥ Completed W Error

Document Mame Docsment Schema  Application  Coming From Stakus i‘
H 130161450270 Fhrotos FD& Crilbsersidimi. . dooumers: Completed
111 S Applcation POS CofUbsersAdmi . | dooun Ceerplated

H| 13101614522 i, Shateirmnt FD& Completed
B 1310161458571 Clsnant Fon FO& s Claimant FormCabinet | Cla...  10{16/2014 1:28... Complebed
8 131017163721 Boand Mirutes FO& Board Mnwtes-2014 | Ocbo...  10fI6/2014 1:31.., Completed
jj 31023151435 Invececes FOa g Accourding | Invoices | BC .. 10/16/2014 3:05... Ceenplated
-

SamplethartgaoeTdf Applcaton FO& s Year-2014 | October | Day...  10/16/2014 7:45... Completed

TO VIEW ALL FILES IN TRANSFER

1. Inthe FDA, go to View > All Files in Transfer. The following table describes the functions
in the All Files in Transfer View:

Function Description

Pause Puts a hold on the transfer of a document.

Resume Removes a pause on a document so it can be transferred into the
library.

Cancel Cancels a document from being transferred into the library.

Clear Completed and Removes all completed and canceled transfers from the view.

Canceled

Include "coming from" When enabled, all documents being sent to the library and

library downloaded from the library are shown. If disabled, only the
documents that are or are sent to the library are shown.

Status: Pending Shows all documents that pending to be sent to the library with a
status of “Scheduled to Send” when enabled.

Status: Completed Shows all documents that have been sent successfully into the
library with a status of “Completed” when enabled.

Status: Error Shows any errors that occurred while sending documents into the

library with the status of “Failed” when enabled. TIP: Hover over
the “Failed” status to see why the document failed to be sent to
the library.

September 2025 < Hold 181



FileHold 17.1 End User Guide

21.REFRESHING THE FILEHOLD SYSTEM

If you have made changes in the Library Administration or System Administration areas of
FileHold since your last log in, you need to update the FileHold Desktop Application by using
the Refresh function. This loads your changes into the application.

To REFRESH THE FILEHOLD SYSTEM
e Go to File > Refresh All.

NOTE: Some changes will only take effect after logging out and back in.

22.ACCESSING SYSTEM AND LIBRARY ADMINISTRATION

To access the Library Administration or System Administration areas of FileHold:

e In FDA, select Administration > Administration Panel from the menu bar. You are
redirected to the Web Client.

e In Web Client, login and click the Administration Panel link at the top of the screen.

23.VIEWING FILEHOLD REPORTS

You are able to see custom reports in the library tree if the feature has been enabled and you
have the correct permissions.

There are two preconfigured reports that can be downloaded from the Knowledge Base:

e Library List Report — Displays the contents of a cabinet.

e System Activity Report — Displays all the logon activities of users.

TO VIEW REPORTS IN THE LIBRARY
1. In the Library, go to Reports > FileHold Reports.
2. Select a report from the list and click Show Report. The Report Manager opens.

3. Select or enter the parameters you want to be shown in the report and click View Report.
The report results are shown.

4. You can now export the report into a XML, CSV, PDF, MHTML, Excel, Tiff, or Word file.
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Client Type

FileHold Application

||| http://qa-2008r2entbd/FH/FileHold/LibraryManager/ReportForm.aspxfreportld= e9d26b99- ccf5-4fbl-b143-92db3efof382 f}|
Client Type FDA - User 1D MNULL
port
Select or enter the
Last Name | NULL First Name  Basie [T report parameters
Login Time | £ Mnow Logout Time | E Mnow
4 LNE of 1 g i Select a format : Expdrt @

Select a format
XML file with report data
CSV (comma delimited)
Acrobat (PDF) file
MHTML (web archive)

¢———————— Select an export format
Regport

FDA McMarvin = 2 Ba ! 12/8/2010 9:02:18 AM 12/8/2010 9:05:11 AM
FDA McMarvin Basie Basia McMarvin 12/8/2010 9:05:19 AM ~ 12/8/2010 10:27:32 AM
5 B 44— Reportresults
FDA McMarvin Basie Basie McMarvin 12/8/2010 12:39:01 PM 12/8/2010 2:11:55 PM
FDA McMarvin Basie Basie McMarvin 12/8/2010 2:12:13 PM 12/8/2010 2:17:20 PM
FDA McMarvin Basie Basie McMarvin 12/8/2010 2:18:33 PM 12/8/2010 2:49:12 PM
FDA McMarvin Basie Basia McMarvin 12/8/2010 3:02:34 PM 12/8/2010 3:02:48 PM
FDA McMarvin Basie Basie McMarvin 12/8/2010 3:03:02 PM 12/8/2010 4:11:08 PM
FDA McMarvin Basie Basie McMarvin 12/9/2010 9:20:13 AM 12/9/2010 9:53:08 AM
FDA McMarvin Basie Basie McMarvin 12/9/2010 9:59:52 AM 12/9/2010 2:17:16 PM
FDA McMarvin Basie Basie McMarvin 12/9/2010 3:08:47 PM 12/9/2010 3:40:08 PM
FDA McMarvin Basie Basie McMarvin 12/13/2010 9:50:33 AM  12/13/2010 11:01:21 AM
Done

24 . FILEHOLD HELP

To read a help topic, click a question mark (?) in the window. You are redirected to the relevant
topic in the online help.

You can also access the home page for the online help by selecting Help > Help from the
menu bar in the FileHold Desktop Application.
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INDEX

add document wizard
web client, 75
Add documents, 25
Add File, 4
alert preferences, 171
alerts, 116
disable on folders, 118
mark as read, 118
removing, 118
assembling documents, 150
batch jobs report, 155
custom watermarks, 154
merge tags, 155
Auto-File, 26

batch jobs report, 155
how to use, 156

cabinet administrator role, 20
cabinets, 60
auto-tagging, 68
managing, 60
calendar, 28
Capture, 161
Check out, 5, 9
Checked Out Documents, 27
Click To Tag, 88
entering metadata, 89
connection options, 2
Convert to offline, 9
CSV files
exporting, 82

database drop-down list
search by fields, 93
database lookups
entering metadata, 94, 97
multiple lookup fields, 96
default domain, 3
Delete, 6, 9
Document Alerts, 27

document assembly. See Assembling documents

document owner
changing, 110

document publisher + delete role, 18

document publisher role, 18
Document Reminders, 28
document tray

clear documents, 123
Document Tray, 122
document URLs, 106
document viewer, 125

full or partial views, 125
documents

licon, 22

actions and functions, 69

add document wizard, 75

adding, 73

adding emails. See emails

adding from FDA, 74

adding from Microsoft Office applications, 79

adding from Web Client, 75

adding offline documents, 80, 82

alerts, 116
cancel check out, 101

change document owner, 110

checking in, 100

checking in from Microsoft Office applications, 101
checking in multiple documents, 101

checking in/out, 99
checking out, 99
deleting, 99

downloading to local folders, 112

drag and drop, 74

emailing. See emails, See emails

exporting, 111
exporting to CSV file, 82
grey dots, 21

linking, 107

linking by metadata field values, 108

linking from metadata pane, 109

make a local copy, 102

managing alerts and reminders, 117

manually linking, 107
move or copy, 101
purple dot, 22

quick check-in, 101
rectangle with dots, 22
red dots, 21

red, yellow dots, 21
red, yellow, green dots, 21
reminders, 117
removing links, 109
renaming, 111

setting alerts and reminders, 116

setting destination folder, 98

version history, 112
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drawers, 60
managing, 60
duo, 14

Edit Destination, 26
Edit metadata, 9
Edit Metadata, 26
electronic documents, 84
electronic records, 84
Email, 5
emails
adding, 76
adding only attachments, 78
email and check out, 105
emailing attachments, 103
emailing documents, 102, See emails
emailing links, 103
extraction rules, 76
Microsoft Outlook, 105
Microsoft Outlook Watched Folder, 77

F

FastFind
changing shortcut keys, 175
clipboard search, 174
enable, 51
mouse search, 174
preferences, 173
screen OCR search, 174
selection search, 174
FDA, 1
accessing, 1
connection options, 2
Inbox, 25
login, 3
menus and toolbars, 4
refreshing, 182
shortcut keys, 6
FileHold
about, 1
accessing, 1
FileHold Desktop Application. See FDA
FileHold viewer
annotation presets, 137
markup, 137
files in transfer, 181
FOC
Add attachment from FileHold, 11
Add document, 11
Browse to FileHold, 11
Checkin, 11
Quick check in, 11
Review / approval feedback, 11
folder groups, 60
assigning to a folder, 62

delete, 62
edit, 62
managing, 60
statistics, 62
folders, 63
archiving, 67
auto-tagging, 68
cloning, 67
colour, 65
copying, 66
creating, 65
default view, 67
deleting, 66
managing, 63
moving, 67
properties, 66
statistics, 67

G
Get a copy, 9
H
help, 183
hotkeys, 6
|
icons
document permissions, 21
Inbox, 25
shared inbox, 25
shared inboxes, 7
L

library
cabinets, 60
drawers, 60
folder groups, 60
folders, 63
inbox, 23
library archive, 24
library tree, 24
My FileHold, 23
recent folders, 24
reports, 24
reviews and approvals, 23
search, 24
structure, 59
structure overview, 23
virtual folders, 24
Library Administration
accessing, 182
library administrator role, 20
library archive, 119
manuallly archiving, 119
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moving documents back to library, 119

moving objects to archive, 119
scheduled archiving, 119
limited user role, 17
Link, 9
Link documents, 5
linking
documents, 107
from metadata pane, 109

linking documents by metadata field values, 108

local copy
documents, 102
login
FDA, 3
multi-factor authentication, 14
webclient, 8

M

Make a local copy, 5
merge tags, 155
metadata
Click To Tag. See Click To Tag
copying, 98
document URL, 85
editing, 98
entering, 83
entering for a single document, 85
entering for multiple documents, 86
FileHold ID, 84
format, 84
has markups, 84
library location, 84
library status, 84
link to a web page, 106
owner, 84
schema lookups, 94
size, 85
type of file, 85
version, 84
metadata pane, 83
mfa. See multi-factor authentication
Microsoft Office applications, 10
accessing, 1
adding documents, 79
checking in, 101
FOC window, 12
Microsoft Outlook
adding emails, 76
Microsoft Teams, 120
add document to team, 121
add to FileHold from Teams, 122
check in Teams file, 122
get latest version, 122
got to document, 122
library tree, 120
remove link to FileHold, 122
remove old and duplicate files, 122

working with documents, 121
Move/copy, 9
multi-factor authentication, 7, 14
My Favorites, 27
My FileHold, 27

offline documents, 82, 84
organizer + delete role, 19
organizer role, 19

passwords
lost or forgotten, 12
reset, 13
userid, 13
PDF Image viewer
closing, 149
delete pages, 148
drag and drop, 147
drag and drop image, 149
insert files, 148
insert image file, 148
modify images, 148
modifying files, 147
printing, 149
publish as PDF, 148
reorder pages, 147
save image file, 149
undocking, 149
permission icons, 21
preferences, 158
publisher + delete role, 18
publisher role, 18

quick check-in, 101
QuickScan Pro, 161

raw query, 47
read-only role, 18
recent folders, 29
Recently Accessed, 28
Recently Added, 28
reminders, 117
mark as read, 118
removing, 118
Remove from Inbox, 25
reporting services
reports, 182
reviews and approvals, 115
roles and permissions, 17
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scanning. See QuickScan Pro, See Capture
schema lookups, 94
search, 30
"and" connector, 46
"not w/n" connector, 46
"not" connector, 46
"or" connector, 46
"w/n" connector, 46
# phonic, 35
% fuzzy, 35
& synonym, 36
* wildcard, 35
? matches any character, 35
~ stemming, 35
= matches any digit, 35
accessing, 30
advanced search, 37
Advanced Search, 30
boolean, 45
contains in db, 33
contains in fts, 33
empty saved search, 50
FastFind, 30, 50
for documents in a workflow, 52
for previous versions, 51
fts wildcard limitation setting, 37
full text search, 30, 36
general usage, 33
integrated with external applications, 53
noise words, 34
proximity, 46
quick search, 53
raw query, 47
regular saved search, 48
request types, 34
saved searches, 47
search operators, 43
security, 32
simple search, 36
url builder, 54
words and phrases, 36
Send, 26
Send All, 26
Send to > Email, 10
Send to > Email and check out, 10
Send to > Library archive, 10
Send to > Tray, 9
Send to > Virtual folder, 9
senior library administrator role, 20
sign off sheet, 115
System Administration
accessing, 182
system administrator role, 21

user preferences, 77, 158

Vv

version history
deleting previous versions, 113
document usage, 115
reinstating previous versions, 114
reviews and approvals history, 115
sign off sheet, 115
viewing, 112
viewing metadata edits, 114
viewing previous versions, 113
version properties
document URLs, 106
view preferences, 166
ad-hoc views, 169
setting default view, 171
workflow views, 170
viewers
publish as PDF, 136
viewers, 125
FileHold viewer, 126
highlight search results, 134
level 1, 126
level 2, 126
level 3, 126
page manipulation, 131
publish as PDF, 136
supported file types, 127
viewers
bookmarks panel, 136
viewers
annotations, 136
viewers
comments, 141
viewers
redaction, 143
viewers
PDF/Image viewer, 145
viewing
files in transfer, 181
virtual folders, 57
adding documents, 57
creating, 57
deleting, 57
removing documents, 58

watched folders, 179
watermarks, 154
web client, 7

accessing, 1

login, 8

menus and toolbars, 8

September 2025

Hold 187



FileHold 17.1 End User Guide

Web Client sign off sheet, 115
reset password, 175 workflow preferences, 172
workflow working documents, 177

reviews and approvals history, 115
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